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Introduction: Manual information

Manual information

Revision history
The document part number and revision appear at the bottom of each page. The 
following table summarizes this document’s revision history .

Table 1. Revision History, PN 2002783-027

Revision Date Comment

A 10 July 2000 Initial release of manual.

B 4 December 2000 Added SMM information. Updated manual to version 005C.04 software. Added section for 
Tram-MUSE gateway setup to “Installation” chapter. Changed company name.

C 4 March 2001 Updated manual to include new client hardware SFF (small form factor).

D 1 June 2001 Updated manual to include new ML370 file server.

E 1 May 2002 Updated manual to include G2 server, Evo workstation, and flat panel monitor.

F 1 October 2002 Edited IMS chapter for 5C.10 software changes.

G 22 November 2002 Edited manual for Evo D510 SFF client.

H 1 May 2003 Edited manual for G3 server.

J 22 September 2003 Edited manual for Evo D530 client. and the HIS ProLiant DL360 1U G3 client.

K 15 April 2004 Edited manual for version 5E software.

L 21 July 2004 Document edited per feedback from 5E pilot installations.

M 20 April 2005 Updated hardware information for ML370 G4, new monitors, and HP4250N printer

N 17 June 2005 Updated hardware information for dc7100 client. Added pointer to security information.

P 17 February 2006 Updated hardware for dc7600 MUSE client and 1U HIS client.

R 1 May 2006 Updated document for 2MB L2 memory processor.

S 20 October 2006 Added software version 5E.12

T 18 June 2007 Added DL360 IU G5 HIS server.

U 12 October 2007 Added ML370 G5 MUSE file server hardware.

V 23 May 2008 Added rp5700 client. Added “Installing and Configuring the I2 Option”.

W 4 September 2008 Modified “Installing and Configuring the I2 Option” on page 3-5.

Y 12 September 2008 Added information on the HP5700 hardware, HP L1910 19 inch display, and HP 4015N 
LaserJet printer.

Z 23 April 2009 Updated with new modem part number information.
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Manual purpose
This manual supplies technical information for service representatives and technical 
personnel so they can maintain the equipment to the assembly level. Use it as a 
guide for maintenance and electrical repairs considered field-repairable. Where 
necessary, the manual identifies additional sources of relevant information and/or 
technical assistance. 

See the operator manual for the instructions necessary to operate the equipment 
safely in accordance with its function and intended use. 

Manual content 
This manual is organized into the following chapters. 

Chapter 1, Introduction
Describes the service manual and chapter contents. 

Provides general information on safety, service requirements, equipment 
symbols, and serial number identification.

Chapter 2, Equipment Overview
Describes the equipment and its characteristics, connector locations, and 
preparation for use.

Chapter 3, Installation
References installation/upgrade documents for the 005E MUSE system. 

Describes how to use the Format Settings Manager to customize the format of 
printed reports.

Chapter 4, Integrated Maintenance Suite
Describes how to use the Integrated Maintenance Suite (IMS) to back up and 
archive data on the MUSE system as well as procedures for disaster recovery.

Chapter 5, HIS Disaster Recovery
Provides information for rebuilding the DL310 1U G4 HIS hardware.

Chapter 6, Troubleshooting
Provides overall and specific troubleshooting help.

Chapter 7, Maintenance
Contains a preventive maintenance schedule, instructions for opening the unit, 
and cleaning guidelines.

Chapter 8, Parts Lists
Contains parts lists for reference in repairing the unit at the assembly level.

Chapter 9, Glossary
Defines technical words and terms used in this document.
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Typographical Conventions
The following typographical conventions are used throughout this 
document. 

OEM Documentation and Support
The following table lists the system components provided by each original 
equipment manufacturer (OEM) and the URL of each component’s support page. 
The support pages provide the most current component information, drivers, 
manuals, troubleshooting help, and support forum for each component. The URLs 
were current and active at the time this manual was released but are subject to 
change without notice.

Requirements for accessing and viewing these additional documents vary from 
manufacturer to manufacturer and sometimes from product to product. Please refer 
to the requirements listed on each OEM’s website.

Convention Description

Bold Indicates keys on the keyboard, text to be entered, or hardware 
items such as equipment buttons or switches. 

Italics Indicates software terms such as menu items, buttons, field 
names, or options. 

[Key 1] + [Key 2] Indicates a sequence of keys that must be pressed to initiate an 
action. While pressing and holding the first key, press and release 
the second key. 

[Space] Indicates the spacebar must be pressed. Used in command line 
instructions when the command must be entered precisely. 

Enter Indicates the Enter or Return key must be pressed. 

Table 2. OEM Component Support Pages

Component 
Type Component Support Page

Servers HP ProLiant ML370 G4 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=15351&prodSeriesId=397646&lang
=en&cc=us

HP ProLiant ML370 G5 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=15351&prodSeriesId=1121474

HP ProLiant DL360 G5 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=15351&prodSeriesId=1121486

http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp?lang=en&cc=us&prodTypeId=15351&prodSeriesId=397646&lang=en&cc=us
http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp?lang=en&cc=us&prodTypeId=15351&prodSeriesId=1121474
http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp?lang=en&cc=us&prodTypeId=15351&prodSeriesId=1121486
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Workstations HP rp5700 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=3375897&lan
g=en&cc=us

HP rp7600 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=472277&lang
=en&cc=us

HP dc7100 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=410112&lang
=en&cc=us

Printers HP LaserJet P4015N http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=18972&prodSeriesId=3558793&sub
mit.y=0&submit.x=0&lang=en&cc=us

HP LaserJet P4250 http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=18972&prodSeriesId=412144&lang
=en&cc=us

HP LaserJet 4200N http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=18972&prodSeriesId=84028&lang=
en&cc=us

Monitors HP L1910 19-inch LCD http://h20000.www2.hp.com/bizsupport/TechSupport/
Home.jsp?lang=en&cc=us&prodTypeId=382087&prodSeriesId=3561416&su
bmit.y=0&submit.x=0&lang=en&cc=us

Compaq CV7500 17-inch CRT http://h10025.www1.hp.com/ewfrf/wc/
product?product=313889&lc=en&cc=us&dlc=en&submit.y=8&submit.x=7&la
ng=en&cc=us

NEC 1990SXi 19-inch LCD http://www.necdisplay.com/SupportCenter/Product/?product=bb77b527-
6721-4721-b36c-f0b961836afb

Tape Drives Sony SDX-550V AIT-2 http://sony.storagesupport.com/product/72#news

Modems Multitech MultimodemZBA http://multitech.com/PRODUCTS/Families/MultiModemZBA/

Barcode 
Readers

3800g Linear Image Scanner http://www.handheld.com/Site.aspx/na/en/product_center/hardware/
?product=136

UPS Compaq 3000 Series http://www3.compaq.com/support/reference_library/
viewdocument.asp?countrycode=1000&prodid=121|Uninterruptible+Power+
Supply&source=341251-002.xml&dt=264

Ethernet Hub OfficeConnect http://support.3com.com/infodeli/tools/hubs/off-con/3c16700/manual.a03/
dua1670_0aaa04.pdf

Table 2. OEM Component Support Pages

Component 
Type Component Support Page

http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=3375897&lang=en&cc=us
http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=472277&lang=en&cc=us
http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp?lang=en&cc=us&prodTypeId=12454&prodSeriesId=410112&lang=en&cc=us
http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp?lang=en&cc=us&prodTypeId=18972&prodSeriesId=3558793&submit.y=0&submit.x=0&lang=en&cc=us
http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp?lang=en&cc=us&prodTypeId=18972&prodSeriesId=412144&lang=en&cc=us
http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp?lang=en&cc=us&prodTypeId=18972&prodSeriesId=84028&lang=en&cc=us
http://h20000.www2.hp.com/bizsupport/TechSupport/Home.jsp?lang=en&cc=us&prodTypeId=382087&prodSeriesId=3561416&submit.y=0&submit.x=0&lang=en&cc=us
http://h10025.www1.hp.com/ewfrf/wc/product?product=313889&lc=en&cc=us&dlc=en&submit.y=8&submit.x=7&lang=en&cc=us
http://www.necdisplay.com/SupportCenter/Product/?product=bb77b527-6721-4721-b36c-f0b961836afb
http://sony.storagesupport.com/product/72#news
http://multitech.com/PRODUCTS/Families/MultiModemZBA/
http://www.handheld.com/Site.aspx/na/en/product_center/hardware/?product=136
http://www3.compaq.com/support/reference_library/viewdocument.asp?countrycode=1000&prodid=121|Uninterruptible+Power+Supply&source=341251-002.xml&dt=264
http://support.3com.com/infodeli/tools/hubs/off-con/3c16700/manual.a03/dua1670_0aaa04.pdf
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Safety information

Responsibility of the manufacturer
GE Medical Systems Information Technologies is responsible for the effects of 
safety, reliability, and performance only if:

Assembly operations, extensions, readjustments, modifications, or repairs are 
carried out by persons authorized by GE Medical Systems Information 
Technologies.
The electrical installation of the relevant room complies with the requirements 
of the appropriate regulations.
The equipment is used in accordance with the instructions for use.

General
This device is intended for use under the direct supervision of a licensed health care 
practitioner.

The device stores ECGs generated by a computerized analysis program which can 
be used as a tool in ECG tracing interpretation. This computerized interpretation is 
only significant when used in conjunction with clinical findings. All computer-
generated tracings should be overread by a qualified physician.

To ensure patient safety, use only parts and accessories manufactured or 
recommended by GE Medical Systems Information Technologies.

Contact GE Medical Systems Information Technologies for information before 
connecting any devices to this equipment that are not recommended in this manual.

If the installation of this equipment, in the USA, will use 240 V rather than 120 V, 
the source must be a center-tapped, 240 V, single-phase circuit.

Parts and accessories used must meet the requirements of the applicable IEC 601 
series safety standards, and/or the system configuration must meet the requirements 
of the IEC 601-1-1 medical electrical systems standard.

The use of ACCESSORY equipment not complying with the equivalent safety 
requirements of this equipment may lead to a reduced level of safety of the resulting 
system. Consideration relating to the choice shall include:

use of the accessory in the PATIENT VICINITY, and
evidence that the safety certification of the ACCESSORY has been performed 
in accordance with the appropriate IEC 601-1 and/or IEC 601-1-1 harmonized 
national standard.
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Equipment symbols
For an explanation of the symbols that appear on the equipment, refer to the 
MUSE Cardiology Information System Operator’s Manual (PN 2020285-021). 

Warnings and cautions

DANGER
Do NOT use in the presence of flammable anesthetics.

WARNINGS
Replace only with same type and rating of fuse.

This is Class I equipment. The mains plug must be connected to 
an appropriate power supply.

Turn off power and disconnect power cord from AC power source 
before removing the cover.

Disconnect patient from unit BEFORE connecting personal 
computer to unit.

CAUTIONS
This equipment contains no user-serviceable parts. Refer servicing 
to qualified service personnel.

U.S. Federal law restricts this device to sale by or on the order of a 
physician.

Data loss or system failure can result due to ingress of liquids. 
The system does not provide protection against ingress of liquids. 
Ensure installation in a cool, dry environment.

To reduce the risk of electric shock, do NOT remove cover (or 
back). Refer servicing to qualified personnel.
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Service information

Service requirements
Refer equipment servicing to GE Medical Systems Information Technologies’ 
authorized service personnel only. Any unauthorized attempt to repair equipment 
under warranty voids that warranty.

It is the user’s responsibility to report the need for service to GE Medical Systems 
Information Technologies or to one of their authorized agents. 

Failure on the part of the responsible individual, hospital, or institution using this 
equipment to implement a satisfactory maintenance schedule may cause undue 
equipment failure and possible health hazards.

Regular maintenance, irrespective of usage, is essential to ensure that the MUSE 
cardiology information system will always be functional when required.

Security updates
A list of viruses that pose a significant threat to GE customers’ product security are 
posted on the GE Healthcare Product Security Database Web site. Vulnerability 
notification to customers will occur through the Web site. After security patches 
have been validated for specific GE Healthcare products, this information will be 
added to this database. After confirming that a particular security patch has been 
validated for your system configuration, you can download it directly from the Web 
site of the software manufacturer (Microsoft, etc.) and applied to the customer’s GE 
product. To check on the latest information regarding validated security patches:

1. Browse to the GE Healthcare Product Security Database Web site:

http://www.gehealthcare.com/usen/index.html

2. Select Product Security from the Solutions drop-down list.

3. Select Product Vulnerability Database.

4. Log on with your SSO (Single Sign On) username and password.

NOTE
If you do not have an SSO, click the Sign Up link to obtain an SSO.

5. Use the features on the GE Healthcare Product Security Database Web site to 
determine security patches that can be applied to your system.

6. Download the applicable updates per the instructions that are provided on the 
update site.

http://www.gehealthcare.com/usen/index.html


Revision Z MUSE™ Cardiology Information System 1-9
2002783-027

Introduction: Service information

Equipment identification

Serial number format

Label format

A Product Code

B Year Manufactured (00-99)
04 = 2004
05 = 2005
06 = 2006
(and so on)

C Fiscal Week Manufactured

D Production Sequence Number

E Manufacturing Site

F Miscellaneous Characteristic

A Date of manufacture in YYYY-MM format

B Part number of product

C Product code description

D Serial number (see “Serial number format” on page 1-9).

### ## ## #### # #

A B C D E F

A

B

C

D
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FCC requirements

Modem requirements

The modem in your GE Medical Systems Information Technologies device is 
designed to comply with FCC part 68, U.S. Telecommunication Requirements. See 
the equipment label on the GE Medical Systems Information Technologies device 
for the FCC registration number and the ringer equivalence number. The device is 
designed to be used on standard device telephone lines. Connection to telephone 
company-provided coin service (central office implemented systems) is prohibited. 
Connection to party lines service is subject to state tariffs.

The goal of the telephone company is to provide you the best service it can. In order 
to do this, it may occasionally be necessary for them to make changes in their 
equipment, operations, or procedures. If these changes might affect your service or 
the operation of your equipment, the telephone company will give you notice, in 
writing, to allow you to make any changes necessary to maintain uninterrupted 
service. If you have any questions about your telephone line, such as how many 
pieces of equipment you can connect to it, the telephone company will provide this 
information upon request.

In certain circumstances, it may be necessary for the telephone company to request 
information from you concerning the equipment which you have connected to your 
telephone line. Upon request of the telephone company, provide the FCC 
registration number and the ringer equivalence number (REN) of the equipment 
which is connected to your line; both of these items are listed on the equipment 
label. The sum of all of the RENs on your telephone lines should be less than 5 in 
order to assure proper service from your telephone company. In some cases, a sum 
of 5 may not be usable on a given line.

If any of your telephone equipment is not operating properly, you should 
immediately remove it from your telephone line, as it may cause harm to the 
telephone network. If the telephone company notes a problem, they may temporarily 
discontinue service. When practical, they will notify you in advance of this 
disconnection. If advance notice is not feasible, you will be notified as soon as 
possible. When you are notified, you will be given the opportunity to correct the 
problem and you will be informed of your right to file a complaint with the FCC.

An analog telephone line is required. A digital PBX line will not work.

Emissions (interference) requirements

This GE Medical Systems Information Technologies device has been tested and 
complies with the limits for a Class B computing device in accordance with the 
specifications in Part 15 of the FCC rules. These rules are designed to provide 
reasonable protection against radio-frequency interference. However, there is no 
guarantee that interference will not occur in a particular installation.

You can tell whether this device is causing interference by turning it off. 
If the interference stops, it was probably caused by the device.
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System characteristics

General description
The MUSE system is a multiple data-type system designed for managing cardiology 
data. It allows you to edit and store data acquired from many different areas. Data 
may be acquired from areas within the hospital, as well as from areas not directly 
connected to the hospital such as emergency care and outreach facilities.

The version 5E MUSE system has a file server running Windows Server 2003 which 
is networked to one or more workstations. The products range from a low-cost, 
single data-type system to multiple data-type systems with many workstations and 
virtually unlimited ECG storage capabilities. Options can be added to the standard 
configuration to suit a customer’s particular needs.

File server hardware
Turnkey MUSE systems include GE-supplied hardware, which will be configured 
with either an HP ProLiant ML370 G4 or G5 server. 

The following table describes the available configurations for the HP ProLiant 
ML370 G4 server. 

Table 1. ML370 G4 File Server Configurations

Features Tower Rackable

Processor Single Single

CPU Slot 1 and PPM Slot 1 Populated CPU CPU

Memory, Total (6,144 MB max.) 1024 MB 1024 MB

DIMM 1 512 MB 512 MB

DIMM 2 512 MB 512 MB

DIMM 3 Empty Empty

DIMM 4 – 8 Empty Empty

Case/Chassis (rear-Vertical)

Case slot #6 (Left) Empty Empty

Case slot #5 Empty Empty

Case slot #4 Empty Empty

Case slot #3 Digiboard Serial MUX
(8-port)

Digiboard Serial MUX
(8-port)

Case slot #2 10/100 NIC
(NC7170)

10/100 NIC
(NC7170)
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The following table describes the available configurations for the HP ProLiant 
ML370 G5 server. 

Case slot #1 Smart Array 
Controller (642)

Smart Array 
Controller (642)

External Drive Bay (Front-Horizontal) 

Case slot - Top 48x IDE
CD-ROM/16x DVD 

ROM

48x IDE
CD-ROM/16x DVD 

ROM

Case slot - Middle AIT-2 Tape Drive AIT-2 Tape Drive

Case slot - Bottom Filler panel Filler panel

HotPlug Drive Bay (Front-Horizontal)

Ultra3 SCSI ID 5, Top 146 GB 300 GB

Ultra3 SCSI ID: 4 146 GB 300 GB

Ultra3 SCSI ID: 3 146 GB 300 GB

Ultra3 SCSI ID: 2 146 GB 300 GB

Ultra3 SCSI ID: 1 Empty 300 GB

Ultra3 SCSI ID 0. Bottom Empty 300 GB

HotPlug - Supplies/Fans

Power Supply 500 Watts 500 Watts

Redundant PS (Rear-Lower Left) Redundant PS Kit Redundant PS Kit

Redundant Fans Yes – Installed Yes – Installed

Table 2. ML370 G5 File Server Configurations

Features Tower Rackable

CPU Slot #1 CPU CPU

CPU Slot #2 empty empty

Memory, Total 2 GB 2 GB

DIMM 1A 1 GB 1 GB

DIMM 5A 1 GB 1 GB

DIMM 2B, 6B, 3G, 7C, 4D, 8D empty empty

Case/Chassis (rear-Vertical)

Case slot #6 - #9 empty empty

Table 1. ML370 G4 File Server Configurations (Continued)

Features Tower Rackable
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Case slot #5 serial / parallel 
board

serial / parallel 
board

Case slot #4 empty empty

Case slot #3 SCSI HBA 
(optional)

SCSI HBA 
(optional)

Case slot #2 Digiboard Serial 
MUX

(8-port)

Digiboard Serial 
MUX

(8-port)

Case slot #1 P400 Array 
Controller*

P400 Array 
Controller*

External Drive Bay (Front) 

Case slot - Top CD-ROM/16x DVD 
ROM

CD-ROM/16x DVD 
ROM

Case slot - Middle Floppy drive Floppy drive

Case slot - Bottom Sony AIT-2 Turbo 
tape drive

Sony AIT-2 Turbo 
tape drive

HotPlug Drive Bay (Front) 

Bay 1 146 GB 146 GB

Bay 2 146 GB 146 GB

Bay 3 146 GB 146 GB

Bay 4 146 GB 146 GB

Bay 5 Empty 146 GB

Bay 6 Empty 146 GB

Bay 7 Empty Empty

Bay 8 Empty Empty

Bay 9 - Bay 16 Empty Empty

Power Supplies/Fans

Power Supply (Right)

Redundant PS (Left) Redundant PS Kit Redundant PS Kit

Redundant Fans Installed Internal Installed Internal

* Connect array controller port 1 to hard drive bays 1 – 4. 
Connect array controller port 2 to hard drive bays 5 – 8. 

Table 2. ML370 G5 File Server Configurations (Continued)

Features Tower Rackable
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The G5 server must have access to an analog telephone line for communication with 
the host MUSE system to work properly. Newer digital telephone systems will not 
work with this equipment.

NOTE
HP RAID servers can be configured with a 4-port KVM 
(Keyboard-Video-Mouse) switch for servicing “headless” clients.

Workstation hardware
The GE-supplied MUSE workstation is an HP model rp5700 SFF (small form 
factor) PC. The following table summarizes the hardware specifications of the 
workstation.

Table 3. HP rp5700 Small Form Factor

Processor

Type 1 Intel® Core 2 Duo (E6400e)

Speed 2.13 GHz
2MB L2 cache

Front Side Bus (FSB) 1066-MHz front side bus 

Memory 1GB PC2-5300 (DDR2-667)
Expandable to 4GB

Integrated I/O

Integrated Serial (2) RS-232C

Integrated USB (2) front USB 2.0 ports 
(4) rear USB 2.0 ports

Integrated Keyboard PS/2 standard keyboard supported

Integrated Mouse PS/2 2-button optical scroll mouse

Video 1280x1024 @ 75 Hz
16 or 32 bit color

Integrated Ethernet 10/100/1000 NIC
RJ45 connector

Expansion Slots (PCI/ Cards) 3

Drive Bays

Optical Drive SATA 16X/48X DVD-ROM

Hard Drive 160GB SATA 3Gb/s

Power

Voltage 90 - 264 VAC, autoselecting

Rated Line Frequency 50/60 Hz

AC input connector IEC60-320 male connector.



2-6 MUSE™ Cardiology Information System Revision Z
2002783-027

Equipment Overview: System characteristics

Power consumption, rated Maximum Rated Power: 240 W

Heat dissipation (BTU/hr) 100 VAC: 215.297 BTU/hr
115 VAC: 214.614 BTU/hr 
230 VAC: 210.861 BTU/hr

Environmental

Operating Temperature +50° to +104° F
+10° to +40°C

Operating Humidity 20% to 85%, non-condensing at ambient

Operating Altitude 10,000 feet
3,048 meters

Storage Temperature -22° to +140°F
-30° to 60° C

Storage Humidity 5% to 90%, non-condensing at ambient

Storage Altitude 30,000 feet
9,144 meters

Physical

Size (HxWxD) 3.94 x 13.4 x 15 inches 
10 x 34 x 38 cm

Weight 19.4 lbs 
8.8 kg

Weight supported 77 lbs 
35 kg

Operating Systems

Operating Systems supported Microsoft Windows XP Professional US

Table 3. HP rp5700 Small Form Factor (Continued)
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Optional equipment
The following optional equipment may be purchased with your MUSE system.

HP L1910 19-inch LCD Display
HP LaserJet P4015 Printer
Fax Modem
Used for faxing reports to Group 3-compatible Fax machines. 

CSI Modem
Used for communicating with the MAC 1200, MAC 3500, MAC 5000, and 
MAC 5500 resting ECG analysis systems. 

HP L1910 19-inch LCD Display

The following table provides the technical specifications for the HP 
L1910 monitor. 

Table 4. HP L1910 19-inch LCD Monitor 

LCD Module 19-inch active matrix TTF (thin film transistor (TFT)

Viewable Image Area 19 inches (48.26 cm) diagonal

Active Display Area Horizontal: 14.8 inches / 37.8 cm
Vertical: 11.9 inches / 30.3 cm

Viewing Angle 160° horizontal
160° vertical
10:1 minimum contrast ratio

Brightness 300 nits (cd.m2)

Contrast Ratio 800:1

Response Rate 5 ms (rise and fall)

Pixel Pitch 0.294 mm

Backlight Lamp Life 50 K hours

Horizontal Frequency 24 to 83 kHz

Vertical Frequency 50 to 70 Hz

Native Resolution 1280 x 1024 @ 60 Hz

Current < 0.50 Ampere

AC input voltage/current Universal 100 (110-240V) 50-60Hz Internal

Power Consumption Maximum: < 38 watts
Typical: 31 watts
Power Save Mode: <2 watts

Operating Temperature +41° to +95° F (+5° to +35° C), non-condensing

Operating Humidity Range 20% to 80%, non-condensing
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HP LaserJet P4015 Printer

The following table provides the technical specifications for the HP 
LaserJet P4015 Printer. 

Dimensions (W x H x D) With stand: 16.4 x 16.3 x 7.6 in / 41.6 x 41.4 x 19.2 cm
Head only: 13.7 x 16.3 x 2.3 in / 34.7 x 41.4 x 5.8 cm

Weight Head only: 8.6 lbs. / 3.9 kg

Table 4. HP L1910 19-inch LCD Monitor  (Continued)

Table 5. HP LaserJet P4015 Printer

Speed 52 ppm 

Resolution 1200 x 1200 dpi

Memory, Standard 128 MB

Memory, Maximum 640 MB

First page out <9 sec.

Power requirements 100-127 V (50-60 Hz) 
220-240 V (50-60 Hz)

Power Consumption 840 watts active
18 watts ready
12 watts sleep mode
0 watts off

Operating Temperature 50° - 90° F 
10° - 32° C

Storage Temperature 32° - 95° F
0° - 35° C

Dimensions (h x w x d) 16.5 x 17.7 x 15.5 in. 
41.91 x 44.95 x 39.37 cm

Weight 59.92 lbs. 
27.2 kg
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Software
The MUSE system is capable of acquiring data from a variety of sources, both 
within and outside the hospital. Data is acquired via a network, floppy diskette, 
direct line, or telephone transmission. Users may view and measure ECG 
waveforms, edit and confirm the acquired data, and create an assortment of 
configurable data reports.

The MUSE system software is a menu-driven program that operates in Microsoft 
Windows. The overall program is divided into “applications.” Each application 
includes many related operations. For example, the System Status Application 
includes operations that let you display lists of errors, events, pending tasks, and 
print queues.

Network functions
Computers may be networked to each other via twisted pair ethernet. Every MUSE 
system comes equipped from the factory with the customer-selected network 
interface. 

TCP/IP is the standard networking protocol for the MUSE system.

Workstation setup 
NOTE

Some of the choices you will be asked to make when setting up workstations 
must be decided when they are installed. Based on the following information, 
decide if the workstation will be a “Turnkey” or “Multi-Use” workstation. 
Then, decide if it will be set up for MUSE authentication or Windows 
authentication. Refer to “MUSE Information Advanced Security Guide” for 
information about Authentication and how it affects the level of security on 
your version 005E MUSE system.

Turnkey workstation

Dedicated to the operation of the MUSE system
Only MUSE system software is installed
MUSE system software starts automatically when the workstation starts
Typically, additional MUSE tasks are running

Multi-use workstation

Additional third-party applications may be installed.
The MUSE system software does not start automatically.
Typically, does not have additional MUSE tasks running. (The user is not 
always running the MUSE system software.)
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MUSE authentication

MUSE Login (ICIS0250.exe) provides authentication.
Must have a Domain User Account with which to log in to the computer. This is 
typically MUSEXXX (where XXX is the node ID).

Windows authentication

Provides a one-time login to all MUSE and third-party resources.
Must have a Domain User Account for the user.
Must have a MUSE User account (USERS.BTR)
Must have an entry in the MUSE NT Users database (NTUSERS.BTR) that 
maps the Windows domain account to the corresponding MUSE User account.
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Preparation for use
The following interconnect diagrams give a general overview of how your 
workstation should be set up. There are too many variations to show all of them, but 
enough information should be provided so someone reasonably familiar with 
computer system installations should have no problem.

Step-by-step instructions for setting up your workstation for the first time can be 
found in the sections following the interconnect diagram. Use the interconnect 
diagram as a reference when following these instructions. Please refer to the 
supplied OEM manuals and the “System components, controls, indicators” on 
page 2-22 for more specific information.

DANGER
Do NOT use in the presence of flammable anesthetics.

WARNINGS
This is Class I equipment. The mains plug must be connected to 
an appropriate power supply.

Keep leakage current within acceptable limits when connecting 
auxiliary equipment to this device.

Disconnect patient from unit BEFORE connecting personal 
computer to unit.

The file server contains an internal battery pack. There is risk of 
fire and burns if the battery pack is not handled properly. To 
reduce the risk of personal injury: 

Do not attempt to recharge the battery.
Do not expose to temperatures higher than 60°C.
Do not disassemble, crush, puncture, short external contacts, or 
dispose of in fire or water.
Replace only with the HP spare parts designated for this 
product.

NOTE
MUSE system operation may be affected if large machines with high current 
draws are connected to the same electrical circuit as the MUSE system. It is 
recommended that the MUSE system be connected to a power source away 
from these machines.
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Connecting the file server and clients
The following table provides information for connecting a tower file server for the 
MUSE clients.

Table 6. Tower File Server Interconnections

Connect From Connect To Comments/Remarks

UPS

Power Supply Ext. AC Ensure all devices are properly configured for the mains power 
(i.e. 110 or 220 VAC).
Ensure all devices to be plugged into the UPS are turned ‘OFF’.

Serial Server (COM1) See “Server” on page 2-12.

Server

Power Supply UPS Via applicable AC power cord

COM1 UPS serial Via serial: 9 pin-D to serial: 9 pin-D

COM2 Modem: RSS Via serial: 9 pin-D to serial: 25 pin-D

Video Display See “Display” on page 2-13.

Keyboard Keyboard See “Keyboard” on page 2-13.

Mouse Mouse or Trackball See “Mouse/Trackball” on page 2-13.

Internal Ethernet Ethernet Hub (#8) Via applicable length Ethernet cable

Digi Card Modems Via serial: 78 pin-D to multiple 9 pin-D’s [P1-8: plus 9 to 25 pin-D 
extension cables]

Modems
(Common modem connections)

DC Pwr AC/DC power module AC/DC power supplied from external power source

Line Ext. phone jack Via applicable length phone cord

RSS modem application

Modem: RSS Server (Com2) RSS Modem (25 pin-D) to Server COM2 (9 pin-D)

CSI modem application option(s)

Modem: CSI 1 Server via P1 Via Server serial: 78 pin-D to 9 pin-D (P1) plus 9 to 25 pin-D 
extension cable.

Modem: CSI 2 Server via P2 Via Server serial: 78 pin-D to 9 pin-D (P2) plus 9 to 25 pin-D 
extension cable.

Modem: CSI 3 Server via P3 Via Server serial: 78 pin-D to 9 pin-D (P3) plus 9 to 25 pin-D 
extension cable.

Modem: CSI 4 Server via P4 Via Server serial: 78 pin-D to 9 pin-D (P4) plus 9 to 25 pin-D 
extension cable.
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The following table provides information for connecting a rack-mounted file server 
for the MUSE clients.

FAX modem application option(s)

Modem: FAX 1 Server via P5 Via Server serial: 78 pin-D to 9 pin-D (P5) plus 9 to 25 pin-D 
extension cable.

Modem: FAX 2 Server via P6 Via Server serial: 78 pin-D to 9 pin-D (P6) plus 9 to 25 pin-D 
extension cable.

Modem: FAX 3 Server via P7 Via Server serial: 78 pin-D to 9 pin-D (P7) plus 9 to 25 pin-D 
extension cable.

Modem: FAX 4 Server via P8 Via Server serial: 78 pin-D to 9 pin-D (P8) plus 9 to 25 pin-D 
extension cable.

Display

Power Supply UPS Via applicable AC power cord

Video Server Via display video cable (hardwired into display)

Keyboard

Keyboard Server Via keyboard cable (hardwired into keyboard)

Mouse/Trackball

Mouse/Trackball Server Via mouse/trackball cable (hardwired in mouse/trackball)

Ethernet Hub

Power Supply Ext. AC Ensure all devices with manual power selection are properly 
configured for the mains power (i.e. 110 or 220 Vac).

Port #8 Server Ethernet Via applicable length Ethernet cable

Port #1-7 Clients (i.e. nodes) Optional

Clients (MUSE or HIS), see Clients

Power Supply UPS if applicable Via applicable AC power cord

NIC #2 Ethernet Hub (1-7) Optional (see Client)

Table 6. Tower File Server Interconnections (Continued)

Connect From Connect To Comments/Remarks

Table 7. Rack-Mounted File Server Interconnections

Connect From Connect To Comments/Remarks

UPS

Power Supply Ext. AC Install “Heavy Duty” Line Cord for UPS 220V installation
Ensure all devices are properly configured for the mains power (i.e. 
110 or 220 Vac).
Ensure all devices to be plugged into the UPS are turned “OFF.”

Serial Server (COM1) See Server
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Server

Power Supply 1 UPS Via applicable AC power cord

Power Supply 2 UPS Via applicable AC power cord

COM1 UPS serial Via serial: 9 pin-D to serial: 9 pin-D

COM2 RSS Modem (Bay 12) Via serial: 9 pin-D to serial: 25 pin-D

Video Display See “Display” on page 2-13.

Keyboard Keyboard See “Keyboard” on page 2-13.

Mouse Mouse or Trackball See “Mouse/Trackball” on page 2-13.

SCSI RAID Card
(case slot #1)

Hot Pluggable Drive Bay OEM installed (internal cable connection)

Digi Card
(case slot #5)

Modem Rack Via serial: 78 pin-D to multiple 9 pin-D’s [P1-8: plus 9 to 25 pin-D 
extension cables]

Network Interface Card
(case slot #7)

External Ethernet Via applicable length Ethernet cable

Modem Rack

Power Supply UPS Via applicable AC power cord

Modem Rack (Rear View) - shown with modem installed in Bay 12
Bay 03: not usedBay 02: FAX 1 (optional)Bay 01: CSI 1 (optional)
Bay 06: not usedBay 05: FAX 2 (optional)Bay 04: CSI 2 (optional)
Bay 09: not usedBay 08: FAX 3 (optional)Bay 07: CSI 3 (optional)
Bay 12: RSS ModemBay 11: FAX 4 (optional)Bay 10: CSI 4 (optional)
DC Pwr(25 pin-D) [Phone] [Line]

Modems in Modem Rack [reference: Modem Rack (Rear View - table above)]

Common modem connections to Modem Rack

Bay N DC Pwr Modem Rack bay N DC DC power supplied from the Modem Rack, applicable bay

Bay N [Line] Ext. phone jack Via applicable length phone cord

RSS modem application

Bay 12 serial (RSS) Server (Com2) Modem Rack (25 pin-D) to Server COM2 (9 pin-D)

CSI modem application option(s)

Bay 01 serial (CSI 1) Server via P1 Via Server serial: 78 pin-D to 9 pin-D (P1) plus 9 to 25 pin-D 
extension cable.

Bay 04 serial (CSI 2) Server via P2 Via Server serial: 78 pin-D to 9 pin-D (P2) plus 9 to 25 pin-D 
extension cable.

Bay 07 serial (CSI 3) Server via P3 Via Server serial: 78 pin-D to 9 pin-D (P3) plus 9 to 25 pin-D 
extension cable.

Bay 10 serial (CSI 4) Server via P4 Via Server serial: 78 pin-D to 9 pin-D (P4) plus 9 to 25 pin-D 
extension cable.

Table 7. Rack-Mounted File Server Interconnections (Continued)

Connect From Connect To Comments/Remarks
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The following table provides information for connecting a HIS server. 

FAX modem application 
option(s)

Bay 02 serial (FAX 1) Server via P5 Via Server serial: 78 pin-D to 9 pin-D (P5) plus 9 to 25 pin-D 
extension cable.

Bay 05 serial (FAX 2) Server via P6 Via Server serial: 78 pin-D to 9 pin-D (P6) plus 9 to 25 pin-D 
extension cable.

Bay 08 serial (FAX 3) Server via P7 Via Server serial: 78 pin-D to 9 pin-D (P7) plus 9 to 25 pin-D 
extension cable.

Bay 11 serial (FAX 4) Server via P8 Via Server serial: 78 pin-D to 9 pin-D (P8) plus 9 to 25 pin-D 
extension cable.

Display

Power Supply UPS Via applicable AC power cord

Video Server Via display video cable (hardwired into display)

Keyboard

Keyboard Server Via keyboard cable (hardwired into keyboard)

Mouse/Trackball

Mouse/Trackball Server Via mouse/trackball cable (hardwired in mouse/trackball)

Table 7. Rack-Mounted File Server Interconnections (Continued)

Connect From Connect To Comments/Remarks

Table 8. MUSE/HIS Client Interconnections

Connect From Connect To Comments/Remarks

Workstation

Power Supply Ext. AC Ensure all devices are properly configured for the mains power (i.e. 
110 or 220 Vac).
Ensure all devices to be plugged into the UPS are turned ‘OFF’.

Video Display See “Display”

Keyboard Keyboard See “Keyboard/Barcode”

Mouse Mouse or Trackball See “Mouse/Trackball”

COM1 Mac8 connector Optional for MUSE Client

(PCI #4: top case slot) *

Network Interface Card
(PCI #3: 2nd case slot)

External Ethernet Optional

(PCI #2: 3rd case slot) *

Network Interface Card
(PCI #1: bottom case slot)

Ethernet Hub (Client-to-Ethernet Hub-to-Server) connection
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Uninterruptible power supply (UPS)
1. Unpack the UPS and place it in a location near where you plan to set up the 

workstation. An area on the floor and under the desk is recommended. Keep in 
mind that the unit needs to be accessible.

2. Ensure that the power switch on the back of the unit is in the OFF position.

3. Connect the UPS power cord into a 20 amp power outlet dedicated to the 
workstation.

NOTE
Do not connect your laser printer to the UPS. The large periodic current 
draw of the printer will trigger the low voltage alarm on the UPS.

4. Connect the UPS serial cable from the UPS serial port to COM1 on the file 
server.

Client
1. Unpack the system box.

2. Note the location of the items on the back of the system box. You need to know 
where each of the controllers or connectors are to properly set up your system.

Detailed descriptions of these items are in the original equipment manufacturer 
(OEM) manual you received with your system, and further defined in the 
“System components, controls, indicators” on page 2-22. You can also use the 
interconnect diagrams for locating the proper connectors.

3. Verify that the input power selection switch on the back of your system box is 
set correctly for your environment. The voltage visible on the switch is the 
voltage at which the system is set to operate.

4. Ensure the power control button, located on the front of the client hardware, is 
off. Also ensure that the system power enable switch on the back of the desktop 
server is in the off position by pressing the end marked 0.

5. Connect the AC power cord to the AC power receptacle on the back of the 
system box and to one of the power outlets on the back of the UPS.

Display

Power Supply Ext. AC Via applicable AC power cord

Video Client Via display video cable (hardwired into display)

Keyboard/Barcode

Keyboard/Barcode Reader Client Via keyboard cable (hardwired into keyboard)

Mouse/Trackball

Mouse/Trackball Client Via mouse/trackball cable (hardwired in mouse/trackball)

*Not used

Table 8. MUSE/HIS Client Interconnections (Continued)

Connect From Connect To Comments/Remarks
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Monitor
1. Unpack the monitor and place it on the desktop. The monitor may also be 

placed on top of the client.

2. Verify that the power switch is in the off position.

3. Connect the AC power cord to the power receptacle on the back of the monitor 
and to one of the power outlets on the back of the UPS.

4. Connect one end of the video cable to the back of the monitor and connect the 
other end to the appropriate port on the back of the system box. Use the 
interconnect diagrams as a reference.

NOTE
Be sure to connect the monitor to the file server and not the modem 
module.

Modem module
1. If a modem module was ordered, unpack it and place it in a location near the 

UPS.

2. Note the location of the items on the back of the system box. You need to know 
where each of the controllers or connectors are to properly set up your system.

Detailed descriptions of these items are in the original equipment manufacturer 
(OEM) manual you received with your system, and further defined in the 
“System Components, Controls, Indicators, and Locations” section in this 
chapter. See Table 8, “MUSE/HIS Client Interconnections,” on page 2-15 for 
locating the proper connectors.

NOTE
The modem module does not use a keyboard or a monitor.

3. Ensure the power switch on the back of the unit is in the off position by pressing 
the end marked 0.

4. Connect the AC power cord into the AC receptacle on the back of the system 
box and to one of the power outlets on the back of the UPS.

RSS multitech modem 
1. Unpack the modem and place it in a location near the file server.

2. Ensure that the power switch located on the side of the modem is in the off 
position.

3. Attach the AC power cord to the modem and to the UPS.

4. Connect one end of the RS232 cable to the COM2 port on the back of the file 
server. Connect the other end to the RS232 port on the back of the modem. Use 
Table 6, “Tower File Server Interconnections,” on page 2-12 or Table 7, “Rack-
Mounted File Server Interconnections,” on page 2-13 as a reference.

5. Connect one end of the phone wire to the LINE jack on the back of the modem 
and connect the other end to the appropriate phone jack in the wall.
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Fax/asynch CSI multitech modem
Refer to 2002783-012 “MUSE System Standard Fax/Asynch CSI Modem Upgrade” 
for specific instructions regarding how to add either the STANDARD FAX modem 
or the ASYNCH CSI modem as Windows Services on a MUSE File Server or client 
running Windows.

Keyboard and mouse
1. Ensure the system power is off.

NOTE
Power should always be OFF when connecting or disconnecting the 
keyboard or mouse.

2. Connect the keyboard/bar code wand cable to the 6-pin keyboard port on the 
back of the system box and to the port on the back of the keyboard. Use the 
interconnect diagrams as a guide.

3. Connect the mouse cable to the 6 pin mouse port on the back of the system box. 
See the interconnect diagram for the exact location.

Network connection

Twisted pair

1. If your network is twisted pair, unpack the 3Com Linkbuilder hub and place it 
near your system box or in the location designated by your customer’s IS 
department.

2. Connect each system box to the network by running your twisted pair wire from 
the twisted pair network port on the back of the system box to a port on the hub.

If necessary, multiple hubs may be linked together to accommodate a large 
number of workstations.

Enterprise network

If you are connecting to the customer’s enterprise network, your system contains a 
“special.” An RSA should be involved in the installation. 
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Printers
NOTE

Do NOT plug your laser printer into the UPS.

HP LaserJet

1. If you are connecting the HP laser printer to your system, unpack the 
HP LaserJet and place it in the desired location.

2. Follow the installation instructions provided in the HP manuals which 
accompanied your shipment of equipment.

JAM RECOVER Setting

After connecting your printer, ensure that the JAM RECOVER setting is turned on.
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Powering on and system shutdown

Introduction
The section includes the following procedures:

Powering on the workstation
Powering off the workstation
Exiting from MUSE system software to Windows desktop

Powering on the workstation
Power on your client as specified below. Additional information can be found in 
your file server’s OEM manual.

1. Verify that all system components such as the monitor, keyboard, etc. are 
connected. All connections should be made while the system is off.

NOTE
If a laser printer is part of the system, do not plug it into the uninterruptible 
power supply (UPS). In some environments, the cycling of power in the 
laser printer will cause the UPS alarm to sound (approximately every 
minute).

2. Turn on the UPS power switch.

3. Turn on peripheral devices, monitors, and printers.

4. Turn on the power enable switch on the back of your desktop and 
communication servers.

5. Press the power control button on the front of your system to turn it on. The 
system will power up and immediately begin the power-on self test (POST).

6. Make sure the Authorization window appears.

NOTE
System shutdown procedures are described in Chapter 4, “Integrated 
Maintenance Suite” .
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Checkout the workstation

Final checkout 
Perform the following for all applicable options. Use this manual and the MUSE 
system operator’s manual for reference.

1. Client Initialization – Power up all clients and ensure each initializes, error free, 
and you can log in.

2. Diskette Acquisition – Acquire test ECGs via electrocardiograph diskettes and 
ensure they plot according to report distribution.

3. Phone Acquisition – Acquire test ECGs via remote electrocardiograph modems 
and ensure they plot according to report distribution.

4. Local Acquisition – Acquire test ECGs via the MAC 8 acquisition cable and 
ensure they plot according to report distribution.

5. Holter – Locally transmit data from the Holter to the MUSE system.

6. TRAM Module – Test that data is successfully flowing from the TRAM to the 
MUSE system.

7. MAC LAB – Test that data can be sent from the MAC LAB to the MUSE 
system.

8. SDLC – Acquire test ECGs via remote SDLC modems.

9. CSI – Acquire test ECGs via remote CSI modems.

10. RSS – Contact Tech Support to ensure remote logon is possible.

11. Remote Query – Test CSI modem connections if system has Remote Query.

12. Edit – View and edit an ECG from the Edit List.

13. Writer/Printers – Test writers to ensure they plot. Check for burned out dots, 
especially in the bar code region.

14. Fax – Fax a record to test fax modems.

15. On-line Archives – If the system has on-line archive drives, ensure that backup 
tapes are up to date.

16. Backups – Perform a non-scheduled backup. See Chapter 4, “Integrated 
Maintenance Suite” for details. Check that all tapes are being successfully used. 
Replace tapes that are past their intended life span. The Customer should store 
old tapes for safe keeping.
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System components, controls, indicators
This section provides a description of the MUSE system hardware. The first diagram 
is a typical setup containing a tower file server and modem module. The second 
diagram shows a typical setup using a client.

Tower file server system

NOTE
The components shown in the figure above are representative of a typical 
MUSE system with a tower file server. They may not appear identical to the 
components of your system.

20A
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Table 9. Tower File Server System Description

Item Name Description

A Modem module Stores system’s modems.

B RSS modem Used by service to provide remote system support.

C Monitor Displays information, messages, etc.
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D Hub Hub used in twisted pair networks. This item is optional.

E File server System box. Contains the power supply, hard disk drive, RAM, central processing 
unit, etc.

F Mouse An input device used to move the cursor and select items on the display. The 
mouse is standard on the system.

G Keyboard The keyboard is an input device. Use the keyboard to type information when 
required by the system.

H UPS The UPS automatically provides temporary power to the MUSE system in the 
event of a power interruption. 

Table 9. Tower File Server System Description (Continued)

Item Name Description
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Workstation client system
This section provides a description of the MUSE system hardware. The hardware 
associated with a typical workstation client configuration is shown.

 

21A
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Table 10. Workstation Client System Description

Item Name Description

A Client The system box which contains the power supply, hard disk drive, RAM, central 
processing unit, etc.

B CSI modem Used to communicate with MAC VU, MAC 8, MAC 1200, and MAC 5000 resting 
ECG analysis systems.

C Monitor Displays information, messages, reports, ECGs, etc.

D HP LaserJet printer Optional laser printer used to print various reports on standard paper.
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E Mouse Input device used to move the mouse cursor and select items on the display.

F Keyboard The keyboard is an input device. Use the keyboard to type information when 
required by the system.

G Barcode reader Used to select and edit ECGs. Makes the system easier to use for those not used 
to working with computers.

Table 10. Workstation Client System Description (Continued)

Item Name Description
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Component Descriptions

ML 370 G5 File Server, CPU

ML 370 Rack, Front

Table 11. CPU Front, HP ProLiant ML370 G5, Rack Model

Item Description

A Hard drive bays 9 – 16 (not used)

B USB connectors

C Front Panel LEDs and buttons (See “ML 370 LEDs, Front Panel” on page 2-28 for 
more information.)

D Video Connector (rack model only)

E HP Systems Insite Display ejector button

F DVD/CD-ROM drive

G Removable media bays

H Hard drive bays 1-8*

* Only bays 1-6 are used.

A B C D E

FGH



Revision Z MUSE™ Cardiology Information System 2-27
2002783-027

Equipment Overview: Component Descriptions

ML 370 Tower, Front

 

Table 12. CPU Front, HP ProLiant ML370 G5, Tower Model

Item Description

A Media bay spacer

B DVD/CD-ROM drive

C Removable media bays

D Hard drive bays 1-8 (only bays 1-4 are used)

E Hard drive bays 9-16 (not used)

F USB connectors

G Front Panel LEDs and buttons (See “ML 370 LEDs, Front Panel” on page 2-28 for 
more information.)

H HP Systems Insight Display ejector button

A

B

C

DE

F

G

H
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ML 370 LEDs, Front Panel

A B C D E F G H

Table 13. CPU Front Panel LEDs and Buttons HP ProLiant ML370 G5

Item Description Status

A UID button –

B
UID LED Blue = Activated

Flashing blue = System is being managed remotely
Off = Deactivated

C

Internal system health LED Green = Normal (system on)
Amber = System health is degraded
Red = System health is critical
Off = Normal (system off)

D

External system health LED
(power supply)

Green = Normal (system on)
Amber = Redundant power supply failure
Red = Power supply failure. No operational power 
supplies.
Off = Normal (system off)

E
NIC 1 link/activity LED
(embedded NIC)

Green = Linked to network
Flashing green = Linked with activity on the network
Off = No network connection

F
NIC 2 link/activity LED
(embedded NIC)

Green = Linked to network
Flashing green = Linked with activity on the network
Off = No network connection

G
System power LED Green = System has AC power and is powered up

Amber = System has AC power and is in standby mode
Off = System has no AC power

H Power On/Standby button –
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ML 370 Connectors, Rear Panel

Table 14. CPU Back HP ProLiant ML370 G5

Item Description

A Keyboard connector

B Mouse connector

C USB connectors

D iLO 2 management connector

E Video connector

F Serial connector

G NIC 2 connector

H PCI expansion slots

I Hot-plug power supply (primary bay)

J Hot-plug power supply blank (redundant bay)

K NIC 1 connector

L T-15 Torx screwdriver

A B C D FE G H

IJKL
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ML 370 LEDs and Buttons, Rear Panel

Table 15. Rear Panel LEDs and Buttons

Item Description Status

A
UID LED Blue = Activated

Flashing blue = system is being remotely managed
Off = Deactivated

B iLO 2 activity LED Green or flashing green = Network activity
Off = No network activity

C iLO 2 link LED Green = Linked to network
Off = No network connection

D NIC 2 activity LED Green or flashing green = Network activity
Off = No network activity

E NIC 2 link LED Green = Linked to network
Off = No network connection

F NIC 1 link LED Green = Linked to network
Off = No network connection

G NIC 1 activity LED Green or flashing green = Network activity
Off = No network activity

H Power supply LED Green = System has AC power and is powered up
Off = System has no AC power

A

B C D E

FG

H
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ML 370 G5 File Server, Accessories

HP Insight 2 Display

Table 16. Insight 2 Display

Item Description Indicator Description

1
Primary power supply Amber Failure

Off Normal

2
Redundant power supply Amber Failure

Off Normal

3

Online spare memory Green Protection enabled

Amber Memory failure occurred

Flashing amber Memory configuration error

Off No protection

4

Mirrored memory Green Protection enabled

Amber Memory failure occurred

Flashing amber Memory configuration error

Off No protection

5
F8DIMM LEDs (Mem board 1)* Amber Failure

Off Normal

6
F8DIMM LEDs (Mem board 2)* Amber Failure

Off Normal
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7
Processor 1 Amber Failure

Off Normal

8
PPM 1 Amber Failure

Off Normal

9
Processor 2 Amber Failure

Off Normal

10
PPM2 Amber Failure

Off Normal

11
Hot-plug fan Amber Failure (or fan not installed)

Off Normal

12

Internal system health Green Normal, system on

Amber Degraded health

Red Critical health

Off System off

13

External system health 
(power supply)

Green Normal, system of

Amber Redundant power failure

Red Power supply failure, no 
operational power

Off System off

14
Over temperature Red Critical overheating

Off Normal

15

System power Green AC power on

Amber System in standby mode

Off No AC power

* If all LEDs for a memory board are flashing, it indicates the memory board is 
unseated.

Table 16. Insight 2 Display (Continued)

Item Description Indicator Description
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Sony AIT Tape Drive LEDs

 

Table 17. Sony AIT tape drive LEDs

LED
Sense

TAPE MOTION CLEANING REQUEST REPLACE TAPE

Independent Independent Tape loaded

Independent Independent Tape access in progress (write/read)

Independent Independent Tape access in progress (others)

Independent Independent Cleaning is requested

Independent Independent Cleaning is not completed

Independent Independent Media error occurred

H/W Error Occurred
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UPS, Front Panel 

Table 18. UPS for HP File Server (Front)

Item Name

A LED indicating overload capacity

B LED indicating 76% to 100% load capacity

C LED indicating 51% to 75% load capacity

D LED indicating 26% to 50% load capacity

E LED indicating 0% to 25% load capacity

F Voltage Configuration Panel *

* Accessible only when the front bezel is removed.

G Configure mode on LED *

H Configure button *

I TEST/ALARM RESET Button

J STANDBY Button

K ON Button

L General Alarm

M On Battery

N Bad Battery / Low Battery

O Site Wiring Fault Indicator

P Utility LED

! + -
100%

25%

A

E

B

C

D

G FHI

J K L M N O P
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UPS, Rear Panel

Table 19. UPS for HP File Server (Back)

Item Name

A Load Segment 1

B Load Segment 2

C Load Segment 3

D Load Segment Circuit Protectors

E PDU (Power Distribution Unit) output receptacle

F Ground bonding screw

G ERM (Extended Runtime Modules) connector

H REPO (Remote Emergency Power Off) port

I Communications Port / Option Slot

D

EF

A B C

GH

I
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HP DL 360 G5 HIS server

HP DL360, Front Panel

Table 20. HP DL360 G5 Server

Item Name

A Hard drive bay 5 (not used on GE-supplied hardware)

B Hard drive bay 6 (not used on GE-supplied hardware)

C Multibay drive bay

D USB connector

E HP Systems Insight Display

F Video connector

G Hard drive bay 4 (not used on GE-supplied hardware)

H Hard drive bay 3 (not used on GE-supplied hardware)

I Hard drive bay 2

J Hard drive bay

A B C

DEFGHIJ
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HP DL360 LEDs and Buttons, Front Panel 

A B C

D

E

F

Table 21. HP DL360 G5 Server, Front Panel LEDs and Buttons

Item Description Status

A

Power On/Standby 
button and system 
power LED

Green = System is on.
Amber = System is shut down, but power is still 
applied.
Off = Power cord is not attached, power supply 
failure has occurred, no power supplies are 
installed, facility power is not available, or 
disconnected power button cable.

B

UID button/LED Blue = Identification is activated.
Flashing blue = System is being remotely 
managed.
Off = Identification is deactivated.

C

Internal health LED Green = System health is normal.
Amber = System health is degraded. To identify the 
component in a degraded state, refer to “HP 
Systems Insight Display and LEDs” (“HP Systems 
Insight Display and LEDs” on page 77).
Red = System health is critical. To identify the 
component in a critical state, refer to “HP Systems 
Insight Display and LEDs” (“HP Systems Insight 
Display and LEDs” on page 77).
Off = System health is normal (when in standby 
mode).

D

External health LED 
(power supply)

Green = Power supply health is normal.
Amber = Power redundancy failure occurred.
Off = Power supply health is normal when in 
standby mode.
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HP DL360, Rear Panel

E

NIC 1 link/activity LED Green = Network link exists.
Flashing green = Network link and activity exist.
Off = No link to network exists.
If power is off, the front panel LED is not active. 
View the LEDs on the RJ-45 connector for status 
by referring to the rear panel LEDs
(“Rear panel LEDs and buttons” on page 74).

F

NIC 2 link/activity LED Green = Network link exists.
Flashing green = Network link and activity exist.
Off = No link to network exists.
If power is off, the front panel LED is not active. 
View the LEDs on the RJ-45 connector for status 
by referring to the rear panel LEDs
(“Rear panel LEDs and buttons” on page 74).

Table 21. HP DL360 G5 Server, Front Panel LEDs and Buttons (Continued)

Item Description Status

A B C D

EFGHIJKLM

Table 22. DL360 G5, Rear Panel

Item Description

A PCI Express expansion slot 1, low-profile, half-length

B PCI Express expansion slot 2

C Power supply bay 2

D Power supply bay 1

E NIC 2 connector

F NIC 1 connector

G Keyboard connector

H Mouse connector

I Video connector

J Serial connector
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HP DL360 LEDs and Buttons, Rear Panel

K USB connector

L USB connector

M iLO 2 NIC connector

Table 22. DL360 G5, Rear Panel (Continued)

Item Description

Table 23. DL360 G5, Rear Panel LEDs and Buttons

Item Description Status

A
iLO 2 NIC activity LED Green = Activity exists.

Flashing green = Activity exists.
Off = No activity exists.

B iLO 2 NIC link LED Green = Link exists.
Off = No link exists.

C
10/100/1000
NIC 1 activity LED

Green = Activity exists.
Flashing green = Activity exists.
Off = No activity exists.

D 10/100/1000
NIC 1 link LED

Green = Link exists.
Off = No link exists.

E
10/100/1000
NIC 2 activity LED

Green = Activity exists.
Flashing green = Activity exists.
Off = No activity exists.

D 10/100/1000
NIC 2 link LED

Green = Link exists.
Off = No link exists.

E

UID button/LED Blue = Identification is activated.
Flashing blue = System is being managed 
remotely.
Off = Identification is deactivated.

F Power supply 2 LED Green = Normal
Off = System is off or power supply has failed

G Power supply 1 LED Green = Normal
Off = System is off or power supply has failed

A B C D E F G H I
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MUSE rp5700 Client

RP5700 Controls and Indicators, Front Panel 

Table 24. rp5700 client, front panel controls and indicators

Item Description

A Recessed power button

B LEDs

C 2 USB 2.0 ports with rubber cover

D 2-button optical scroll mouse

E Keyboard

F Internal hard drive

G CD/DVD drive

A

B

C

DE

F

G

H
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RP5700 Connectors, Rear Panel

Table 25. rp5700 client, rear panel connectors

Item Description

A Line in and line out audio jacks

B PS/2 mouse port

C PS/2 keyboard port

D RS232 serial COM1 port

E Parallel port

F VGA port

G RS232 serial COM2 port

H 4 USB 2.0 ports

I RJ-45 LAN jack

J 2 low-profile slots: left ADD2/SDVO slot, right PCI3-x1

K 2 full-height PCI slots

L 240W 80 PLUS® – Active PFC power supply (no line switching required)

ABCDEFGHI

J

K

L
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MUSE dc7600 Client

DC7600 Controls and Indicators, Front Panel 

Table 26. MUSE dc7600 Client, Front Panel Controls and LEDs

Item Description Item Descriptions

A Diskette drive activity light G Dual-state power button

B Diskette drive H Power-on light

C Optical drive activity light I Hard drive activity light

D Diskette eject button J USB ports

E Optical drive (xx) K Headphone connector

F Optical drive eject button L Microphone connector

A

B C D E F

GI HJKL
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DC7600 Connectors, Rear Panel 

Table 27. MUSE dc7600 Client – Rear Panel Connectors

Item Name

A RJ-45 network connector

B Parallel connector

C | O | O | Serial connector

D Power cord connector

E Line-in audio connectors

F PS/2 keyboard connector (purple)

G PS/2 mouse connector (green)

H Monitor connector

I USB Ports

A B C D

EFGHI
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MUSE dc7100 Client

DC7100 Controls and Indicators, Front Panel 

Table 28. MUSE dc7100 Client, Front Panel Controls and LEDs

Item Description Item Descriptions

A Diskette Drive Activity Light G Microphone Connector

B Diskette Drive H Headphone Jack

C Optical Drive Activity Light I USB (Universal Serial Bus) 
Ports (2)

D Diskette Eject Button J Hard Drive Activity Light

E
Optical Drive (CD-ROM CD-R/
RW, DVD-ROM, DVD+R/RW, 
or CD-RW/DVD Combo Drive

K
Power On Light

F Optical Drive Eject Button L Power Button

C EA B C D E F

G H I J K L M



Revision Z MUSE™ Cardiology Information System 2-45
2002783-027

Equipment Overview: Component Descriptions

DC7100 Connectors, Rear Panel 

NOTE
Arrangement and number of connectors may vary by model.

Table 29. MUSE dc7100 Client – Rear Panel Connectors

Item Name

A Power Connector

B PS/2 Mouse Connector

C PS/2 Keyboard Connector

D Universal Serial Bus (USB)

E Serial Connector

F RJ-45 Network Connector

G Parallel Connector

H Monitor Connector

I Headphone/Line-Out Connector

J Line-In Audio Connector

K Microphone Connector

MD1350-175A
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HP L1910 LCD Monitor

Table 30. HP L1210 LCD Monitor Controls

Item Name

A Menu Selection

B Menu “-” Selector

C Menu “+” Selector

D Power LED

E Power Button
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HP P4015N LaserJet Printer

HP P4015N Features, Front

Table 31. HP P4015N LaserJet Printer

Item Name

A 500 Sheet Tray 2

B 100 Sheet Multi-Purpose Input Tray

C Control Panel Display

D Control Panel
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HP P4015N Connectors, Rear Panel

Table 32. HP P4015N LaserJet Printer

Item Name

A HP Jetdirect Gigabit Ethernet embedded print server with IPSec

B One external and two internal Host USB 2.0-like ports for third-party 
connections

C Hi-Speed USB 2.0 port for direct connection to printer
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CD-ROM drive

Table 33. CD-ROM Drive

Item Name Description

A Headphone connector Connect headphones here.

B Variable control dial Use to vary CD volume.

C LED Light indicates CD-ROM drive activity.

D Eject button Press to remove CD-ROM.

A B C D
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Universal modem

Item Name Description

1 TD (Transmit Data) The TD LED flashes when the modem is transmitting data to another modem. 

2 RD (Receive Data) The RD LED flashes when the modem is receiving data from another modem.

3 CD (Carrier Detect) The CD LED lights when the modem detects a valid carrier signal from another modem. 
It is on when the modem is communicating with the other modem and off when the link is 
broken.

4 OH (Off-Hook) The OH LED lights when the modem is off-hook, which occurs when the modem is 
dialing, online, or answering a call. The LED flashes when the modem pulse-dials.

5 TR (Terminal Ready) The TR LED lights when a communication program is using the modem. It means the 
modem is ready for an outgoing or incoming call. It goes off when the communication 
program disconnects the serial port. When it goes off, a connected modem will also 
disconnect.

48A
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Installation documents
The following table summarizes installation/upgrade documents that have been 
written for the MUSE system at version 005E software.

Part Number Title

2002783-012 MUSE Standard Fax/Asynch CSI Modem Upgrade

2002783-039 MUSE Messaging Configuration and Setup Guide

2002783-040 MUSE/LifePak 12 Data Interface Configuration and Setup Guide

2020285-024 File Server Installation

2006660-016 Network Printer Installation

2006660-022 Client Software Installation

2020285-104 Monitoring Gateway Installation

2020285-097 Install MUSE 5E Software on Customer-Supplied Hardware

2020285-092 HIS Software-Only Installation Instructions

2020285-023 Advanced Security Guide

2020285-025 MUSE Pre-Installation Manual

2020285-022 G4 File Server Software Upgrade

408287-080 MARS-to-MUSE

2000656-010 CASE-to-MUSE

419931-003 CV Web Installation

419931-040 Data Transfer

2020285-192 MUSE Client Build Instructions

2027237-019 SD Card Reader Installation Instructions (English)

2027237-021 SD Card Reader Installation Instructions (French)

2027237-022 SD Card Reader Installation Instructions (Italian)

2027237-023 SD Card Reader Installation Instructions (German)

2027237-024 SD Card Reader Installation Instructions (Swedish)

2027237-025 SD Card Reader Installation Instructions (Danish)

2027237-026 SD Card Reader Installation Instructions (Norwegian)

2027237-034 SD Card Reader Installation Instructions (Simplified Chinese)
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How to set up the direct to database feature
If the customer wants to send reports directly to the database (rather than the 
Edit List), perform the steps below.

1. Log in to the system with the Service password.

2. Select System → System Setup.

The Location window for Location 0 is displayed.

3. Click the Incoming report routing>> button.

The Incoming report routing window appears.
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4. For each data type, select the desired routing of incoming reports.

NOTE
If In-basket is selected, click the In-basket button to select the desired 
in-basket.

5. Click OK.

6. Repeat for each Location.

7. Inform the customer of the modifications you made to their incoming report 
routing. If necessary, they may need to find reports using the Retrieval 
command.
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Installing and Configuring the I2 Option
The I2 (Information Interchange) option is required for systems that are acquiring 
data in XML format. The MUSE system can acquire data in XML format from the 
following devices:

LIFEPAK 12 - through the LIFENET Receiving Station (reference document 
2002783-040)
DatamedFT (Format Translator) provided by Engineering Solutions.

The Information Interchange option is listed in the Installed Option list as I2.

Requirements
The following requirements must be met on the MUSE file server.

1. The I2 option must be installed.

This is installed by GE Service using the MUSE Options utility.

2. The following line must be added to d:\vol000\system\sysinf\xmlacq.asc:

\\servername\vol000\tmp\xml\*.xml; 

Where servername is the name of the MUSE file server. 

The semi-colon at the end of the command must be included. 

3. The CVIS0553 service must be installed and running. 

Add CVIS0553 to backtask.asc and install it as a service using the following 
command: 

CVADDSVC  [Space] Domain\MuseBkgnd  [Space] Password [Space] 
CVIS0553

Where:

Domain is the domain where the MuseBkgnd account exits. If Musebkgnd 
is a local account then Domain is the name of the MUSE file server
Password is the password of the MuseBkgnd service account

Start the CVIS0553 service after it has been added. 

4. The Microsoft XML Parser must be installed.

Refer to “Installing the MSXML Parser” on page 3-6 for details. 
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Installing the MSXML Parser
In order to install Microsoft XML Parser (Microsoft Core Services) the system 
needs Windows Installer version 2. The procedure in this section provides the steps 
to install the XML Parser and to update the version of the Windows Installer if 
necessary.

1. Insert the MUSE Support CD #1 into the CD-ROM drive.

2. Type or browse to z:\XML\Parser\msxml.msi (where z indicates the 
drive letter of the CD-ROM drive) and click OK.

3. If you get a message that you need a newer version of the Windows Installer 
service, complete the following steps.

a. Press Ctrl + Esc and then press R. 

b. Browse to z:\XML\Installer\instmsiw.exe (where z indicates the 
drive letter of the CD-ROM drive) and click OK.

c. When you get the Windows Installer Setup Completed Successfully 
message, click OK. 

d. Return to step 1 to install the parser.

4. Click Next at the Welcome to the Microsoft XML Parser and SDK Setup Wizard 
window.

5. At the End-User License Agreement screen click the radio button for I accept 
the terms in the License Agreement and select Next.

6. At the Customer Information screen, accept the defaults for User Name and 
Organization and click Next.

7. At the Choose Setup Type select Customize.

8. Accept the default selection at Microsoft XML Parser and select Install Now.

9. At the Competing the Microsoft XML Parser and SDK Setup Wizard screen 
click Finish to complete the install.
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Enabling the I2 Option
This XMLCONFIG.EXE utility, located on MUSE Support CD #1, is used to insert 
entries into \sysinf\xmlmap.btr. Before running the utility, launch the MUSE 
application on the file server so the H: drive is mapped.

1. Run the utility and log in with the service username and password.

2. Click Add New.

3. For LifePak 12 enter the following and then refer to the MUSE CV Information 
System/LIFEPAK 12 Data Interface Configuration and Setup Guide 
(PN 2002783-040):

Or, for a DatamedFT, enter the following:
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Or, for a Phillips-to-MUSE db conversion, enter the following:

4. Click Add Device (LifePak 12 or DatamedFT) or Modify (Phillips-to-MUSE 
db conversion)

5. Select OK to exit the utility.

NOTE
If you get an error creating the device, run the utility again, delete the 
device that you just created, and run through steps 2-5 again to recreate 
the device.
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Adjust daylight savings time to comply with the 
Energy Policy Act of 2005

If the MUSE 5E system is to be installed in the United States or Canada, you need to 
ensure that the appropriate Microsoft patches for changing the Daylight Savings 
Time start and end dates have been applied to the system. This will facilitate an 
accurate Daylight Savings time change in the MUSE system.

1. Browse to the GE Healthcare Product Security Database Web site:

http://www.gehealthcare.com/usen/index.html

2. Click Product Security from the Solutions drop-down list.

3. Click Daylight Saving Time Change.

4. Click the CLICK HERE to learn how to keep your system right on time! link.

5. Select the following from the three lists that appear next.

Vendor: GE Healthcare
Modality/Category: Cardiology
Product: MUSE

6. Click the Click Here link provided for the DST Procedure as shown in the 
following figure.

http://www.gehealthcare.com/usen/index.html
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7. If you need additional information on Daylight Savings Time, open the 
PDF file.

a. Click Open in the File Download window to read or print the bulletin.

b. After reading or printing the information, select File > Close to close the 
bulletin.

The bulletin describes the process required, specific to each of the GE 
Healthcare Diagnostic Cardiology products, to account for the United 
States and Canada DST change. It also provides detailed instructions for 
downloading and applying the appropriate Microsoft patches required.

8. Use the information in the file to determine if any Microsoft patches need to be 
applied to the MUSE 5E system. 

If any patches need to be applied, use the information in the bulletin to 
download and apply the appropriate patches. 
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Introduction
The Integrated Maintenance Suite (IMS) application is provided with the MUSE CV 
information system for database backup and archive, as well as integrity checking, 
queue rebuilding, and system shutdown and restart. The system uses a third-party 
package to allow the file server to remain online during backup and therefore all 
workstations will also remain active during backup.

The MUSE CV information system has been set up to automatically run the IMS 
application every night at 3:00 am. When the IMS application runs, it does the 
following tasks:

Integrity checking,
Database analysis.
Archive checking. Before doing a backup, the IMS applications checks if an 
archive should occur, and warns the user when an archive is near. 
Disk space checking. The IMS application begins checking for low disk space 
180 days prior to an archive (when additional disk space is required). 
Automatic database archive. Automatic archive of database is triggered by any 
one of the following conditions:

if the highest numbered database file approaches “255” 
if the total amount of data on the C: drive + Vol000 + the highest volume 
number approaches the capacity of the backup tape, or 
there is a scheduled archive date, or 
the disk space on the active volume is running low.

Database backup.
NOTE

Database backup does not occur for systems that have been set up for 
network backup.

Detailed logging of messages.
Optional notification of significant events via email. 
Optional notification of significant events via MUSE editor. 
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Database backup
Under normal circumstances, the IMS application does a FULL BACKUP EVERY 
DAY to the tape inserted at the file server.

A set of seven tapes is required for the 7-day backup rotation used by the IMS 
application. The IMS application requires that you sequence through the set of seven 
tapes, maintaining the same order every week. If the tapes are used out of sequence, 
the full backup is performed and a warning is entered in the MUSE Event Log (and 
the optional email notification message).

Technical support for IMS
There are many references within this chapter to contacting the Jupiter On-Line 
Center for technical support for systems in the United States. The phone number for 
the Jupiter On-Line Center is 1-800-558-7044. If you need technical support for a 
system and you are not in the US, see “How to Reach Us” at the front of this manual 
to determine whom to contact for technical support.

Network backup
If the user has agreed to use their own network backup, they assume full 
responsibility for all data residing on the file server. IMS will not perform any data 
backup, however IMS must continue to run to perform integrity checking and 
database analysis. If you want your system configured for network backup, contact 
the Jupiter On-Line Center.
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Configuration
There are two features of IMS that may be configured. Generally, the default 
parameters initially configured with the system should suffice, and no 
reconfiguration is necessary. These default parameters include the following:

Automatic Daily Backup occurs at 3:00 am
Users with System Owner privilege are notified of IMS-related events/
conditions

These items can be reconfigured if the default settings are not suitable for your 
system.

IMS notifications
The Notifications window in System Setup serves two purposes. It allows the System 
Owner to set up notification of IMS events and conditions to editors and site 
managers. The Notifications window also indicates that IMS events and conditions 
have occurred and provides a checkbox to acknowledge the event/condition. To 
view the Notifications window, follow the steps below:

1. Log in to the MUSE CV system as the System Owner.

2. Select System → System Setup → System → IMS Notifications.

The Notifications window appears.

NOTE
There are three groups of users who can be configured for notification of 
IMS events and conditions – Editors, Site Managers, and System Owners. 
Notification to System Owners only is the default setting.

3. To configure the other user groups for notification, select the check box next to 
the name of the group in the Notifications window and click the Save button.

When an IMS event or condition occurs, the users who have been configured 
for notification will see a window similar to the following when they start the 

MD1350-124A
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Editor application.

If the user clicks OK in the IMS notification window, the window will 
continue to appear until the event or condition is fixed.
If the user clicks Cancel in the IMS notification window, the window will 
no longer be displayed. However, the window will continue to appear for 
users of a higher privilege level. For example, if a user with Edit privileges 
acknowledges the event/condition by clicking Cancel, the window will 
continue to appear for Site Managers and System Owners when they log 
into the system. When a user acknowledges an IMS event/condition, it will 
be logged to the Event Log.

For each Event and Condition, there is a check box labeled Occurred and a 
check box labeled Acknowledged. When an event or condition occurs, a check 
mark is added to the Occurred check box. The check mark is cleared when the 
event/condition is fixed. 

NOTE
The three archive-related events can only be cleared by clicking the 
Acknowledged check box in the Notifications window. Only the System 
Owner can clear these events.

Events

Backup failed. There was a failure during the Backup operation. This is 
generally caused by a missing tape, a physically bad tape (due to wear, overuse 
or contamination), or incorrect tape label. 
NOTE

If the tape inserted in the drive is labeled with any one of the 7 days of the 
week (Sunday, Monday, etc.), the backup will occur even if the tape label 
does not match the current day of the week.

The daily backup will fail if the tape inserted in the drive is not one of the 7 
tapes labeled with days of the week. For example, if an archive tape is in 
the drive when a the system attempts to perform a daily backup, the backup 
will fail. IMS will not overwrite archive backup tapes, monthly backup 
tapes or service backup tapes during a regular daily backup. 

In the event of a failed backup, the user can perform a manual backup or wait 
for IMS to attempt a backup the following night. 

Archive occurred. The system archived successfully. This should generally be 
accompanied by an “Archive backup 1 occurred” message.

MD1350-125A
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Archive backup 1 occurred. The current tape now contains a backup (1st of 2) 
of the archived volume. This tape should be labeled and removed from rotation. 
The archive backup tapes should be stored in a safe place. If they are needed in 
the future for disaster recovery, they may be the only source that contains a 
copy of this portion of the database.
Archive backup 2 occurred. The current tape now contains a backup (2nd of 2) 
of the archived volume. This tape should be labeled and removed from rotation. 
The archive backup tapes should be stored in a safe place. If they are needed in 
the future for disaster recovery, they may be the only source that contains a 
copy of this portion of the database.

Conditions

No recent backup. Indicates that at least one week has passed since the last 
successful daily backup This is a serious problem that requires investigation. 
Check the Error Log and Event Log for information as to why the backups are 
failing or not being performed at all.
Backup media not changed. It has been one week since the tape was rotated. 
The same tape (e.g. the “Friday” tape) is being used each night. Using the same 
tape over and over will not only wear out the tape and eventually cause backup 
to fail, but also restricts disaster recovery options to a single tape.
Archive pending. Indicates that an archive will occur soon (generally within two 
to three weeks).
Disk space low (vol000). Indicates that the disk space available for the D drive 
is low. A larger drive will need to be installed, or if the active volume is 
currently on the D drive, it may make sense to move it to another drive. Contact 
the Jupiter On-Line Center for assistance.
Disk space low (active volume). Indicates that the disk space available for the 
drive containing the active volume is low. An archive will occur prematurely 
unless some space is made available on the drive, or it is replaced with a larger 
disk drive. Contact the Jupiter On-Line Center for assistance.
Disk space low (target volume). Indicates that there is not enough disk space 
available for a new archive volume. It is necessary to increase the storage 
capacity of the system. Contact the Jupiter On-Line Center for assistance.
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Email notification
IMS may be configured to email a report to one or more selected users. See “Email 
notification of IMS events” on page 4-21 for details on how to configure email 
notification of IMS events. When configured to receive email notification, a user 
will receive a daily email from IMS. This email can be configured to contain IMS 
warnings, IMS error information, and/or all status information.

The messages contained in the email notification are the same as those displayed in 
the Details section of the IMS Status window. (Refer to “IMS status window” on 
pages  4-10 through  4-13 for further information.)
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Daily responsibilities
The following daily responsibilities are required in order to use the IMS application 
responsibly.

Rotate backup tapes. Insert the correct backup tape every day.
NOTE

For systems using the network backup option, tape rotation is not required.

Review the IMS Status window.
Review the Notifications window.

Rotate backup tapes (not required for network backup)
A set of 11 tapes ships with the system. Seven tapes are required for the complete 
backup cycle required by the IMS application. One tape is to be used for the monthly 
backup and one tape is to be used for the monthly service backup. The remaining 
tapes are to be stored in reserve for when the first database archive occurs. Label the 
tapes as follows: 

Leave the two remaining tapes unlabeled. They will be used to replace the day of the 
week tapes that become archive backup tapes after an archive takes place. (Refer to 
“Check for archive (not required for network backup)” on page 4-12.)

NOTE
In order to improve tape reliability, record the date each tape is used. This 
includes each time a tape may be re-used over a weekend (for users that are 
unable to rotate tapes on weekends).

Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
Monthly Backup
Monthly Service Backup
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The MUSE CV information system has been set up to automatically run the IMS 
application every night at 3:00 am. Therefore, every day before the 3:00 am 
automatic backup, you must remove the previous backup tape and insert the next 
one. 

1. Press the eject button on the tape drive to eject the current tape.

2. Wait for the tape to rewind and eject.

NOTE
If the tape was ejected by IMS, review the Details section of the IMS Status 
window to determine why. (Refer to “IMS status window” on pages  4-10 
through  4-13.) There are 4 possible reasons why the tape was 
automatically ejected from the drive:

Archive has taken place
Archive backup has taken place
Monthly backup has taken place
Service backup has taken place

Tapes containing archive backups should not be reused. They should be 
labeled and put in storage. 

3. Record the date(s) the tape was used on the usage grid, which is located on the 
tape label.

4. Put the tape back into its jacket.

5. Find and insert the next day’s tape.
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IMS status window
IMS backup and archive information is available in System Status. To view the IMS 
status window select System → System Status → System → IMS Status. 

A typical IMS status window is shown below.

Verify the IMS application ran

Review the Last IMS operation section of the IMS Status window. Use the 
information displayed in this window to verify that IMS ran the previous night. 
Typically, BACKUP will appear in the LAST IMS operating Type field. Call Jupiter 
On-Line Center if IMS did not run within the last 24 hours.

C: 1.4 of 3.9Gb used, 64% free
D: 9.3 of 13.0Gb used, 29% free

3.5 of 11.2Gb used, 69% free

MD1350-126A
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Check the backup

Verify that a successful nightly backup occurred. The date should reflect the 
previous night’s backup schedule time. Also verify that the correct tape was used. 
The tape label is shown in “Last backup media label.” If the tape label does not 
match the current day of the week, verify you have the correct tape inserted for the 
next backup.

NOTE
If the line {WARNING} current media label is (?), expected (??) appears in the 
Details section (where ? and ?? are replaced by the label rotation found and 
expected), this indicates that the tape was not rotated prior to the backup 
operation. This Warning line does not indicate a failed backup. Users who are 
unable to rotate tapes on the weekends will always see this warning on Monday 
morning.

If the backup has failed, a manual backup may be required. See “Manual backup” on 
page 4-16 for detailed procedures.

Check the last IMS operation

The last IMS operation will indicate what type of operation occurred. The possible 
messages which may appear in the Type field include:

There are two possible messages which may appear in the Status field. They include:

If the operation failed, refer to the Details section and scroll through the list, looking 
for any messages labeled {ERROR}. A failed backup may result from:

There was no tape in the drive. 
A tape was inserted however it had a smaller capacity than required. 
A tape with an incorrect label. Tapes which are labeled as archive backup tapes, 
monthly backup tapes and monthly service tapes may not be used for daily 
backups. Daily backups will not overwrite tapes with these labels. A message 
will indicate this in the details section. 

BACKUP for an automatic nightly backup

MANUAL BACKUP for a manual backup

MONTHLY for a monthly backup (manual backup)

SERVICE for a monthly service backup (manual backup)

ARCHIVE for an archive

ARCHIVE/BACKUP for an backup of an archive volume

Successful The operation succeeded

Failed The operation failed.
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Check for archive (not required for network backup)

If an automatic archive has taken place, the last operation will show BACKUP/
ARCHIVE. Also, the daily tape, which now contains the archive, will be ejected 
from the tape drive in the file server if the backup of the archive succeeded. If the 
operation was successful: 

1. Remove the archive backup tape from the tape drive. Label it as noted in the 
Details section. Write protect the tape and store in a safe place.

2. Label a new blank tape (PN 2291440) to replace the daily tape removed from 
the rotation in step 1. (Label tape with the same “day of the week” label as the 
tape you removed.)

3. Insert the next day’s tape. The IMS application will make another archive 
backup copy the following night.

4. The next morning, after the IMS application has made the second archive 
backup tape, remove the tape and label it as noted in the Details section. Write 
protect the tape and store it with the first archive backup tape.

5. Label another new tape to replace the daily tape removed from the rotation in 
step 4. (Again, use the same “day of the week” as the tape you removed.)

NOTE
Expect to see New or unrecognized backup media, will be labeled as (?) 
where ? is the current weekday.

NOTE
If an archive fails contact the Jupiter On-Line Center to correct the archive.

Review the details section of the IMS status window

Significant IMS messages are noted in the Details section.
ERROR: Unable to access the tape. Check to be sure a tape was inserted.
Disk full warning messages. When the volume of data on the hard disk is 
reaching capacity, the IMS application begins logging messages to the Details 
section and MUSE Event Log. This message should first appear approximately 
180 days before the hard drive is filled. When this message first appears in the 
Details section, contact the Jupiter On-Line Center. It is necessary to increase 
the storage capacity of your system.
Archive prediction. As the system approaches automatic archive conditions, the 
IMS application logs appropriate messages to the Details section and MUSE 
Event Log. IMS includes the predicted number of days until archive (based on 
daily use) in the Details section.
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WARNING: Backup/Archive: sequence (?), (#) files skipped (where ? is 
replaced by the rotation and # is replaced by a number). These indicate files 
which were not backed up. It is important to review which files are skipped to 
determine whether the backup is OK. Contact the Jupiter On-Line Center.
NOTE

The MUSE CV information system uses a third party package to allow the 
file server to remain online during backup. During periods of heavy MUSE 
CV information system traffic (for example, more than normal acquiring, 
editing, printing, and HIS link traffic), backup may skip some files, and this 
will be logged as a warning message. If this occurs frequently, see “Re-
schedule automatic backup” on page 4-16 for details on how to re-schedule 
the time at which the IMS application runs or contact the Jupiter On-Line 
Center for assistance. 

ERROR: Integrity Failed. Integrity Errors. If this message appears in the 
Details section, call the Jupiter On-Line Center.

Review notifications window (System Owner)
IMS is configured to provide notification of significant events and conditions to 
MUSE users. Initially only the system owner is configured to receive these 
notifications when logging into the MUSE CV system. These notifications may be 
disabled, and the system owner may elect not to log in to the MUSE. If this is the 
case, the System Owner should view the Notifications window daily to check for 
and acknowledge messages. Refer to “IMS notifications” on pages  4-4 through  4-6 
for more information.



4-14 MUSE™ Cardiology Information System Revision Z
2002783-027

Integrated Maintenance Suite: Responsibilities (monthly)

Responsibilities (monthly)
NOTE

The following monthly responsibilities are required if the systems are using 
database backup and are recommended if the systems are using network 
backup.

Update the monthly backup tape
1. Insert the Monthly Backup tape.

2. Select Start → Programs → MUSE CV Information System → Integrated 
Maintenance Suite → Manual Backup.

3. Select the Monthly Backup button.

4. Wait for the progress bar to disappear.

5. Wait for the tape to be ejected.

6. Eject the Monthly Backup tape.

7. Continue with “Manual backup” on page 4-16.

Update the monthly service tape
1. Find and insert the Monthly Service tape.

2. Select Start → Programs → MUSE CV Information System → Integrated 
Maintenance Suite → Manual Backup.

3. Select the Monthly Service button.

4. Wait for the progress bar to disappear.

5. Wait for the tape to be ejected.

6. Remove the Monthly Service tape.

7. Insert the next backup tape from the front of the rotation stack.
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Responsibilities (every 3 months or 100 hours)

Run the cleaning cartridge
The tape drive manufacturer recommends cleaning the tape drive when the 
CLEANING REQUEST LED is on to keep the tape drive in good working order. 

Clean tape drive when CLEANING REQUEST LED is on. 

CAUTION
Regular cleaning is vital to trouble-free operation of any tape 
device. Failure to follow recommended cleaning procedures could 
result in serious damage to the tape drive.

GE recommends cleaning the drive once every 3 months or every 100 hours of use, 
whichever comes first.

When a drive is cleaned according to a regular schedule, one cleaning cycle 
typically removes accumulated dirt and particle deposits. However, in a dusty 
environment, one cleaning cycle may not fully clean the drive read/write heads. 
Up to four cleaning cycles may be necessary to fully clean the drive.

NOTE
For systems using the network backup option, cleaning is required only once a 
year.

Cleaning procedure
For specific tape drive cleaning procedures, refer to the OEM manual that shipped 
with the system.

CLEANING REQUEST LED
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Miscellaneous

Manual backup
1. For software v005E.12 or higher systems, before running IMS for the first time, 

run the c:\mei\evnttrig.bat batch file.

a. From the Windows desktop, select Start → Run….
b. Click Browse... button and browse to the c:\mei\evnttrig.bat file.
c. Click Open.
d. Click OK.

The batch file will prompt for password for three times. 
e. Enter Muse!Admin (the current user login password) at each password 

prompt.

2. Select Start → Programs → MUSE CV Information System → 
Integrated Maintenance Suite → Manual.

3. Make sure that the correct tape is in the tape drive.

4. Select the Normal Daily button.

5. Wait for the progress bar to disappear.

6. Review the IMS Status window. (Refer to the “IMS status window” on pages  4-
10 through 4-13 for more information.)

NOTE
Be sure you scroll through the entire Details list in the IMS Status window.

7. Eject the tape.

Re-schedule automatic backup
The default time for automatic daily backup is 3:00am. If this backup time is not the 
time you wish to run automatic backup, change the backup time as described in this 
section:
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1. From the desktop of the file server double-click My Computer, and then double-
click Scheduled Tasks.

2. Double-click Add Scheduled Task. This will launch the Scheduled Task Wizard.

3. Click Next.

4. Click Browse. 
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5. Browse to c:\mei. Click cvis0122.exe and click Open. 

A window appears prompting you to select when to perform the cvis0122 task.

6. Select Daily and click Next>.
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7. Change the Start time to the desired time and click Next>.

8. Enter the MUSEBkgnd account information and click Next>.

9. Click the Open advanced properties for this task when I click Finish box. 
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10. Click Finish.

11. Add the -autorun switch to the Run line and click OK. 



Revision Z MUSE™ Cardiology Information System 4-21
2002783-027

Integrated Maintenance Suite: Miscellaneous

Email notification of IMS events
The steps below describe how to set up the system for email notification of IMS 
events.

1. At the file server open Windows Explorer.

2. Browse to the following file:

vol000\system\templt\imsnote.bat

3. Copy the imsnote.bat file to:

vol000\sysinf

4. Right-click the vol000\sysinf\ims.bat file and select Open to launch Notepad.

5. Edit the file per the instructions contained in the file comments.

6. Save the ims.bat file.

Log files
The IMS application writes information to several log files. Daily log files for the 
previous seven days are stored on the D-drive in Vol000 → System → Errlog. A 
partial list includes:

IMS_?.LOG
CHKPTRS.LOG
DBANAL.LOG
BACK_?.LOG
ARC_#_#.LOG
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Disaster recovery – MUSE file server

Creating the automated system recovery media
This procedure takes advantage of the Automated System Recovery (ASR) feature 
that is part of Windows Server 2003. You will need a new blank AIT tape and a 
blank formatted diskette to create the ASR media set.

1. Log in to the file server as a local administrator.

2. To create an AIT tape/Diskette ASR set, click on Start → Run....

3. Type ntbackup and press Enter. If backup is already configured for advanced 
mode, the following screen will be displayed. If not, click on the advanced 
mode link.

4. Click on the Automated System Recovery Wizard button to launch the wizard. 
The following screen will be displayed.
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5. Click on Next>. The following screen will be displayed.

NOTE
If you are reusing an existing ASR tape, you will need to select it from the 
Backup media or file name drop-down list.

6. Verify that the information matches and then click Next>. The following screen 
will be displayed.

7. Make sure you have a new blank AIT tape in the tape drive (or an existing one 
that is being replaced) and that you have a blank formatted diskette ready. 
Click Finish.
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You will see windows like the ones below that show the progress of the backup.
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8. When the backup finishes, you will prompted for the diskette. Insert the blank 
formatted diskette and click OK.

Files will be copied to the diskette.

9. After the diskette is created, you will be prompted to remove the diskette and 
tape and to label them appropriately.
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10. Click OK. Click Close to close the Backup Progress window.

11. Click the X to close the Backup Utility window.
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12. If the MUSE file server is a G5 server, use the following steps to copy the 
drivers needed for the Sony SDX-550V tape drive from the MUSE Support CD 
to the ASR floppy disk. 

a. Insert the MUSE Support CD into the CD-ROM drive.

b. Navigate to x:\SDX-550V, where x: is the CD-ROM driver letter. 

c. Copy the entire contents of the SDX-550V folder to the root directory of 
the ASR floppy disk. 

NOTE
If you cannot locate the MUSE Support CD, you can download the 
necessary files from http://sony.storagesupport.com/ait/ait_asr.htm.

13. If the MUSE file server is a G5 server, verify the floppy drive contains the 
following files and directory structure:

14. Store the tape and diskette in a safe place.

NOTE
It is recommended that two separate ASR Tape/Diskette sets be created and 
stored in separate locations. One should be easily retrievable to minimize 
delay when it is needed. To create the second set, simply go through this 
procedure again.

NOTE
New ASR tape/diskettes should be created whenever the system partition 
changes, such as after a MUSE software update, or when new Windows 
Users, printers, or security patches are added. Creating new ASR sets is 
recommended during any preventive maintenance work.

15. Restart the MUSE file server when you are finished making ASR media.

Directory Files Comments

A:\ (root)

asr.sif
asrpnp.sif
setup.log

ASR Files

sonlyait.txt
txtsetup.oem

Tape Drivers

W2k3

32
s32ait.cat
s32ait.inf
s32ait.sys

Tape Drivers

64
sx64ait.cat
sx64ait.inf
sx64ait.sys

Tape Drivers
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Recovering from system failures
There are two possible routes to take when you need to recover from a system 
failure. 

Recovery Console (used to repair minor problems)
Automated System Recovery (used to completely restore the system partition)

Using recovery console to recover from system failure

If Safe Mode and other startup options do not work, consider using the Recovery 
Console. This method is recommended only if you are an advanced user who can 
use basic commands to identify and locate problem drivers and files. In addition, 
you will need the password for the built-in administrator account to use the 
Recovery Console.

Using the Recovery Console, you can enable and disable services, format drives, 
read and write data on a local drive (including drives formatted to use NTFS), and 
perform many other administrative tasks. The Recovery Console is particularly 
useful if you need to repair your system by copying a file from a floppy disk or 
CD-ROM to your hard drive, or if you need to reconfigure a service that is 
preventing your computer from starting properly. 

If you are unable to start your computer, you can run the Recovery Console from 
your Setup CD. 

To Start the Computer and Use the Recovery Console
1. Insert the Setup CD and restart the computer from the CD drive. 

2. Watch closely for the Windows Setup window to display the F6 prompt at the 
bottom of the screen. Press the F6 key immediately after the prompt appears.

3. Insert the ASR floppy disk when prompted and press any key to continue.

4. Press the F2 key when you are prompted to run the Automated System 
Recovery (ASR).

5. When the screen asks for floppy to install the tape driver, press the S key.

6. Select the correct operating system tape driver. 
(Sony AIT SAIT 32 bit tape driver for Windows Server 2003).

7. When the text-based part of Setup begins, follow the prompts; choose the repair 
or recover option by pressing R. 

8. When prompted, type the password for the local administrator account. 

9. At the system prompt, type the relevant Recovery Console commands; type 
help for a list of commands or help commandname for help about a specific 
command. 

10. To exit the Recovery Console and restart the computer, type exit.
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Using automated system recovery to recover from system failure

There are several reasons why you might need to perform a disaster recovery. This 
procedure describes a situation where you have replaced multiple failed hard drives 
and would need to start by configuring the server just like it was new.

Another disaster recovery situation may be different, so you should use this 
information as a guide to helping you recover a system. For example, you may not 
need to reconfigure the RAID 5 drive array.

NOTE
To use the Automated System Recovery (ASR) backup media for recovery, you 
must have the floppy disk that you created with that set of media. You cannot 
use a floppy disk created at a different time or with a different set of media.

Make sure you have the following available before you begin the recovery 
procedure:

Your previously created ASR floppy disk.
Your previously created ASR backup media.
The Windows Server 2003 installation CD.
The ML370 G5 Pre-Install CD (for G5 servers only)
The most recent MUSE backup tape, to recover D:\vol000 and the highest 
\volxxx folder.
Any MUSE Archive backup tapes, to recover any D:\volxxx archive folders.

Configuring the file server RAID array (G3 and G4 servers)
1. Power-up the system.

2. Watch closely during system boot and when Press <F8> to run the Option 
ROM Configuration for Arrays Utility is displayed press F8.

3. Highlight Delete Logical Drive and press Enter.

4. If the There are no available logical drives screen appears, press Esc and go to 
step 7 below (Highlight Create Logical Drive...) 

5. If logical drives exist, press F8 to delete them, and press F3 in the warning 
window.

6. Press Enter at the configuration saved screen.

7. Highlight Create Logical Drive and press Enter.

8. In the Available Physical Drives box, cursor down to the last drive and press the 
Spacebar to remove the drive from the array.

9. Verify RAID 5 is selected.

10. Press the Tab key twice to select Use one drive as spare pressing the Spacebar. 
Verify that the letter S appears in the checkbox.

11. Press Enter to create the drive.

12. Press F8 to save the configuration.

13. Press Enter on Configuration Saved screen.

14. On Main Menu screen press Esc to exit and resume the boot process.
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NOTE
Steps 15 through 26 below would not normally need to be done if the 
system was already 5E, but they might be necessary, depending on what 
hardware was replaced on the file server.

15. Press F9 when the message Press “F9” key for ROM-Based Setup utility is 
displayed.

16. Select System Options. Press Enter.

17. Select OS selection. Press Enter.

18. Select or verify Microsoft Windows 2000/Windows Server 2003 as the OS to be 
installed. This may show as Microsoft Windows 2000/Windows.NET. Press 
Enter. Press Esc.

19. Select Boot controller Order. Press Enter.

20. Select or verify Compaq Smart Array 532 (or 641) controller, press Enter.

21. Select Controller Order 1. Press Enter. Press Esc.

22. Select Date and time. Press Enter; enter the current date and time and press 
Enter.

23. Select Advanced Options. Press Enter.

24. Select Post F1 Prompt. Press Enter. Select Disabled. Press Enter.

25. Press Esc twice.

26. Press F10 to Confirm Current boot controller is Compaq Smart Array 532 
(or 641) Controller.

The system will reboot.

27. Go to “Recovering the system partition (G3 and G4 servers)” on page 4-31.

Configuring the file server RAID array (G5 servers)

1. Power up the system.

2. Watch closely during system boot and when Press <F8> to run the Option 
ROM Configuration for Arrays Utility is displayed press F8.

3. Highlight Delete Logical Drive and press Enter.

4. Do one of the following: 

If the There are no available logical drives screen opens, press Esc and 
skip to step 5.
If logical drives exist, do the following:
a. Select the drive with the highest number.

For example, if the logical drives are Drive 0 and Drive 1, delete 
Drive 1 before deleting Drive 0. 

b. Press F8 to delete the selected drive.

c. On the warning window, press F3.

d. On the configuration saved screen, press Enter.

e. Repeat step a through step d for each logical drive. 

5. Insert the 370G5 MUSE Pre-Install CD into the CD-ROM drive. 
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6. On the Option ROM Configuration for Arrays Utility main menu, press the Esc 
key to reboot the server. 

The system will reboot from the CD. 

7. When prompted, press R for Rack or T for Tower, whichever is appropriate for 
the platform, and press Enter. 

The drive array will be configured. When it is done, the system will 
automatically reboot. 

8. Remove the CD. 

9. Proceed to “Recovering the system partition (G5 servers)” on page 4-32.

Recovering the system partition (G3 and G4 servers)
1. Insert the Windows Server 2003 Standard Edition installation CD into your CD 

drive, and the ASR AIT Tape into the tape drive.

2. Restart your computer. The computer should boot from the CD. If it does not, 
you may need to check the boot order in the BIOS setup.

3. Press F2 when prompted at the beginning of the text-only mode section of 
Setup. You will be prompted to insert the ASR floppy disk you had previously 
created.

4. You will be prompted to delete and recreate the disk partitions. Press C to 
continue.

5. The drive will be formatted, and then setup files will be copied to the Windows 
installation folders.

6. The system will reboot. Remove the floppy diskette as requested.

7. After reboot, a normal Windows installation will begin. Windows will install 
drivers and the network, and then go into the Automated System Recovery.

8. Follow the prompts to allow the system to restore from the ASR tape. The 
system will reboot.

9. At this point you will have your original C: drive (from the time the ASR tape 
was created), and you will have an empty D: drive.

NOTE
Automated System Recovery will not restore your data files. The MUSE 
database will need to be restored separately from the most recent backup 
and archive backup tapes.
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Recovering the system partition (G5 servers)
1. Insert the Windows Server 2003 Recovery CD into your CD drive, and the ASR 

AIT Tape into the tape drive. 

2. Restart your computer. 

The computer should boot from the CD. If it does not, check the boot order in 
the BIOS setup. 

3. Press the F6 key when the F6 prompt appears at the bottom of the Windows 
Setup window.

4. When you are prompted to run the Automated System Recovery (ASR), press 
the F2 key. 

5. When prompted, insert the ASR floppy disk and press Enter. 

6. When the system prompts you for the floppy drive with the tape driver, press 
the S key. 

NOTE
If the SDX-550V tape driver was not added to the ASR floppy when it 
was originally created, you will need to copy it onto a floppy disk from the 
hardware Support CD that shipped with the system before pressing the 
S key.

7. When you are prompted to select the driver to install, select Sony AIT - SAIT 32 
Bit Tape Driver for Windows Server 2003 and press Enter. 

8. When Windows Setup prompts you for additional device drivers, press Enter to 
continue. 

9. When prompted to delete and recreate the disk partitions, press C to continue.

The drive will be formatted and setup files will be copied to the Windows 
installation folders. When it is done, the system will reboot and the normal 
Windows installation will continue. When Windows is installed, the Automated 
System Recovery process will start. 

10. Follow the prompts to allow the system to restore from the ASR tape. 

When the process is complete, the system will reboot. At this point, the original 
C: drive will be restored from the ASR tape. This process does not restore the 
MUSE database. You must restore the databases separately. Proceed to 
“Recovering the MUSE Databases” on page 4-xx.
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Formatting the D partition (G3, G4, and G5 servers)
Verify that the D-drive is empty. If it is not, perform the steps to re-format the D: 
drive.

1. Right-click on My Computer and select Manage. 

2. On the Computer Management window, select Storage > Disk Management.

3. Right-click on drive D: and select Format....

4. On the Format window, verify the File System is set to NTFS and the Perform a 
Quick Format check box is set. 

5. Click OK. 

6. When the warning message appears, click OK.

The system will begin formatting the D: partition. When it is done, you will 
have a clean D: drive and its status will be changed to Healthy. Continue to next 
section.
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Recovering the MUSE database
1. Insert the latest MUSE backup tape into the tape drive.

2. Click Start → Run... and type in ntbackup and press Enter.

3. Click on the Restore Wizard (Advanced) button.

4. Click Next> on the Welcome to the Restore Wizard screen.

5. Expand 8mm AIT1 under Items to restore.

6. If necessary, double-click on the backup tape to load a set list from the media.

7. If necessary, double-click the D: drive to load the list for that set.

8. Verify that you have vol000 and volxxx (where xxx = the other volume that 
would be part of the current nightly backups) selected for restore.

9. Click Next.

10. Click Finish to restore the D:\vol000 and D:\volxxx folders to their original 
locations.

11. Click Close when the restore is complete.

12. Follow a similar procedure to restore any archive volumes from the archive 
backup tapes.

13. When you are done with recovering the MUSE database, you should have 
D:\vol000 through D:\volxxx (where xxx = the other volume that was restored 
from the nightly backup tape). If any volumes are missing, you have not 
restored all of the archive volumes. Contact MUSE Tech Support if you are 
unable to find all of the required backups to recover this data.

14. When you are finished with restoring data, close the Backup Utility window.

Sharing the volumes
After restoring the volumes on the D: drive, you will need to share them for the 
MUSE Users group.

1. For each volume, right-click on the folder in Windows Explorer and go into 
Sharing and Security.

2. Select Share this folder, and click on the Permissions button.

3. Remove the Everyone group, and add the local MUSE Users group. Give the 
MUSE Users group Change permissions.



Revision Z MUSE™ Cardiology Information System 4-35
2002783-027

Integrated Maintenance Suite: Disaster recovery – MUSE file server

Recreating and restoring the format settings database
The Format Settings database is stored under D:\mssql\data. Since that folder is not 
part of a normal MUSE backup, a SQL backup is run nightly at 10:00pm that stores 
the database backup in D:\vol000\mssql. The file that contains the SQL backup is 
sqlbackup.dmp. You can use the following procedure to recreate and restore the 
Format Settings database.

If not already present, copy the buildsql5e.exe and restsql.exe files to the 
C:\service folder. These files can be found on the MUSE 5E Service Diskette. 
Contact Technical Support is you do not have this diskette.

Execute the two files to create the C:\service\buildsql and C:\service\restsql 
folders.

NOTE
If the system is running MUSE English software, continue with the next steps. 
Otherwise, do the following:

French – In the c:\service\buildsql folder, copy *.sfr to *.sql
German – In the c:\service\buildsql folder, copy *.sgr to *.sql
Italian – In the c:\service\buildsql folder, copy *.sit to *.sql
Swedish – In the c:\service\buildsql folder, copy *.ssw to *.sql

4. Double-click on C:\service\buildsql\buildsql.bat. This will create the 
D:\mssql7\data folder with the default Format Settings database.

5. Double-click on C:\service\restsql\restsql.bat. This will restore the backed up 
Format Settings database from the D:\vol000\mssql\sqlbackup.dmp file.

Reconfiguring services
The services will be reset to a default configuration as part of this procedure. In 
order to restore the proper settings for MUSE, perform the following step.

1. Click on Start → Run.... 

2. Type or browse to C:\Install\regtweak.reg. 

3. Click OK.
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System Shutdown & Restart Procedures

Shut Down the MUSE System
Shut down all workstations attached to the file server by initiating a MUSE 
shutdown on the file server. To initiate a system shutdown:

1. Log in to the file server as MUSE Administrator.

2. Select Start → Programs → MUSE CV Information System → Integrated 
Maintenance Suite → Advanced to launch the MUSE CV- IMS Advanced 
window.

3. Select System → Shutdown/Restart to display all the Shutdown/ Restart options.

The options in the Shutdown/Restart menu initiate the MUSE CV information 
system shutdown process whereby all MUSE services running on the file server 
and all MUSE clients attached to the server are shut down. The shutdown is a 
four-minute process, allowing users of client workstations sufficient 
notification in order to exit their current application and log out.

The differences between the three options are as follows: 

The Shutdown option will result in a system shutdown. Select this option 
when shutting down the system for maintenance or software upgrades.
The Rebuild Queues option, in addition to shutting down the system, 
selecting this command copies over new template versions of the queues as 
selected by the user from an additional dialog display. When the system is 
restarted, those queues are then rebuilt from scratch (not just validated) by 
the MUSE Service Control Manager task (CV_SCM).
The Restart option is available for a single-step shutdown/restart process 
for cases such as the need to activate MUSE CV information system device 
configuration changes. The Restart option results in the automatic restart of 
the MUSE CV information system.

4. Select the appropriate Shutdown/Restart option.

5. After selecting the shutdown option, select OK from the warning dialog to 
begin operation.

For all options the Shutdown Pending... text appears in the IMS dialog context 
and a small blue flashing indicator appears in the lower right corner of the 
screen. When the operation has completed, Shutdown OK. Code (0) is displayed 
in the IMS dialog context. (Note that the IMS dialog box will remain displayed 
until it is manually closed out.)

6. Select System → Exit to close the MUSE CV-IMS Advanced window.

7. If you selected Rebuild Queues or Restart in step 4, go to “Start-Up 
Verification” on page 4-37.

8. If you selected Shutdown in step 4, go to “Start-Up Verification” on page 4-37.
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Shutdown the File Server
1. After shutting down the MUSE CV system as described in the previous section, 

shut down the file server by selecting Start → Shutdown... from the Windows 
desktop.

2. Select Shut down the computer? and click the Yes button.

3. After Windows has completed its shutdown process, a message box will appear 
stating that It is now safe to turn off your computer, followed by a Restart 
button. At this time, you may turn off the monitor and power down the file 
server.

4. At this time, you may also power down the workstation nodes and attached 
monitors if so desired.

Power Up Procedure
1. Power up the file server and attached monitor. 

2. Restart clients. Wait until the NT Begin Logon window appears and then power 
on the clients.

NOTE
Clients that were not powered off will restart automatically.

Start-Up Verification
1. Log into the MUSE CV information system.

2. Verify that all nodes had shutdown and initialized. Look for the following line 
in the Event Log:

<<<<Station Shutdown>>>> <<<<Station initialization>>>>

NOTE
If a node has not initialized, press its Reset button to manually reboot.
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Troubleshooting (IMS)
The frequently asked questions and solutions provided in this section apply to 
MUSE software v5E.12 with Windows Server 2003 operating system.

Storage media not detected

Problem

Removable storage media is not getting detected (the window shown below is 
displayed). 

Solution

The situation occurs randomly. The cause is still unknown. The solution for this is to 
restart the Removable Storage Service. After re-starting the service, the cross will 
get removed. After this if you try to look for the pool list in the RSM, you will find 
only three pools: Free, Import, and Unrecognized. The Backup pool is not listed. 
The inserted media will be listed under the Import pool. Next time IMS runs, the 
tape will be re-prepared by the IMS and the Backup pool will be created 
automatically.
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Error 20531 – ntbackup fails

Problem

NT Backup fails and error 20531 is logged by the IMSclient debug messages. 

Solution

This is a tape drive related issue. The tape driver used by MUSE is version 1.0.0.4 
which gives this error if it is not able to read some memory location on the tape. 
When this error occurs an event is logged in the windows system log with an ID 
of 7. The only solution is to manually restart the backup. 

In the MUSE 5E.12 application, the IMS looks for such an event, detects it and 
stops the backup. The following message will also be logged in: 
d:\vol000\system\errlog\ims_.log and
d:\vol000\system\errlog.backarc_.log files
A message fatal error has occurred... Now killing imsserver and imsclient.

NOTE
Upgrading the driver to the latest release v2.0.0.7 will remove this error but 
may introduce other problems that will stop NTbackup from working properly 
and is not recommended.
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Tape in use

Problem

When a prepared tape is inserted and IMS is started, IMS is not able to read from the 
tape and displays the following message:

Tape in use. Sleeping and retrying

Solution

IMS makes use of Removable Storage Manager to read from the tape. The RSM 
maintains a cache of the information about the inserted media. The cache needs to be 
updated when new media is inserted. This is done automatically once the new tape is 
inserted but this process takes some time (5-10 seconds). If you start the IMS backup 
while the RSM is still updating its database about the media, you will get message 
Tape in use, Sleeping and retrying. If this happens, wait for 10-15 seconds after 
replacing the media and then start the IMS backup.

Tape drive not recognized by removable storage media

Problem

Removable storage media is not recognizing the tape drive. I am getting a cross 
against the tape drive name.

Solution

Restarting the Removable Storage Service will solve this problem. IMS code 
proactively takes care of this situation and restarts the Removable Storage Service. 
But sometimes this problem occurs once the backup has already started. In that case 
IMS cannot automatically restart the Removable Storage Service. Whenever such a 
problem occurs an event id 168 is logged in the system event log file. IMS detects 
this and just stops the backup and logs the error message: fatal error has 
occured...Now killing imsserver and imsclient!!.
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Backup stops suddenly

Problem

The IMS backup stops suddenly. The ims_.log file contains the following entry:
fatal error has occurred... Now killing imsserver and imsclient!! 

Solution

A new IMS feature (introduced with v5E.12) deals with the exceptional situation 
which may occur due to one of the following:

1. System event 168 occurred. This event occurs when the removable storage 
media stops recognizing the tape drive.

2. System event 85 occurred. This event occurs when the removable storage media 
stops working probably because its database gets corrupted.

3. System event 7 occurred. This event occurs when the tape driver is not able to 
read properly from the tape. Previously when windows logged any of these 
events, the backup used to hang since the application was not able to read the 
tape. In the latest version of IMS any such occurrence of events is considered 
fatal and the backup is simply stopped.

NOTE
Also refer to “Error 20531 – ntbackup fails” on page 4-39 and “Tape drive 
not recognized by removable storage media” on page 4-40.
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Sequence of backup tape usage

Problem

I was told to always use a GE-supplied tape and in a particular order (on Monday 
use the tape labeled Monday, on Tuesday use the tape labeled Tuesday tape, etc.). 
But even if I use the tapes in random order the backup is done successfully.

Solution

In earlier versions of MUSE software, the IMS had some problems with the order of 
the tapes. With v5E.12 this problem has been addressed. The only issue is that in the 
IMSstatus in the This week column it will display the status as Label Tuesday (day 
as per the label of the tape) instead of OK. 

Even if you insert a brand new tape (that has not been provided by GE) the backup 
will be done successfully. This is because the latest IMS will automatically format 
the new tape according to the IMS format.
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Introduction
The procedures in this section are intended to be performed in order to restore the 
OS image installation performed by HP and before the installation of the application 
software. 

This disaster recovery procedure applies to MUSE HIS systems running on a 
GE-supplied HP DL360 Server (G4 or G5) and running Windows 2003 operating 
system. To identify the server, check the label imprint on the left or right tab on the 
front of the server where it fastens to the rack. It should indicate G4 or G5. To verify 
the operating system right-click on My Computer and select Properties. On the 
General tab verify the Windows version running.

NOTES
The system will reboot several times during this procedure. 
Some information in this procedure is case-sensitive. Observe case, as noted.

Before starting you should have the following:

Configure the HP server
1. Boot the system using the SmartStart CD version 7.60. 

(This will take approximately three minutes.)

2. Press F1 to continue, if applicable.

3. At the Language selection screen, select the English radio button.

4. In the Select the keyboard to be used with the system drop-down list 
select English.

5. Click Continue.

6. Click the Agree button.

7. Select the Maintain Server button.

8. Select Erase System button.

9. Confirm all boxes are checked and click the Continue button.

10. Click OK when the Are you sure...? window is displayed.

Hardware Platform
Software Required

GE Part Number Description

DL360 G5
2002801-012 HP SmartStart CD version 7.6

2030821-001 MUSE HIS HP#325367-004 CD 
(GE-supplied Windows 2003 OS)

DL360 G4
2002801-012 *

*  For G4 server, HP SmartStart v7.4 (PN 2002801-011) will also work.

HP SmartStart CD version 7.6

2030821-001 MUSE HIS HP#325367-004 CD 
(GE-supplied Windows 2003 OS)



Revision Z MUSE™ Cardiology Information System 5-3
2002783-027

HIS Disaster Recovery: Configure the disk system RAID

11. System will power down and then reboot. 
(This will take approximately three minutes.)

12. During boot up, press the F9 key for ROM-based Setup Utility when prompted.

13. Select Boot Controller Order and move PCI slot 1 HP Smart Array Controller 
to CTLR:1 position. Depending on the server being restored, the controllers 
will be identified as follows:

14. Press Enter. 

NOTE
If necessary, press the Esc key to return to the selection menu.

15. Select Date and Time and press Enter. Enter current date and time info. 
Press Enter.

16. Select Server Availability and press Enter.

17. Select POST F1 Prompt and press Enter. 

18. Select Disabled and press Enter.

19. Press Esc to exit the window. 

20. Press Esc to exit the utility.

21. Press F10 to Confirm Exit Utility.

Configure the disk system RAID 
1. Reboot the system with HP SmartStart CD version 7.60 in the CD-ROM drive.

2. At the Language selection screen select the English radio button.

3. In the Select the keyboard to be used with system drop-down list select English.

4. Click Continue.

5. Click the Agree button and click OK.

6. Select the Maintain Server button to begin configuration of the array 
controllers.

7. Click Configure Array button.

8. Select Clear Configurations under Common Tasks.

9. The message ... Any data on these logical drives will be lost! appears. 
Select OK. 

10. Select Create Array under Common Tasks.

11. Check the Select All checkbox and select OK.

12. Select Create Logical Drive.

13. In the Create Logical Drive window, select OK (to use the default settings). 

14. Confirm the SCSI controller has one logical drive configured to RAID 1+0 
in the Configuration View panel.

G5 E200i

G4 6i
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15. Click Exit ACU.

16. Click Smartstart Home.

17. Click Deploy Server.

18. Click Continue.

19. Click on Microsoft Windows 2003 folder.

20. Select Microsoft WIndows Server 2003, Standard Edition (HP-branded).

21. Select Continue.

22. In the Operating system media source select the following radio buttons: 
CD-ROM and Flat Files.

23. Select Continue.

NOTE
It will take several minutes while Smart Start prepares the system for 
installation of the operating system.

24. In the file system drop-down box, select NTFS.

25. Click the Minimum Recommended partition size.

Select 10420 MB if this is a G5 server.
Select 10842 MB if this is a G4 server.

26. Click Continue.

27. In User Name field type Hospital Name.

28. In Organization field type Hospital Name.

29. In License Type field, select Per Seat.

30. Click Continue.

31. Accept default entries in SNMP Configuration screen and click Continue.

32. Pressing Continue will erase all drives, resulting in the loss of all data 
is displayed. Click Continue.

NOTE
It will take several minutes while SmartStart prepares the system for 
installation of the operating system.

33. When the SmartStart CD is ejected from the drive and you are prompted to 
insert the operating system media, proceed with “Install the operating systems 
(Windows Server 2003)” on page 5-5. 
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Install the operating systems (Windows Server 2003)
1. At the Please insert the Operating System media and click Continue window, 

remove the Smart Start CD and insert the Windows 2003 Server CD 
(GE PN 2030821-001; HP PN 325367-004).

2. Click Continue. The system will reboot after 3-5 minutes.

3. When the CD drawer opens, remove the Windows 2003 Server CD.

4. System will reboot several times over 3-5 minutes.

5. If the Welcome to Windows Setup Wizard screen, click Next.

The Installing Devices window is displayed for several minutes.

6. At the Regional and Language Options window, click Next.

7. At the Computer Name and Administrator Password window, use the following 
information where applicable (follow screen instructions). Case sensitive inputs 
are required:

NOTE
If you do not know the GE-recommended Administrator password, 
contact the Jupiter, Florida On-Line Center (MUSE Tech Support) at 
1-800-558-7044. If the customer is using a password other than the one 
recommended by GE, be sure that MUSE Tech Support personnel 
are aware of this password.

8. Click Next.

9. Set Date & Time and Time Zone to appropriate values. Select Next.

10. System displays Installing Network for 30 seconds.

11. Select No, this computer... radio button (or Yes, make this computer... per 
customer’s network environment).

12. In the text box, type HIS_WG (or enter domain or workgroup name per 
customer order).

13. Click Next.

14. System installs drivers and programs for approximately 20 minutes and then 
reboots.

15. At the Welcome to Windows window, press Ctrl + Alt + Delete and enter 
password.

16. System installs HP drivers and programs for several minutes and then reboots.

17. At the Welcome to Windows window, press Ctrl + Alt + Delete and enter 
password.

Computer Name: Revise per customer or accept default

Administrator Account Password: Enter GE-recommended Administrator 
password (or, enter customer-provided 
Administrator password)

Confirm Password: Enter same password entered in previous 
field
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18. At the Windows Server Post-Setup Security Updates window, select Finish. 

19. At When you close this page... window, select Yes. 

20. At the Manage Your Server window, check the Don’t display this page at logon 
check box. 

21. Exit the Manage your server window.

Configure the display settings
1. Click Start → Control Panel → Display.

2. Click on the settings tab and configure the Settings in Display Properties as 
follows:

a. Set Screen Resolution to 1024 by 768 pixels.

b. Set Color Palette to Highest 32 bit.

c. Click on Advanced and select Monitor tab. 
Set Screen refresh rate to 75 Hertz.

d. Click OK to exit the Advanced window.

e. Click Apply. 

f. At the testing mode dialog box, click Yes.

g. Click OK. To exit the Display Properties window.

Configure SNMP
1. Select Start → All Programs → Administrative Tools → Services.

2. In the right pane, open SNMP Service. 

3. Select the General tab.

4. At Startup type, click Disabled.

5. At Service status, click Stop, if it is not grayed out.

6. In the Stop Other Services window, click Yes.

7. After the stopping services window closes, click OK to close the SNMP Service 
Properties window.

8. Close the Services window.

NOTE
SNMP is disabled here in order to reduce security risks in the system.
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Change the CD drive letter to Z:
1. Select Start → All Programs → Administrative Tools → Computer 

Management.

2. Select Disk Management.

3. Right-click on the CDROM 0 device, then select Change Drive Letter....

4. Select Change. Open the drive letter drop-down box and select Z. Select OK.

5. At the confirm window, select Yes.

Create the D-drive 
1. Right-click in the Disk 0 Unallocated space and select New Partition.

2. At the Welcome to the New Partition Wizard window, click Next.

3. At the Select Partition Type window, select the Primary partition radio button 
and click Next. 

4. At the Specify Partition Size window, set the partition size to the maximum 
and press Next.

5. At the Assign Drive Letter or Path window, select drive letter D and click Next.

6. At the Format partition window, in the Volume label field enter Data. Check the 
Perform a Quick format check box. Click Next.

7. At the Completing the New Partition Wizard window, click Finish.

8. Wait for the formatting to complete, then close the Computer Management 
window.

Install security updates 
1. Insert the MUSE 5E Support CD #2.

2. With Windows Explorer, browse to the CD ROM drive and open \Win2K3SR.

3. Double-click on ServerUpdates.cmd.

4. After the updates install and the DOS window closes (2-3 minutes), close 
Windows Explorer.
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Set up the Windows environment
1. From the Control Panel, click the System icon.

2. Click the Advanced tab.

3. Click the Startup and Recovery Settings button.

4. In the Time to display list of operating systems text box, enter 5 seconds.

5. In the Write debugging information drop-down box, select (none).

6. Click OK to exit the Startup and Recovery window.

7. Click OK to exit the Systems Properties window.

Install HIS software
See “HIS Software-Only Installation Instructions” (pn 2020285-092) for HIS 
software installation procedures.
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Assembly descriptions

Introduction
If you encounter a problem that is not addressed in the OEM manuals or if you 
would like further assistance, please call Technical Support at 1-800-558-7070.

File server
Assembly and disassembly instructions can be found in the HP manuals that 
accompanied your system.

Desktop client
Assembly and disassembly instructions as well as basic troubleshooting procedures 
can be found in the HP manuals that accompanied your system.

Monitors
Basic troubleshooting procedures for the monitors can be found in the Operating 
Instruction manual that accompanied your monitor. The monitor is a field 
replaceable unit and should not be disassembled in the field.

UPS
Basic troubleshooting procedures for the UPS can be found in the PowerVAR or 
HP manual that accompanied your UPS. The UPS is a field replaceable unit and 
should not be disassembled in the field.

HP LaserJet 4015N Printer
Basic troubleshooting procedures for the printer can be found in the Operating 
Instruction manual that accompanied it. The printer is a field replaceable unit and 
should not be disassembled in the field.
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Assembly block diagram
The system level overview on the following page describes the function of each of 
the major assemblies in a typical MUSE system configuration. Please keep in mind 
that the diagram is only a representative sample, there are too many possible 
configurations to show them all.
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Theory of operation
The theory of operation gives you a very broad overview of the various functional 
units. Refer to the OEM manuals for additional information and troubleshooting 
procedures.

The MUSE system consists of computers connected together via a local area 
network (LAN). There are several different computers and each is used in a different 
way. File servers store large numbers of ECGs and “serve” requests from other 
computers on the network for files. Communication servers acquire ECGs from 
diskette, via modem, or through a local direct connection to a resting ECG analysis 
system. They then process the ECG and send it to the file server.

Workstation clients allow reports to be edited and printed. Physician stations allow a 
physician to change reports right in the computer, or dictate the changes for a 
technician to incorporate at a later time. Telephone retrieval stations allow a 
physician to call in to the system from a telephone and hear the diagnosis for a 
particular patient. 

Most often an ethernet local area network (LAN) system interconnects the MUSE 
system file servers, synchronous modem modules, and workstation clients together. 
Regardless of network technology, each computer on the network is called a “node” 
and has a “node ID” or “station ID” number that identifies it.

File server

The HP file server contains the motherboard, processor (CPU), hard drives, RAM, 
internal DVD-ROM drive, 3.5" diskette drive, AIT tape drive and a redundant 
power supply.The hard drive stores the Windows operating system, MUSE system 
software, and patient data. The diskette drive is used for updating software and 
running system diagnostics, and the AIT drive is used for system backups and data 
archive. The CD-ROM drive is used for software upgrades.

The hard drive stores the MS-DOS operating system, MUSE system software, and 
patient data. The diskette drive is used for updating software and running system 
diagnostics, and the AIT drive is used for system backups. The CD-ROM drive is 
used for software upgrades.

The default configuration shipped in all ML370 G4 or G5 servers from the 
manufacturer includes a 10/100 MB card in each slot.

Network Fault Tolerance (NFT)
Network Fault Tolerance allows two NIC cards to be configured to have one 
ethernet and one IP address with one card on and one card in backup mode. The 
backup NIC card will become active using the same ethernet and IP address, should 
the primary active card, its cable, or the switch it is attached to fail.

The default configuration shipped in all ML370 G4 servers from the manufacturer 
includes a 10/100 MB card in each slot.
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Workstation client

The workstation client contains a motherboard, a 2.13 GHz Pentium 4 processor 
(CPU), one 160 GB hard drive, 1 GB of RAM, an internal 48x CD-ROM drive, and 
a power supply.

The hard drive stores the Windows operating system, MUSE system software, and 
patient data. The CD-ROM drive is used for software upgrades.

Network interface

Twisted pair ethernet network is supported. 

Displays

Display options include an HP L1910 19-inch LCD monitor. Additional information 
on the display can be found in the OEM manual.

Printers

Printer options include an HP LaserJet 4015N printer. Additional information on the 
HP printer can be found in the OEM manual.

Uninterruptible power supply

The UPS provides battery backup for a limited time after power has gone out. It also 
provides power conditioning. The MUSE system should be systematically shut 
down in the event of a power outage. Do not rely on long-term use of the UPS’s 
battery backup.
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General fault isolation

First things to ask
If the unit is not working properly, save yourself some time troubleshooting by 
asking yourself these basic questions.

Is the unit turned on?
Have there been any changes in the use, location, or environment of the 
equipment that could cause the failure?
Has the unit been modified in any way, either in software or hardware?
Is operator error the cause of the problem? Try to repeat the user’s scenario 
exactly and compare that to the proper operation of the equipment. Check the 
operator’s manual as necessary.

Visual inspection
A thorough visual inspection of the equipment can save time. Small things—
disconnected cables, foreign debris on circuit boards, missing hardware, loose 
components—can frequently cause symptoms and equipment failures that may 
appear to be unrelated and difficult to track.

Read the Disassembly Guidelines in the products OEM manual before you perform 
an internal visual inspection of the components.

Take the time to make all the recommended visual checks (refer to the following 
visual inspection chart) before starting any detailed troubleshooting procedures.

Table 1. Visual Inspection List

Area Look for the following problems

I/O Connectors and Cables Fraying or other damage
Bent prongs or pins
Cracked housing
Loose screws in plugs

Fuses Type and rating, replace as necessary

Interface Cables Excessive tension or wear
Loose connection
Strain reliefs out of place

Circuit Boards Moisture, dust, or debris (top and bottom)
Loose or missing components
Burn damage or smell of over-heated components
Socketed components not firmly seated
PCB not seated properly in edge connectors
Solder problems: cracks, splashes on board, incomplete feedthrough, prior modifications or repairs

Ground Wires/Wiring Loose wires or ground strap connections
Faulty wiring
Wires pinched or in vulnerable position
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Mounting Hardware Loose or missing screws or other hardware, especially fasteners used as connections to ground 
panes on PCBs

Power Source Faulty wiring, especially AC outlet
Circuit not dedicated to system
(Power source problems can cause static discharge, resetting problems, and noise.)

Table 1. Visual Inspection List (Continued)

Area Look for the following problems
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For your notes
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Introduction

Recommended maintenance
A regular equipment maintenance program helps prevent unnecessary equipment 
and power failures and also reduces possible health hazards. This chapter contains 
instructions for the following recommended maintenance:

Inspecting and cleaning the unit
System Checkout 

Inspection report
To help you establish a systematic maintenance routine, GE Medical Systems 
Information Technologies recommends that every six months you perform the 
maintenance checks and test procedures on the “Preventive Maintenance Inspection 
Report,” included at the end of this chapter.

NOTE
Unless you have an Equipment Maintenance Contract, GE does not in any 
manner assume the responsibility for performing the recommended 
maintenance procedures. The sole responsibility rests with the individual or 
institution using the equipment. GE service personnel may, at their discretion, 
follow the procedures provided in this manual as a guide during visits to the 
equipment site.
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Required tools and supplies
The following equipment is required to maintain or repair the MUSE system. 

Standard set of hand tools
Multimeter
Leakage Current Tester 

120 V (or equivalent)
240 V (or equivalent)

Tape Head Demagnetizer
Cleaning kits for the following components:

DAT drive
Tape drive 
Optical drive
Floppy drive

Vacuum 
Isopropyl alcohol
Can of compressed air
Tie wraps for securing cables
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Pre-service procedures

System shutdown
Before opening the unit for maintenance or service, be sure to shut the system down 
and remove power. Instructions for shutting the system down can be found in 
“Powering On and System Shutdown” in Chapter 2.

In addition, the OEM manuals provide information regarding the proper shutdown 
of individual systems and devices.
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Inspection and cleaning

Visual inspection
Perform a visual inspection daily. Turn off the unit and remove power before 
making an inspection or cleaning the unit.

Check the case and display screen for cracks or other damage.
Regularly inspect all cords and cables for fraying or other damage.
Inspect all plugs, cables, and connectors for bent prongs or pins.
Verify that all cords, socketed components, and connectors are securely seated.
Inspect keys and controls for proper operation.

Toggle keys should not stick in one position.
Knobs should rotate fully in both directions.

Precautions 
Turn off the unit and remove all power before inspecting or cleaning. 

Do not immerse any part of the equipment in water.

Do not use organic solvents, ammonia based solutions, or abrasive cleaning agents 
which may damage equipment surfaces.

Do not use a cleaning solution or solvent on the cassette tapes. Doing so can cause 
loss of data or damage to the tape drive.

Do not use metal articles, such as a screwdriver, to clean the tape heads, or bring any 
magnetic material near the head assembly.

Exterior cleaning
Clean the exterior surfaces once per month, and more frequently if needed, with a 
clean, soft cloth and a mild dishwashing detergent diluted in water. 

Wring the excess water from the cloth. Do not drip water or any liquid on the 
writer assembly, and avoid contact with open vents, plugs, or connectors.
Dry the surfaces with a clean cloth or paper towel.
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Cleaning the monitor screen

Clean the LCD monitor surface with a lint-free, non-abrasive cloth. Avoid using any 
cleaning solution or glass cleaner.

Interior cleaning
Complete any pre-service procedures prior to opening the unit or performing any 
interior cleaning. Clean the unit as needed, but at least once per month. 

The equipment is sealed before it leaves the factory. There should be no dust buildup 
on the surfaces of the interior PCB assemblies and components when you receive it. 
However, if dust is an environmental problem, use a commercially available dust 
remover (compressed air). Follow the manufacturer’s directions for use.

WARNING
Only qualified personnel should perform the following procedure.

WARNING
Turn off power and disconnect power cord from AC power source 
before removing the cover.

Cleaning the system box interior

Follow these steps to clean the system box interior.

1. Power off the workstation. See “Powering Off the Workstation” in Chapter 2, 
“Equipment Overview,” for steps to power off the workstation.

2. Detach the AC power cord before cleaning the interior of the system box.

3. Remove the system box top cover. See the OEM manual for your specific 
system for detailed information.

4. Clean the interior. See the “Preventive Maintenance Inspection Report” for 
more detail.

5. Replace the system box cover. Refer to the OEM manual for your specific 
system for detailed information.

Cleaning the tape drive

See the OEM manual for the steps required to clean the tape drive heads on the file 
server.
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Cleaning the CD-ROM drive

Follow these steps to clean the CD-ROM drive.

1. Open the CD-ROM drive.

2. Insert the cleaning CD-ROM, brushes down, into the drive.

3. Close the CD-ROM drive. The activity led blinks for about 10 seconds.

4. Open the CD-ROM drive.

5. Remove the cleaning CD-ROM and place it in its case.

6. Close the CD-ROM drive.

Cleaning the printer

See the OEM manual for cleaning and adjusting instructions for the HP LaserJet 
4015N printer.

Cleaning the mouse

1. Make sure the computer is turned off.

2. Disconnect the mouse cable from the computer.

3. Turn the mouse over and look carefully at the bottom. To remove the retainer 
ring, turn it in the direction indicated by the diagram on the bottom of the 
mouse.

4. Turn the mouse over, top side up, so that the retainer ring and ball drop out.

5. Wash the ball in warm, soapy water; then dry it with a clean cloth. Blow air 
carefully into the ball-cage to dislodge dust and lint.

6. Look for a build-up of dirt on the plastic rollers inside the ball-cage. This build-
up usually appears as a stripe running around the middle of the rollers.

7. If dirty, clean the rollers by using a cotton swab soaked in isopropyl (rubbing) 
alcohol. Turn the rollers with your finger and repeat the process until all 
deposits are removed. After cleaning, make sure the rollers are still centered in 
their channels.

8. Make sure that fluff from the swab is not left on the rollers.

9. Replace the ball and retainer ring. Turn the retainer ring to lock it into place.

10. Connect the mouse cable to the computer. Turn your computer back on.
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UPS maintenance

All UPS sub-systems used in MUSE systems use sealed lead acid batteries. These 
batteries do not require any specific preventive maintenance other than testing for 
functionality.

UPS Battery Care
Keep the area around the unit clean and relatively dust free. If the atmosphere is very 
dusty, clean the outside of the system periodically with a vacuum cleaner.

Battery Life
Battery life will vary based on ambient temperature and amount of time that the 

  batteries are used. Maintaining an ambient temperature of 25 C (77 F) will help 
attain maximum battery life. Typical battery life is approximately 2 – 4 years. It is 
recommended that floor mount UPS systems be returned for battery replacement 
and testing every 3 years or sooner if the preventive maintenance tests described 
below fail.

The rack mounted UPS systems are designed to allow on site replacement of 
batteries. Contact your authorized service provider or follow the recommended 
procedures in the Rack Mount UPS manual.

UPS testing

NOTE
The following test should not be run on system that is in operation. It should 
only be done during scheduled down time for preventive maintenance. The 
following test disconnects the power from the line and attempts to supply the 
load from batteries. If the batteries cannot hold the load, the system attached to 
the UPS will experience a power failure.

There is a self-test built into the UPS. This can be run from the front panel of the 
unit by depressing and holding the Test/Alarm Reset button for 3 seconds. The unit 
will do an internal self-test. If a problem is found the unit will sound an alarm and an 
LED will turn on to indicate the nature of the problem. 

The test can be run from the Fail Safe III software. 

1. At the file server select Start → Programs → FailSafe III → FailSafe III 
console. 

2. From the console window select Maintenance → Test Hardware. 

3. At the test hardware window press the Test button. 

4. The system will respond with maintenance is running. After about 42 seconds 
the system will respond with a maintenance completed OK message. 

5. Close the FailSafe III window.

It is possible that if the system has gone for a long period of time without loss of 
input power, the batteries could be in an unrecognized failed condition. It is also 
possible that the built in test may pass. During scheduled down time, the most 
thorough test is to disconnect the input power from the UPS with the full load 
applied to the system. The unit should maintain power to the system for the 
recommended amount of backup time based on the equipment load, which is 
typically better than 5 minutes.
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Disassembly guidelines

PCB assemblies
Observe the following guidelines when working on all PCB assemblies:

Take precautions against electrostatic discharge damage.
Handle all PCB assemblies by their edges.
Use a heatsink when soldering any phototransistors, photodiodes, or optical 
isolators.
After soldering, clean excess flux from the PCB assembly.

Hardware
Before disassembly, note the positions of any wires or looms (cables), marking 
them if necessary to ensure that they are replaced correctly. 
Save and set aside all hardware for re-assembly. 

Opening the file server
See the OEM manual for your specific system for the steps to open, disassemble, 
and reassemble your system.

WARNING
Turn off power and disconnect power cord from AC power source 
before removing the cover.

Opening the HP LaserJet 4015N printer
Instructions on opening the HP printer, adding RAM, and other maintenance 
procedures can be found in the OEM manual.
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Equipment safety tests

Introduction
The following paragraphs contain equipment safety tests to ensure that the MUSE 
system poses no electrical health hazards. It is suggested that the equipment safety 
tests be performed every 6 months and every time a circuit board/assembly is 
removed and replaced. The following table lists the tests.

Equipment necessary to perform these equipment safety tests includes a 110-volt 
leakage current tester, pn MT-1216-01AAMI, (referred to as tester) and a digital 
multimeter. Note that for 220-volt, use tester, pn MT-1216-02AAMI.

NOTE
Failure to implement a satisfactory maintenance schedule may cause undue 
equipment failure and possible health hazards. Unless an Equipment 
Maintenance Contract exists, GE Medical Systems Information Technologies 
does not in any manner assume the responsibility for performing the 
recommended maintenance procedures. The sole responsibility rests with the 
individual or institution using the equipment. GE Medical Systems Information 
Technologies service personnel may, at their discretion, use this procedure as a 
helpful guide during visits to the equipment site.

Table 2. Equipment Safety Tests

Test # Applies to Tools Required

1 File servers, acquisition servers/
processing stations, and 
workstation computers that have 
the MAC 6/MAC PC Local 
Acquisition Port

110V ac MT-1216-01AAM 220 V ac MT-
1216-02AAMI (or equivalent) and 
DVOM

2 Same as above. Same as above.
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Preparation for tests
NOTE

The following procedure checks for proper wiring of the power receptacle. If 
the proper indications of step A (normal polarity and ground) are not obtained, 
the following procedures will be ambiguous. Do not proceed until a properly 
wired outlet is found.

This procedure verifies that a properly wired outlet is used to furnish power to the 
MUSE system. Note also that Chapter 6, “Troubleshooting,” contains an additional 
and important power source verification procedure that should also be done.

Connect the appropriate leakage tester to the power outlet.
Insure that the GND switch on the leakage tester is in the down (closed) 
position.
Check the O, K, and R indicators for the condition according to the table below. 
Normal polarity and ground is the desired and safe condition.

Table 3. Power Receptacle Wiring Check

Step
Indicator

Condition
O K R

A On On Off Normal polarity and ground

B Off On On Reverse polarity

C Off On Off No ground

D On Off On No neutral

E Off Off On No neutral/reverse polarity

F Off Off Off No power
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Test #1: ground-wire-leakage-to-ground test
NOTE

This diagram shows only a representation of how a typical leakage current 
tester functions. Follow the instructions provided with your leakage tester.
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Test #2: chassis-leakage-to-ground (exposed chassis) test
NOTE

This diagram shows only a representation of how a typical leakage current 
tester functions. Follow the instructions provided with your leakage tester.
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Performing anti-virus scanning from an FE notebook 
computer

Introduction
This procedure describes how to scan the MUSE file server for viruses, over the 
network, by using the Symantec AntiVirus Corporate Edition software that is 
installed on an FE notebook computer.

Mapping drives to the MUSE file server
The first step is to map drives to the MUSE file server so that they can be selected 
within the antivirus software for scanning. You can use Windows Explorer to map to 
the \\servername\c$ and \\servername\d$ administrative shares. 

Use the Connect using a different user name feature to provide a username and 
password that has administrator rights on the MUSE file server. On MUSE systems 
you should be able to use the local administrator account and the corresponding 
password. For example, in the Connect As dialog box you would enter 
administrator for the User name and password for the Password. The real 
password is not supplied here for obvious reasons.



Revision Z MUSE™ Cardiology Information System 7-15
2002783-027

Maintenance: Performing anti-virus scanning from an FE notebook computer

Configuring a custom scan
Open Symantec AntiVirus and select New Custom Scan as shown below. Provide a 
descriptive name and description so that you will recognize it when you want to run 
it.

After clicking Next>, select the c$ and d$ drives that you mapped previously.
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Click on Save to save this custom scan. Now you can highlight the custom scan you 
created and click on Scan to run it.

Or if you need to make changes to the configuration for the scan, you can click on 
Edit as shown below.

Click on Options to bring up the Scan Option dialog where you can configure 
different options such as the files to include or exclude. You wouldn’t normally 
want to exclude any files for a one time scan, but keep in mind that for a large 
system the scan could take quite a long time.
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How to change the name of the file server
1. Shutdown the MUSE system from IMS, or stop the CV_SCM service if there 

are no users on the system.

2. Edit d:\vol000\system\sysinf\backtask.asc, generacq.asc, resource.asc, and 
xmlacq.asc to have the correct computer name.

3. Edit MainServerName= in the [MUSE] section of c:\windows\win.ini to have 
the correct computer name. This needs to be done on the file server and on each 
client workstation.

4. Right-click on My Computer and select Properties.

5. Click on the Computer Name tab.

6. Click on the Change button.

7. Enter the correct computer name in the Computer name field.

8. Click OK.

9. Click OK to the message that you will need to restart the computer.

10. Click OK to close the System Properties window.

11. Click Yes to the question about restarting the computer now.

12. After the system reboots, verify that the services start correctly and that the 
MUSE system is functioning properly.
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Upgrading the BIOS firmware
If the 1MB processor which was originally shipped with a G4 file server needs to 
be replaced, you may need to replace it with a 2MB processor (pn 2031370-001). 
After replacing a 1MB processor with a 2MB processor, you may need to 
upgrade the BIOS firmware. 

NOTE
The BIOS firmware upgrade procedure described below is needed if the 
BIOS firmware date displayed when the file server boots is dated earlier than 
11/09/2005 (November, 2005). If the BIOS firmware date displayed on reboot 
is 11/09/2005 or later, the BIOS firmware upgrade is not necessary.

1. Create a BIOS upgrade floppy diskette by inserting a blank diskette into the 
floppy drive and the 5E Support CD #2 (pn 2021275-002) in the CD drive.

2. Select Start → Run....

3. Click Browse... and browse to:
[CD drive letter]:\BIOS\ML370G4\SP31871.exe

4. Follow the on-screen prompts to create the BIOS upgrade floppy.

5. When the process is done, reboot the system with the floppy diskette in the 
drive.

The system should automatically boot from the floppy disk and display 
ROMPAQ Firmware Upgrade Utility V4.20M.

NOTE
If the system does not boot from the floppy, you may need to reboot the 
system and press F9 during the boot process and then select the floppy 
as the boot device.

6. At Select a Device window, select Compaq ML370G4 and press Enter.

7. At the Select an Image window, select 11/09/2005, and press Enter.

8. At the Caution window, read and follow the warning, ...Do not reboot or turn 
off your machine while programming is in process. Press Enter.

9. Wait for the upgrade process to complete (2-3 minutes) and display 
Flash Programming Completed Successfully. Press Enter.

10. At Do you want to reprogram another ROM?, press the Esc key.

11. Remove the floppy and power cycle the system.
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Changing MUSE Service Accounts
The following MUSE service accounts are integral to the correct operation of the 
MUSE system: 

The process of changing the passwords for these accounts consists of the following 
procedures. 

1. Changing the MUSE account passwords. 

See “Changing Service Accounts Passwords” on page 7-19 for details. 

2. Changing the password on scheduled IMS tasks. 

See “Changing Passwords for Windows Scheduled Task(s) for IMS” on page 7-
20 for details. 

3. Reinstalling the MUSE services. 

See “Re-Installing the MUSE Core Services” on page 7-21 for details. 

4. Changing the MACCRA service password. 

See “Changing the MACCRA Service Password” on page 7-22 for details. 

5. Changing the password on any interconnected systems. 

See “Changing Passwords on Interconnected Systems” on page 7-22 for details. 

6. Verifying the system functions with the new passwords. 

See “Verifying the Changes” on page 7-22 for details. 

If you are using domain accounts and do not have the appropriate permissions to 
change them, contact the IT domain system administrator and request that the 
passwords be changed. 

Changing Service Accounts Passwords
Use the following procedure to change service account passwords. The same 
procedure can be used for both local accounts and domain accounts; however, to 
change the passwords for domain accounts, you must have the appropriate 
permissions. If you do not have the appropriate permissions, contact the system 
administrator to change the passwords for you. 

If the MUSE File Server, HIS Server, and MUSE Clients all use the same domain 
MUSEBkgnd account and password, you need to perform this procedure only once: 
the change will be applied globally. If they use local accounts, you must perform the 
procedure on each computer where the account exists. 

Default Account Description

MUSEAdmin MUSE administrator account. Used by the MUSE application 
to perform functions critical to the system operation. Also used 
by MUSE Tech Support to help troubleshoot and maintain the 
system.

MUSEBkgnd MUSE background account. Used to run the MUSE services.
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1. Log on to the server as the user whose password is to be changed.

The user will be either MUSEAdmin or MUSEBkgnd. 

2. Press Ctrl+Alt+Delete.

The Windows Security dialog box opens. 

3. Click the Change Password... button.

The Change Password dialog box opens. 

4. Type the current password into the Old Password field.

5. Type the new password into the New Password and Confirm New Password 
fields.

6. Click OK.

If the new password meets the system restrictions, the password is changed and 
a confirmation message is displayed. 

7. Click OK.

The confirmation message closes and you return to the Windows Security dialog 
box. 

8. Do one of the following:

If you changed the MUSEAdmin password, continue to “Changing 
Passwords for Windows Scheduled Task(s) for IMS” on page 7-20.
If you changed the MUSEBkgnd password, skip to “Re-Installing the 
MUSE Core Services” on page 7-21.

Changing Passwords for Windows Scheduled Task(s) for IMS
The MUSE v5E system uses a Windows scheduled task to run the daily IMS job. By 
default, this job is configured to use the MUSEAdmin account and password. If you 
change the MUSEAdmin password, use the following procedure to modify the 
password of the scheduled tasks to the new MUSEAdmin password. 

1. Select Start > Programs > Accessories > System Tools > Scheduled Tasks. 

The Scheduled Tasks window opens. 

2. Right-click on a scheduled task and choose Properties.

The task’s Properties window opens. 

3. Enter the appropriate domain or local MUSEAdmin account in the Run as field. 

4. Click Set Password.

The Set Password window opens.

5. Type the new MUSEAdmin password in both the Password and Confirm 
Password fields. 

6. Click OK to close the Set Password window. 

7. Click OK to close the task’s properties window. 

8. Verify the job runs successfully.

9. Repeat step 2 through step 8 for each scheduled task.
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Systems running v5E.12 or higher will have the following scheduled tasks:

IMS-rs
IMS-rsm
IMS-system

10. Do one of the following:

If you changed the MUSEBkgnd password, continue with “Re-Installing 
the MUSE Core Services” on page 7-21.
If you changed the MUSEAdmin password, skip to “Verifying the 
Changes” on page 7-22. 

Re-Installing the MUSE Core Services
Windows stores the MUSE background account’s name and password with any 
service registration associated with that account. If you change the Windows 
account name or password, you must re-install the MUSE services so they can be re-
registered with the new account name and password.

1. Perform an IMS shutdown on the MUSE server.

2. Stop the CV_SCM service and verify that all MUSE services have stopped.

3. Open a Command Prompt window on the MUSE file server.

4. Change to the c:\mei directory.

5. Type the following command and press Enter.

cvsinst [space] domain\MUSEBkgnd [space] password [space] 
d:\vol000\system\sysinf\services.asc

Where:

domain is the name of the domain where the account resides. For local 
accounts, it will be the name of the MUSE file server.
password is the password assigned to the MUSEBkgnd account. 

6. When you receive a message stating that the services have been re-installed, 
close the Command Prompt window and restart the CV_SCM service.

7. If there is a HIS Interface, repeat step 1 through step 6 on the HIS Interface.

8. If the MUSE server or clients have defined modems, the modem services must 
be reinstalled. Refer to “MUSE™ Cardiology Information System Standard 
Fax/Asynch CSI Modem Upgrade” (2002783-012) for instructions on installing 
modem services.

9. Determine whether the MACCRA service is installed and do one of the 
following.

If the MACCRA service is installed, continue to “Changing the MACCRA 
Service Password” on page 7-22.
If the MACCRA service is not installed, determine whether the MUSE 
system is connected to a MARS system or Monitoring Gateway. If it is, 
skip to “Changing Passwords on Interconnected Systems” on page 7-22. If 
it is not, skip to “Verifying the Changes” on page 7-22.
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Changing the MACCRA Service Password
The MACCRA service is used by several MUSE options, such as CV Web, and is 
run using the MUSE Background account name and password. Therefore, if you 
changed the MUSE background account name or password, use the following 
procedure to update the MACCRA service.

1. In the Services list, locate the MACCRA service and open its Properties.

2. On the MACCRA Properties window, select the Log On tab.

3. Enter the Windows domain and account name of the MUSE background 
account in the This account field.

4. Enter the account’s password in both the Password and Confirm Password 
fields.

5. Click OK.

6. Restart the service for the changes to take effect.

7. Proceed to “Changing Passwords on Interconnected Systems” on page 7-22.

Changing Passwords on Interconnected Systems
The MUSE system can interact with the following external systems:

MARS PC
Using its default configuration, the MUSE system pulls holter data from the 
MARS PC using the MUSEBkgnd account. 

Monitoring Gateway
Using its default configuration, the MUSE system pulls 12-lead ECG data from 
the Monitoring Gateway using the MUSEBkgnd account.

If the MUSE, MARS PC, and Monitoring Gateway systems all use the same 
MUSEBkgnd domain account and password, no changes are required on the MARS 
PC or Monitoring Gateway: the changes you made to the MUSE system will be 
applied globally on both systems. However, if the MUSE system uses local 
accounts, you must change the MUSEBkgnd password on MARS PC and 
Monitoring Gateway to match the change on the MUSE server. 

Verifying the Changes
After changing the service password(s) on the MUSE system and all interconnected 
systems, verify that the system functions correctly as described in “Installation 
Checkout Procedures” in MUSE™ Cardiology Information System File Server 
Installation (PN 2020285-024)
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Conducting Service Checkouts
Whenever a MUSE system is serviced, checkout procedures must be performed to 
comply with FDA guidelines and to ensure that the system is safe and functioning 
properly. The specific procedures depend on the service performed. 

The following sections:

identify the required tools, 
describe the checkout procedures for FRU repairs, and 
describe the checkout procedures for non-FRU repairs.

Required Tools
The following list identifies all the tools that may be required to perform a specific 
checkout procedure. When a specific tool is required by a procedure, it will be 
identified by number.

1. Standard hand tools, including a #10 Torx Driver

2. Anti-static wrist strap

3. Applicable service and/or operator manual as needed 

Use OEM manuals for reference as needed. 

4. Floppy Diskette

5. SD Card

6. Tape

7. CD or DVD

8. Leakage tester 

9. Multimeter

Visual Checkout and Cleaning
All service repairs should include a visual inspection of the product before service 
begins. For information on what to inspect, refer to “Visual inspection” on page 7-5.

If the system box is opened, also inspect for dust. If necessary, clean the dust from 
the interior as described in “Interior cleaning” on page 7-6.

Checking Out FRU Repairs
FRU replacement should be made following the appropriate repair procedures 
outlined in the manufacturer's manual for the system. For systems under the 
manufacturer’s warranty, the repair may be performed by the OEM service 
representative. However, final functional checkout of the system is the 
responsibility of the GE service representative onsite at the time.
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NOTE
The FRU checkout procedure for any listed FRU also applies to its internal 
PCBs and components

Locate the repaired FRU in the following table to identify tools and checkout 
procedures to use. The tools are described in “Required Tools” on page 7-23. The 
checkout procedures follow the table. 

1. SERVER 

NOTE
Verify that rack-mounted systems have been fully seated and fastened to 
the rack before proceeding.

a. Reboot the server.

b. Confirm that system boots normally (that is, no errors occur). 

c. Confirm you can successfully log on to the MUSE system from the server. 

d. Confirm that users can successfully log on to the MUSE system from a 
client workstation. 

e. Confirm that users can open the Edit List and access a patient record from a 
client workstation

FRU Description Tools Visual 
Inspection?

Checkout 
Procedures

Hard Drive 1, 2, 3 Y 1, 2

Disk Array Controller 1, 2, 3 Y 1, 2, 3

Power Supply 1, 2, 3, 8, 9 Y 1, 2, 10

Fan 1, 2, 3 Y 1, 2

Mother Board 1, 2, 3 Y 1, 2

Battery 1, 2, 3 Y 1, 2

Network Card (NIC) 1, 2, 3 Y 1, 2

Memory 1, 2, 3 Y 1, 2

Floppy Drive 1, 2, 3, 4 Y 1, 2, 6

CD/DVD Drive 1, 2, 3, 7 Y 1, 2, 7

Multimedia Card Reader (External) 1, 2, 3, 5 Y 1, 2, 8

Tape Drive 1, 2, 3, 6 Y 1, 2, 5

Tape Drive Controller 1, 2, 3, 6 Y 1, 2, 5

Modem 1, 2, 3 Y 1, 2, 9

Mouse 1, 2, 3 Y 1, 2

Keyboard 1, 2, 3 Y 1, 2

Display 1, 2, 3 Y 1, 2, 4
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2. CLIENT

a. Reboot the client.

b. Confirm that the system boots normally (that is, no errors occur).

c. Confirm that users can successfully log on to the client.

d. Confirm that users can open the Edit List and access a patient record. 

3. DISK ARRAY CONTROLLER

a. Confirm that C and D drive partitions have been created correctly.

b. Verify that the disaster recovery procedure restored the MUSE database. 
For more information, refer to “Disaster recovery – MUSE file server” on 
page 4-22.

4. DISPLAY

a. Confirm the display resolution is set to customer preference.

b. Open the MUSE application and confirm the application displays correctly.

5. TAPE DRIVE/TAPE DRIVE CONTROLLER

a. Using the Enterprise Manager or SQL Server Management Studio, run a 
manual MUSE backup.

b. Confirm the backup was successful. 

c. Verify that all tapes are being successfully used per the backup schedule. 

d. Replace tapes that are past their intended life span.

6. FLOPPY DRIVE

a. Access the floppy using My Computer or Windows Explorer.

b. Confirm that the contents of the floppy are displayed.

c. Confirm that you can open and save files to the floppy. 

d. Confirm that you can acquire data into the MUSE system from the floppy. 

7. CD/DVD DRIVE

a. Access the CD or DVD drive using My Computer or Windows Explorer. 

b. Confirm that the contents of the media are displayed.

c. Confirm that you can open files from the media.

8. MULTIMEDIA CARD READER

a. Access the card reader using My Computer or Windows Explorer.

b. Confirm that the contents of card are displayed.

c. Confirm that you can open and save files to the card.

d. Confirm you can acquire data into MUSE from the card.

9. MODEM

a. Transmit an ECG from a cart to the modem.

b. In the MUSE application, select System Status.

c. Select Newly Acquired or Acquisition Log.

d. Verify the PID/Name of the ECG transmitted from the cart has been 
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acquired. 

10. ELECTRICAL SAFETY CHECKS

Perform electrical safety checks when indicated. Record measurement values in 
your debrief. 

NOTE
The following values apply to 120/240 VAC for personal computers.  

60950-1
Leakage Current Limits in 

microamps (uA) 1

Step Description Condition2 UUT–ON3 Results IEC 60601-1 UL 60601-1

A Earth Leakage Current in uA Type ITE

1 Forward Polarity NC Pass/Fail 3500 3500

2 Neutral Open, Forward Polarity SFC Pass/Fail 3500 3500

3 Neutral Open, Reverse Polarity SFC Pass/Fail 3500 3500

4 Reverse Polarity NC Pass/Fail 3500 3500

B Enclosure Leakage Current in uA Type ITE

1 Forward Polarity NC Pass/Fail 3500 3500

2 Neutral Open, Forward Polarity SFC Pass/Fail 3500 3500

3 Ground Open, Forward Polarity SFC Pass/Fail 3500 3500

4 Ground Open, Reverse Polarity SFC Pass/Fail 3500 3500

5 Neutral Open, Reverse Polarity SFC Pass/Fail 3500 3500

6 Reverse Polarity NC Pass/Fail 3500 3500

C Ground Continuity in ohms Resistance in ohms

1 AC mains power cord ground prong to 
exposed metal surface (e.g., ground lug)

N/A Pass/Fail < 200 < 200

1. Countries recognizing IEC standards use the IEC values; countries recognizing UL standards use the UL values.
2. Condition Abbreviations: NC – Normal Conditions, SFC – Single Fault Condition, N/A – Not Applicable
3. Record your readings in this column.
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Checking Out Non-FRU Repairs
System functional checks are required for non-FRU repairs and typically involve 
MUSE setup and configurations that can be performed remotely or onsite. If 
performed remotely, visual inspections or confirmation should be completed by a 
customer contact or FE on-site.  

Checkout Tools Visual 
Inspection

Checkout 
Procedure

Printing
Manual printing NR Y 1a
Automatic printing NR Y 1b
Format setting change NR Y 1c

Faxing
Manual faxing NR Y 2a
Automatic faxing NR Y 2a

Editing/Confirming
Edit record checkout NR Y 3a
Confirm record NR Y 3b

Report Distribution
NR Y 4

Device Setup
Output device (printer, fax, HL7 results) NR Y 5a
Inbound devices (modem, share) NR Y 5b

User Setup
NR Y 6

Carts Transmission
Modem transmission NR Y 7a
Wireless transmission NR Y 7b
LAN transmission NR Y 7c

MARS Transmission
New MARS to MUSE setup NR Y 8a
MARS formatted report print NR Y 8b

CASE/Cardiosoft Transmission
CASE/Cardiosoft to MUSE NR Y 9

Monitoring Transmission
Manual transmission from bedside monitor NR Y 10

Database Search
Manual report NR Y 11a
Automatic report NR Y 11b

MUSE Web
MUSE Web data retrieval NR Y 12
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1. PRINTING

a. Manual Print Checkout

i Highlight a record on the MUSE Edit List and click the Print button.

ii Select the printer you want to test, from the drop-down menu and click 
OK. 

iii Verify that the record printed out correctly at the printer selected.

b. Automatic Print Checkout

i Acquire data from a cart/stress device with the location number you 
are testing.

ii Verify that the record prints out correctly at the printer setup for 
automatic distribution.

c. Format Setting change checkout

i Highlight the record on the MUSE Edit List and click the Print button.

ii Select the printer you want to test from the drop-down menu and click 
OK.

iii Compare the new printout to a previous printout to verify format 
changes took effect.

2. FAXING

a. Manual Fax to temporary or defined device checkout

i Highlight record on the MUSE Edit List and click the Print button.

ii Send to a temporary fax machine.

iii Check that the fax printed correctly at the receiving fax machine.

a. Automatic Fax to existing fax device checkout

i Acquire data from an ECG cart with the location setup for the correct 
report distribution, or confirm data with correct physician mapping for 
auto-fax.

ii Check that the fax printed correctly at the receiving fax machine.

CV-Web
CV Seb data retrieval NR Y 13

Remote Support
NR Y 14

HIS/CCG
HIS ADT/Orders inbound checkout NR Y 15a
HIS Real-time results/billing outbound checkout NR Y 15b
Order download from MAC Cart checkout NR Y 15c
XML Import NR Y

Checkout Tools Visual 
Inspection

Checkout 
Procedure
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3. EDITING/CONFIRMING

a. Edit record checkout

i Have customer open a record on the MUSE Edit List and edit as 
normal.

ii Update in Edit List.

iii Re-open record to verify the changes have been saved.

b. Confirm Record Checkout

iv Have customer edit a record on the Edit List.

v Have customer confirm the record.

vi Do a retrieval of the record and verify it is now in the database.

4. REPORT DISTRIBUTION CHECKOUT

a. Acquire or confirm data for the location of new report distribution setup.

b. Check the output device setup in the Report Distribution for the report.

5. DEVICE SETUP

a. Output Device (Printer, Fax, HL7 Results)

i Highlight a record on the MUSE Edit List and click on the Print 
button.

ii Select newly created device from the drop-down menu and click OK.

iii Check device for report.

b. Inbound Device (Modem, Share)

i Transmit record from source device.

ii Verify record appears in MUSE system.

6. USER SETUP

a. Have newly created user start the MUSE application.

b. Have user log on and confirm MUSE access based on roles/privileges 
given during setup.

7. CARTS TRANSMISSION

a. Modem transmission checkout

i Transmit ECG from cart to modem.

ii In the MUSE system select System Status.

iii Select Newly Acquired or Acquisition Log.

iv Check that PID/Name of ECG transmitted from cart has been acquired 
by the MUSE system.

b. Wireless transmission checkout

i Transmit ECG from cart while in range of wireless antennae.

ii In the MUSE system select System Status.

iii Select Newly Acquired or Acquisition Log.

iv Check that PID/Name of ECG transmitted from cart has been acquired 
in the MUSE system.
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c. LAN transmission checkout

i Transmit ECG from cart via LAN.

ii In the MUSE system select System Status.

iii Select Newly Acquired or Acquisition Log.

iv Check that PID/Name of ECG transmitted from cart has been acquired 
in MUSE.

8. MARS TRANSMISSION

a. New MARS to MUSE setup checkout

i From a MARS workstation send a Holter report to the MUSE system.

ii In the MUSE system select System Status.

iii Select Newly Acquired or Acquisition Log.

iv Check that PID/Name of ECG transmitted from MARS has been 
acquired by the MUSE system.

b. MARS formatted report print checkout

i In MUSE highlight a Holter report on the Edit List or retrieve from 
database.

ii Click the Print button.

iii Compare the newly-printed Holter report to the report printed prior to 
the installation of the MARS formatter and verify the format changes. 

9. CASE/CARDIOSOFT TRANSMISSION

a. Send Stress report to the MUSE system.

b. In the MUSE system select System Status.

c. Select Newly Acquired or Acquisition Log.

d. Check that PID/Name of ECG transmitted from cart has been acquired by 
the MUSE system.

10. MONITORING TRANSMISSION

a. From Bedside/DASH monitor, transmit 12SL to the MUSE system.

b. In the MUSE system select System Status.

c. Select Newly Acquired or Acquisition Log.

d. Check that PID/Name of ECG transmitted from cart has been acquired by 
the MUSE system.

11. DATABASE SEARCH

a. Manual Search checkout

i Go to Database Search function on the MUSE system.

ii Create a search.

iii Choose criteria and run the search.

iv Verify search results match criteria selected.

b. Automatic Search checkout:

i Go to Database Search function on the MUSE system.

ii Create a search.
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iii Save the criteria.

iv Schedule the search.

v Verify search runs when scheduled and expected results are generated. 
The MUSE system runs all scheduled searches only once per day (2:00 
AM).

12. MUSE WEB DATA RETREIVAL CHECKOUT

a. Start Internet Explorer.

b. Type the MUSE server name into the URL field (i.e. http://museserver).

c. If prompted, log on as a user who has access to MUSE Web.

d. Choose Frames or No Frames option.

e. Type patient ID into PID field, or patient name into Last Name field.

f. Find record for verification that MUSE Web is working properly.

13. CV Web DATA RETRIEVAL CHECKOUT

a. Start Internet Explorer.

b. Type the CV Web server name into the URL field (i.e. http://cvweb).

c. If prompted, log on as a user who has access to MUSE Web.

d. Type patient ID into PID field, or patient name into Last Name field.

e. Verify appropriate MUSE server/site is selected.

f. Find record for verification that CV Web is working properly.

14. REMOTE SUPPORT

a. Log into customer’s system using the remote connection configured for 
that system (PCAnywhere or Insite 2).

b. Confirm that you can access customer’s desktop via remote connection.

c. Confirm you can upload and download files to customer system.

15. HIS/CCG

a. HIS ADT/Orders Inbound Checkout:

i From the MUSE system go to HIS Event Viewer.

ii Verify inbound ADT and order events exist. 

iii Have customer verify data being sent from their interface is flowing 
into MUSE.

b. HIS Real-time Results/Billing Outbound Checkout:

i From the MUSE system go to HIS Event Viewer.

ii Verify outbound results/billing events exist. 

iii Verify outbound data is leaving the MUSE result/billing queue.

c. Order Download from MAC Cart Checkout:

i From a MAC cart use the order download function.

ii Verify that the MAC cart is able to successfully download orders from 
MUSE.
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16. XML Import

a. Copy XML data files from the manufacturer’s device into the XML folder 
setup on the MUSE server.

b. In the MUSE application, select System Status. 

c. Select New Acquired or Acquisition Log. 

b. Verify the XML data has been acquired into the MUSE system. 



TheMUSE™ system preventive maintenance inspection 
report

Customer _______________________________________ Customer # ______________________ Date _______________

Field Engineer __________________________________ Case # ________________________________

Equipment Serial # ________________________________________________ MUSE Software Version _______________

Required tools
1. Standard hand tools (p/n NA)
2. Multimeter (p/n NA) (Not always required)
3. DAT cleaning tape (p/n 409669-001) (Not required on all systems)
4. AIT cleaning tape (p/n 2291441) (Not required on all systems)
5. Vacuum cleaner (p/n VACUUM)
6. Floppy Drive cleaning kit (p/n 407546-001)
7. Field Service manual - reference only
8. Operator's manual - reference only

Visual inspection
Inspect the following for visual wear and/or for proper functionality

1. ____ Network cabling (broken insulation)
2. ____ Network cabling (proper stress relief
3. ____ AC power cord(s)
4. ____ Fans
5. ____ Internal and external system cables and connectors
6. ____ Laser printer toner cartridge

Cleaning
1. ____ Clean all internals of dust (may not be necessary in raised floor computer rooms)
2. ____ Clean all keyboards
3. ____ Clean mouse contacts (only necessary on roller ball style)
4. ____ Clean all fans and air intakes
5. ____ Clean floppy drives
6. ____ Clean CD-ROM drives (use canned air to carefully blow out any dirt or debris)
7. ____ Clean the DAT or AIT backup tape drive - older systems use the DAT tape drive
8. ____ Clean external surfaces and monitor screens

Calibration
There is no calibration required on the MUSE system.



Diagnostic tests
1. Verify that there is a recent backup before doing other diagnostic tests.
2. Shut down MUSE from IMS before running Diskeeper and scheduling CHKDSK and rebooting.
3. Verify that Defrag is running regularly by checking the Diskeeper schedule. If it is not running regularly, run it on both drive C: 

and D:. Wait until the remote checkout procedure below has been completed to run Diskeeper.
4. Schedule CHKDSK to run on the next reboot for both drive C: and D:.

a. From Windows Explorer, under the properties for the drive, on the Tools tab.
b. Select only the bottom check box - Scan for and attempt recovery of bad sectors.
c. Reboot the system and note any errors during the boot up process, especially when CHKDSK runs.

AntiVirus procedure
Check with the customer, or on the system, to see if they are running an antivirus program on the MUSE. If they are, and if they are 
keeping the virus definition files up to date, you do not need to do anything more. You may need to remind them to keep the definition 
files up to date. If they are not running antivirus software, and if in the process of doing this PM or in discussions with the customer you 
suspect that the system may have a virus, you can follow the procedure outlined in “Performing anti-virus scanning from an FE 
notebook computer” on page 7-14 to run an anti-virus check over the network from your notebook computer. Please keep in mind that 
the procedure is just a guideline, and that running the antivirus check could take a long time on some systems.

PM checkout procedures
NOTE

Use the checkout steps below as a guideline. Some of these steps can be verified by looking at the system or through discussions 
with the customer.

Use the Service and Operator's manual where necessary for reference. Perform the following for all applicable options.

1. Power up all nodes and ensure that each one initializes and that you can log into MUSE.
2. Verify that records can be acquired via diskette, serial cable, modem (CSI and SDLC), and wireless connections, and that they 

route properly based on report distribution settings.
3. Verify that data can be acquired from the MARS system(s).
4. Verify that data can be acquired from the CASE system(s).
5. Verify that data can be acquired from the Mac-Lab system(s).
6. Verify that reports are being successfully transmitted through the Monitoring/MUSE gateway.
7. Verify that the system can successfully send reports to laser printers and fax machines.
8. Verify that users can successfully edit and confirm reports from the Edit List.
9. Verify that the system is running the latest point release for the current version of software (i.e. version 5C.10). If necessary, update 

the system to the latest version. This update will need to be coordinated with the site.
10. Contact the Jupiter Online Center and verify that they can remotely access the system. *See remote checkout procedure below.
11. Check the backup tapes to ensure they have not exceeded their expected lifespan. (Customers should store old tapes for 

safekeeping).
12. Verify that Archive backup tapes exist for all Archive Volumes on the system.
13. Verify that there is enough free space on the system to provide for continued growth.
14. Perform a service tape backup of the system.



Remote checkout procedure
This section should be performed by technical support while connected to test remote access.

1. Check that backups are functioning and that tapes are being rotated. (Does not apply to sites that are doing network backups).
2. Check the MUSE Event Log and Error Log, and the NT Event Viewer for any obvious problems.
3. Verify that *.bak files are not collecting in the d:\vol000\tmp\acq folder. There should only be files that have collected since the 

last backup.
4. Perform a cleanup of the working directories - \tmp and its subfolders, and copy in new Btrieve queues where appropriate.
5. Delete any old files that may have been left on the system for troubleshooting purposes.
6. Delete or move any unnecessary files or folders from under d:\vol000.

Reference

This section has been maintained from previous versions for reference. You are not expected to shutdown the system to perform these 
tests.

This report is to be filed at customer site.

Briefly describe all repairs/adjustments made and list any parts replaced:

_________________________________________________________________________________________________________

_________________________________________________________________________________________________________

_________________________________________________________________________________________________________

_________________________________________________________________________________________________________

_________________________________________________________________________________________________________

_________________________________________________________________________________________________________

Additional Comments: 
_________________________________________________________________________________________________________

_________________________________________________________________________________________________________

_________________________________________________________________________________________________________

_________________________________________________________________________________________________________

Customer Signature:  _______________________________________ Date: ______________________________________

FE Signature:  _____________________________________________ Date: ______________________________________

DPMFRM-010B   12/10/2003

AC Line Voltage Checkout

Line to neutral = 120V

Line to ground = 120V

Neutral to ground  < 3V

Neutral-ground loop resistance test

Neutral to ground < 2Ω

Neutral

Ground

Line
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Ordering parts

Introduction
The parts lists and assembly drawings in this chapter supply enough detail for you to 
order parts for the assemblies considered field serviceable.

If you require additional information, schematic diagrams, or troubleshooting 
assistance, contact Technical Support.

To order parts, contact GE Healthcare Service Parts.
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Field Replaceable Units
The following items may not be assigned separate manufacturing part numbers 
because they are normally part of a larger assembly. Since they are considered FRUs 
(field replaceable units), they have specific service part numbers so they can be 
ordered and replaced by service technicians. Contact Tech Support for FRU 
information for assemblies used on previous configurations.

NOTE
Verify part numbers before ordering service parts (FRUs). See the tech memo 
series for this product for changes or additions to these lists.

HP ML370 G5 file server

Table 1. FRUs, HP ML370 G5 File Server

Description GE Part Number HP Part Number

FRU HP ML370 ACCESS PANEL (TOP COVER) 2036800-001 409410-001

FRU HP ML370 FRONT BEZEL (TOWER ONLY) 2036800-002 409411-001

FRU HP ML370 RACK BEZEL (RACK ONLY) 2036800-003 409412-001 

FRU HP ML370 TOWER CONFIGURATION PANEL 2036800-004 409413-001 

FRU HP ML370 CENTER WALL 2036800-005 409433-001

FRU HP ML370 REMOVABLE MEDIA BLANK 2036800-006 409414-001

FRU HP ML370 MEDIA BAY SPACER 2036800-007 409415-001

FRU HP ML370 SAS DRIVE CAGE BLANK 2036800-008 409416-001

FRU HP ML370 POWER SUPPLY BLANK 2036800-010 409417-001

FRU HP ML370 PROCESSOR AIR BAFFLE 2036800-011 409419-001

FRU T-10/T-15 TORX SCREWDRIVER L-HEAD 2036800-012 413965-001

FRU SYSTEM DISPLAY TRAY W/EJECT BUTTON 2036800-013 409420-001

FRU ML370 HOT-PLUG POWER SUPPLY 1000-W 2036800-014 403781-001

FRU HP ML370 HOT-PLUG FAN, 120-MM 2036800-015 409421-001

FRU HP ML370 3.3-V LITHIUM BATTERY 2036800-016 153099-001

FRU ML370 DUAL-CORE XEON PROCESSOR 5120 2036800-017 416794-001

FRU HP ML370 HEATSINK GREASE/ALCOHOL PAD 2036800-018 409426-001

FRU ML370 DSPLY PANEL W/BRD, LBL, BEZEL 2036800-019 409427-001

FRU ML370 SYS BOARD W/PROCEESSOR CAGE 2036800-020 409428-001

FRU HP ML370 PPM 2036800-021 407748-001

FRU HP ML370 POWER SUPPLY BACKPLANE 2036800-022 399787-001
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HP ML370 G4 file server

FRU SAS BACKPLANE DUPLEX BRD W/DRV CAGE 2036800-023 409429-001

FRU HP ML370 MEMORY BOARD 2036800-024 409430-001

FRU HP ML370 DVD-RW 2036800-025 384069-001

FRU HP ML370 DISKETTE DRIVE 2036800-026 399397-001

FRU HP ML370 PLASTICS KIT 2036800-027 409431-001

FRU HP ML370 HARDWARE KIT 2036800-028 409432-001

FRU HP ML370 RACK-MOUNTING KIT 2036800-029 377839-001

FRU RETURN KIT PACKING BOX AND CUSHIONS 2036800-030 409434-001

FRU ML370 MISCELLANEOUS CABLE KIT 2036800-031 409436-001

FRU ML370 SAS OPTION CABLE 2036800-032 389952-001

FRU ML370 DISKETTE DRIVE CABLE 2036800-033 431243-001

FRU ML370 2ND PARALLEL/SERIAL PORT CABLE 2036800-034 418300-001

FRU ML370 SFF HARD DRIVE 146 GB
NOTE: Quantity required for rack-mounted server = 6

Quantity required for tower server = 4

2036800-036 432320-001

FRU HP SMARTARRAY P400 CNTRLLR CACHE MOD 2036800-038 405832-001

FRU HP DL360 HARD DRIVE BLANK LFF 2036798-003 392613-001

FRU HP DL360 AC POWER CORD 2036798-021 187335-001

FRU HP FBDIMM PC2-5300F FULLY-BUFFERED 2036798-017 416471-001

Table 1. FRUs, HP ML370 G5 File Server (Continued)

Description GE Part Number HP Part Number

Table 2. FRUs, HP ML370 G4 File Server

Description GE Part Number HP Part Number

Access Panel Top Cover 2026980-001 359233-001

Front Bezel – Tower Model Only 2026981-001 359234-001

Rack Bezel – Rack Model Only 2026982-001 359235-001

Hood Cover – Tower Model Only 2026983-001 359236-001

Power Supply, 800 W 2026984-001 347883-001

Fans, 92 MM 2026985-001 231213-001

Power Button/Switch with Cable 2026987-001 359714-001

Intel Xenon 3.4-GHZ 1-MB L2 Cache 2026988-001 364757-001
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Intel Xenon 3.4-GHZ 2-MB L2 Cache 2031370-001 379429-001

System Board with Processor Cage 2026989-001 347882-001

PPM 2026990-001 347884-001

Power Supply Backplane 2026991-001 347886-001

SCSI Backplane Simplex W/6X1-IN Drive Cage 2026992-001 359719-001

SCSI Backplane Duplex Board 2026993-001 371722-001

Diskette Drive, 3-Mode 1.44 MB 2026994-001 233409-001

DVD-ROM Drive, IDE, 12X 2026995-001 217801-001

Plastics Kit 2026996-001 365962-001

Hardware Kit 2026997-001 365963-001

Wall, Center 2026998-001 359238-001

Round Hole Rack Mounting Kit 2026999-001 373115-001

Country Kit 2027000-001 359712-001

Return Kit Packing Box/Cushions – Tower 2027001-001 359713-001

Processor Air Baffle 2027002-001 359240-001

Miscellaneous Data Cable Kit 2027003-001 365964-001

Miscellaneous Power Cable Kit 2027004-001 365967-001

Cable Management Arm 2027005-001 367831-001

512-MB PC2-3200-R DIMM 2027006-001 359241-001

Rear Fan Cage 2027007-001 230984-001

146.8-GB 10K rpm SCSI Ultra320 hot-plug hard drive
NOTE: Quantity required for rack-mounted server = 6

Quantity required for tower server = 4

2027078-001 289044-001

300-GB 10K rpm SCSI Ultra320 hot-plug hard drive 2027079-001 351126-001

Digi Board - DIGI International, Inc. 412946-006 77000707

Digi Cable - DIGI International, Inc. 414961-003 76000529

Tape Drive SONY AIT-2 SDX-500V/RB Int 2024244-001 SDX-500V/RB

Table 2. FRUs, HP ML370 G4 File Server (Continued)

Description GE Part Number HP Part Number
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HP rp5700 SFF client

Table 3. FRUs, HP rp5700 SFF Client

Description GE Part Number HP Part Number

CMPTR HP RP5700 SFF E6400 1MB 160GB 2040611-001 KW399UP#ABA

FRU FRO RP5700 HOOD ASSY W FRT BEZEL 2040746-001 445766-001

FRU RP5700 POWER SUPPLY 2040746-002 445771-001

FRU RP5700 POWER SWITCH W LED AND CABLE 2040746-003 445759-001

FRU RP5700 SERIAL PORT W CABLE 2040746-004 445768-001

FRU RP5700 HD DRIVE 160GB 7200 RPM SATA 2040746-005 440499-001

FRU RP5700 SYSTEM BOARD 2040746-006 445757-001

FRU RP5700 CPU 2GB E6400 2.13GHZ 2040746-007 450470-001

FRU DC5750 1 GB, PC2-5300, CL5 2036936-022 398038-001

FRU RP5700 MEMORY RISER CARD 2040746-008 445758-001

FRU RP5700 USB EXPANSION CARD W CBL 2040746-009 445775-001

FRU RP5700 FAN 2040746-010 445761-001

FRU RP5700 HEATSINK 2040746-011 445774-001

FRU RP5700 MOUSE PS2 OPTICAL 2040746-012 417966-001

FRU HP ML370 3.3-V LITHIUM BATTERY 2036800-016 153099-001

FRU RP5700 FRONT BEZEL 2040746-013 445766-001

FRU RP5700 SPEAKER INTERNAL 2040746-014 445762-001

FRU RP5700 FAN DUCT 2040746-015 445767-001

FRU RP5700 TOWER STAND 2040746-016 445770-001

DISK DRIVE FLOPPY USB 2.0 EXT BLACK 2034800-002 DC361B

SATA 16X SUPERMULTI LIGHTSCRIBE ALL 2040746-017 RV629AV

SD Card Reader Memory Card 18 in 1 2027495-004 *

* SD Card Reader is not an HP part.
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HP dc7600 SFF client

HP dc7100 SFF client

Table 4. FRUs, HP dc7600 SFF Client

Description GE Part Number HP Part Number

Computer Cover Assembly Front Bezel w/o Inserts 2030505-018 393599-001

Power Supply 5 Output 240W DC7600 2030505-019 381024-001

40 GB\7200 RPM SATA Hard Drive DC7600 2030505-020 365555-001

48X CDROM Drive w/Mounting Screws DC7600 2030505-021 326773-005

SATA Hard Drive Cable 19.5" DC7600 2030505-022 391739-001

Power Switch/LED Cable USE W/370857-001 2030505-023 392410-001

Front I/O Device w/Cable USB+Audio 7600 2030505-024 393606-001

CD Drive Bezel w/Disk Drive Slot DC7600 2030505-025 370501-001

Speaker HP DC7600 SFF 2030505-026 394778-001

Heatsink w/Thermal Grease & Alcohol Pad 2030505-027 382024-001

Chassis Fan HP DC7600 SFF 2030505-028 392412-001

Heatsink Duct Baffle DC7600 SFF 2030505-029 375514-001

Foot Kit Oval and Round (4 each) 7600 SFF 2030505-030 370708-001

Sys Board w/Alcohol Pad & Thermal Grease 2030505-032 381028-001

SD Card Reader Memory Card 18 in 1 2027495-004 *

* SD Card Reader is not an HP part.

Table 5. FRUs, HP dc7100 SFF Client

Description GE Part Number HP Part Number

Computer HP dc7100 P4 2.8GHZ 512MB SFF 2027481-001 PP458US#ABA

40GB Serial ATA hard drive 2027481-002 365555-001

16X/40X DVD-ROM 2027481-003 325313-005

512MB 400MHz DDR-DIMM 2027481-004 325313-005

System Board 2027481-005 361682-001

Intel Pentium 4 processor - 2.80GHz, 800MHz FSB 2027481-006 367594-001

Power supply, 240 watts 2027481-007 350030-001

Keyboard 2027481-008 355630-005

Mouse 2027481-009 323614-005
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HIS DL360 1U G5 server

Table 6. FRUs, HP DL360 1U G5 

Description GE Part Number HP Part Number

Access panel 2036798-001 412209-001

Plastics kit:
a) Optical drive ejector assembly
b) Front bezel
c) Optical device blank
d) Expansion slot covers (2) 
e) Screws, M3×0.5×4 in, T-10 (4)
f) Bezel screw, T-10, flathead, 1/4-in
g) Power supply air baffle 
h) Processor air baffle
i) HP Smart Array E200i Controller battery tray
j) HP Smart Array P400i Controller battery tray
k) Hard drive bezel blank SFF
l) Power supply blank

2036798-002 412208-001

Hard drive blank LFF 2036798-003 392613-001

Rack mounting hardware kit 2036798-004 360104-001

Cable management arm 2036798-005 360105-001

System fan module 2036798-006 412212-001

Hot-plug power supply, 700 W 2036798-007 412211-001

PCI riser board assembly 2036798-008 412200-001

Dual-Core, Intel® Xeon™ Processor 5110
(1.6-GHz, 1066- MHz FSB, 2x2-MB L2 cache)

2036798-009 416795-001

Heatsink with grease and alcohol swab 2036798-010 412210-001

HP Smart Array E200i Controller, integrated SAS 2036798-011 412205-001

System board with processor cage supporting Intel® Xeon™ 
50xx and 51xx processors

2036798-012 412199-001

SAS backplane 2036798-013 412201-001

Multibay media backplane 2036798-014 412202-001

HP Systems Insight Display, LEDs, and power button assembly, 
with cable

2036798-015 412204-001

CD-ROM Slimline Drive 2036798-016 228508-001

FBDIMM, PC2-5300F, Fully-Buffered DIMM (Qty 2) 2036798-017 416471-001

SAS hard drives 72-GB, 10,000-rpm (Qty 2) 2036798-018 376597-001

HP Smart Array E200i Controller memory module, 64-MB 2036798-019 412800-001

SAS cable 2036798-020 408763-001
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HIS DL360 1U G4 server

Multitech Modem

AC power cord 2036798-021 187335-001

Battery, 3.3-V, lithium 2036798-022 234556-001

Table 7. FRUs, HP DL360 1U G4 

Description GE Part Number HP Part Number

Access Panel DL360 G4 2030506-001 361400-001

Intel® 3.60-GHZ Xeon 1-MB L2 Cache G4 2030506-005 361382-001

3.6 Volt, 500 MAH NIMH Battery DL360 G4 2030506-006 307132-001

Sys Board w/Processor SCSI Model 2030506-008 361384-001

SCSI Backplane DL360 G4 2030506-010 305443-001

Optical Device/Disk Drive Interface G4 2030506-011 361395-001

2 GB DL360 G4 2030506-016 367553-001

SCSI Ultra320 72.8-GB 15K RPM DL360 G4 2030506-018 289243-001

Diskette Drive/Optical Drive Cable G4 2030506-019 361391-001

AC Power Cord DL360 G4 2030506-020 187335-001

Optical Drive Ejector Assembly DL360 G4 2030506-022 30545-001

Hardware Kit DL360 G4 2030506-023 361397-001

Table 8. FRUs, Multitech Modem

Description GE Part Number

MultiTech Modem MT9234ZBA Replacement Kit 2046544-001

Table 6. FRUs, HP DL360 1U G5  (Continued)

Description GE Part Number HP Part Number
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archive Permanent storage of data.

ACC American College of Cardiology. A professional society whose membership comprises more than 24,000 
cardiovascular physicians and scientists from around the world.

AIT Advanced Intelligent Tape. A form of magnetic tape and drive using AME developed by Sony for storing large 
amounts of data. AIT features high speed file access, long head and media life, the ALDC compression algorithm, 
and a MIC chip. 

ANSI American National Standards Institute. The United States government body responsible for approving US 
standards in many areas, including computers and communications. ANSI is a member of ISO.

API Application Program Interface. The interface (calling conventions) by which an application program accesses 
operating system and other services. An API is defined at source code level and provides a level of abstraction 
between the application and the kernel (or other privileged utilities) to ensure the portability of the code.

ASCII American Standard Code for Information Interchange. This is a standard means of representing characters, 
consisting of 256 characters. The first 128 characters are standardized, and the first 32 of those are control codes, 
which don't really represent visible characters but rather codes that can be used for text formatting or actions, such 
as making the computer beep. After the 32 control codes, the next 96 standardized characters represent numbers, 
letters (both uppercase and lowercase), and standard punctuation marks. The last 128 characters represent 
different things on different platforms. 

ATAPI AT Attachment Packet Interface. Part of the EIDE interface that provides additional commands to control a CD-
ROM drive or magnetic tape.

backup A spare copy of a file, file system or other resource for use in the event of failure or loss of the original.

BIOS Basic Input/Output System. The part of the system software of the IBM PC and compatibles that provides the 
lowest level interface to peripheral devices and controls the first stage of the bootstrap process, including installing 
the operating system. The BIOS is stored in ROM, or equivalent, in every PC. Its main task is to load and execute 
the operating system which is usually stored on the computer’s hard disk, but may be loaded from CD-ROM or 
floppy disk at install time.

BNC Bayonet Navy Connector. A connector for coaxial cable such as that used for some video connections and RG58 
“cheapernet” connections. A BNC connector has a bayonet-type shell with two small knobs on the female connector 
which lock into spiral slots in the male connector when it is twisted on.

cache A small fast memory holding recently accessed data, designed to speed up subsequent access to the same data. 
Most often applied to processor-memory access but also used for a local copy of data accessible over a network 
etc.

CE Marking The European Commission refers to the CE Marking of products as a “passport” which can allow a manufacturer to 
freely circulate their products within the European marketplace. The marking applies only to products regulated by 
European health, safety and environmental protection legislation (product directives) but this is estimated to include 
more than 50% of the goods currently exported from the U.S. to Europe.

The letters “CE” are an abbreviation of a French phrase “Conformite Europeene”. The marking indicates that the 
manufacturer has conformed with all the obligations required by the legislation.

client/server A network system where a dedicated computer (server) handles some of the processing tasks while multiple smaller 
computers (clients) complete other processes by tapping into the server’s shared files and programs.

CMOS Complementary Metal Oxide Semiconductor. A semiconductor fabrication technology using a combination of n- 
and p-doped semiconductor material to achieve low power dissipation. Any path through a gate through which 
current can flow includes both n and p type transistors. Only one type is turned on in any stable state so there is no 
static power dissipation and current only flows when a gate switches in order to charge the parasitic capacitance.
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CPU Central Processing Unit. The part of a computer which controls all the other parts.

DICOM Digital Imaging and Communications in Medicine. An industry standard to define connectivity and 
communication protocols of medical imaging devices. It conforms to the ISO reference model for network 
communications and incorporates object-oriented design concepts.

DIMM Dual In-line Memory Module. Small circuit boards carrying memory integrated circuits, with signal and power pins 
on both sides of the board.

DLL Dynamically Linked Library. A library which is linked to application programs when they are loaded or run rather 
than as the final phase of compilation. This means that the same block of library code can be shared between 
several tasks rather than each task containing copies of the routines it uses. The executable is compiled with a 
library of “stubs” which allow link errors to be detected at compile-time. Then, at run-time, either the system loader 
or the task's entry code must arrange for library calls to be patched with the addresses of the real shared library 
routines, possibly via a jump table. 

The alternative is to make library calls part of the operating system kernel and enter them via some kind of trap 
instruction. This is generally less efficient than an ordinary subroutine call. 

It is important to ensure that the version of a dynamically linked library is compatible with what the executable 
expects. 

DMA Direct Memory Access. A facility of some architectures which allows a peripheral to read and write memory 
without intervention by the CPU. DMA is a limited form of bus mastering.

DRAM Dynamic Random Access Memory. A type of semiconductor memory in which the information is stored in 
capacitors on a MOS integrated circuit. Typically each bit is stored as an amount of electrical charge in a storage 
cell consisting of a capacitor and a transistor. Due to leakage the capacitor discharges gradually and the memory 
cell loses the information. Therefore, to preserve the information, the memory has to be refreshed periodically. 
Despite this inconvenience, the DRAM is a very popular memory technology because of its high density and 
consequent low price. 

DTMF Dual Tone Multi Frequency. (“Touch-Tone”) A method used by the telephone system to communicate the keys 
pressed when dialling. Pressing a key on the phone’s keypad generates two simultaneous tones, one for the row 
and one for the column. These are decoded by the exchange to determine which key was pressed.

ECC Error Detection and Correction. A collection of methods to detect errors in transmitted or stored data and to 
correct them. This is done in many ways, all of them involving some form of coding. The simplest form of error 
detection is a single added parity bit or a cyclic redundancy check. Multiple parity bits can not only detect that an 
error has occurred, but also which bits have been inverted, and should therefore be re-inverted to restore the 
original data. The more extra bits are added, the greater the chance that multiple errors will be detectable and 
correctable.

ESD Electrostatic Discharge. One kind of test that hardware usually has to pass to prove it is suitable for sale and use. 
The hardware must still work after is has been subjected to some level of electrostatic discharge. Some 
organizations have their own ESD requirements which hardware must meet before it will be considered for 
purchase. Different countries have different legal regulations about levels of ESD. 

Ethernet A popular method for sending data through a local area network using single channel cable and a special data 
collision protocol to detect network availability.

expansion slot A connector in a computer into which an expansion card can be plugged. The connector supplies power to the card 
and connects it to the data bus, address bus and control signals of the motherboard.

fax Facsimile. A process by which fixed graphic material including pictures, text, or images is scanned and the 
information converted into electrical signals which are transmitted via telephone to produce a paper copy of the 
graphics on the receiving fax machine.
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FAT File Allocation Table. The component of an MS-DOS or Windows 95 file system which describes the files, 
directories and free space on a hard disk or floppy disk.

file server A computer dedicated to managing the flow of information among networked computers and used as a storage 
location for programs and files shared by network users.

firmware Refers to the software that is embedded onto a piece of hardware to control that hardware. Generally, firmware can 
be upgraded and is placed on an EEPROM. Sometimes, if a new driver for a piece of hardware is released, new 
firmware will also be released that is required to get the full functionality or performance of the driver. In other cases, 
firmware will have some bugs or undesirable features, and can be upgraded to work out the problems. Of course, 
the rest of the hardware cannot be upgraded without replacing pieces of it, so manufacturers try to store as many 
critical function controls as they can in the firmware, in case they need to change them. For them, it is the difference 
between recalling a product and simply telling their customers to upgrade the firmware. 

FTP File Transfer Protocol. The method of moving files from system to system using TCP/IP. 

gateway A term for a device that enables data to flow between different networks (forming an internet). 

HIS Hospital Information System. A system that provides the information management features hospitals need for 
daily business. Typically includes patient tracking, billing and administrative programs. May also include clinical 
features.

HL7 Health Level 7. A standard interface for exchanging and translating data between computer systems.

Hot-pluggable This type of mechanism implies that you can remove or add things while the system is running. For example, hard 
drives and power supplies are often candidates for this term. Normally, they come in special proprietary form factors 
in server machines and RAID boxes. If you’ve got mission-critical applications you want your servers to have as 
many hot swappable components as possible. Recently, servers have been introduced with hot-swappable PCI 
cards and buses. 

IDE Integrated Drive Electronics. A disk drive interface standard based on the IBM PC ISA
16-bit bus but also used on other personal computers.

IEC International Electrotechnical Commission. The international standards and conformity assessment body for all 
fields of electrotechnology.

IEEE Institute of Electrical and Electronics Engineers, Inc. The world's largest technical professional society, based in 
the USA. Founded in 1884 by a handful of practitioners of the new electrical engineering discipline, today's Institute 
has more than 320,000 members who participate in its activities in 147 countries. The IEEE sponsors technical 
conferences, symposia and local meetings worldwide, publishes nearly 25% of the world's technical papers in 
electrical, electronics and computer engineering and computer science, provides educational programs for its 
members and promotes standardization. Areas covered include aerospace, computers and communications, 
biomedical technology, electric power and consumer electronics. 

IIS Internet Information Server.The name for Microsoft’s webserver. It works with server versions of Microsoft's 
operations systems and was first developed for Windows NT Server. 

I/O Input/Output. Communication between a computer and its users, its storage devices, other computers (via a 
network) or the outside world. The devices the computer uses to do this are called “peripherals”.

IrDA Infrared Data Association. A non-profit trade association providing standards to ensure the quality and 
interoperability of infrared (IR) hardware. The association currently has a membership of over 160 companies from 
around the world, representing computer and telecommunications hardware, software, components and adapters.

IP Internet Protocol. The network layer for the TCP/IP protocol suite widely used on Ethernet networks, defined in 
STD 5, RFC 791. IP is a connectionless, best-effort packet switching protocol. It provides packet routing, 
fragmentation and re-assembly through the data link layer. 
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IRQ Interrupt Request. The name of an input found on many processors which causes the processor to suspend 
normal instruction execution temporarily and to start executing an interrupt handler routine.

ISA Industry Standard Architecture. A bus standard for IBM compatibles that extends the XT bus architecture to 16 
bits.

ISO International Organization for Standardization. A voluntary, nontreaty organization founded in 1946, responsible 
for creating international standards in many areas, including computers and communications. Its members are the 
national standards organizations of 89 countries, including the American National Standards Institute. 

KVM Switch Keyboard Video Mouse switch. This is a switch that connects 2 or more computers to the same keyboard, mouse, 
and monitor. The KVM switch fools each computer into thinking that they are actively connected to a separate 
keyboard, mouse and monitor. There is always some mechanism (a button and or keyboard command) on a KVM 
switch to switch between which computer accepts the input of the keyboard and mouse, and displays output to the 
monitor. Thus, when you move the mouse connected to the switch, your mouse movement is only echoed to the 
active computer at the time.

LAN Local Area Network. A data communications network which is geographically limited (typically to a 1 km radius) 
allowing easy interconnection of terminals, microprocessors and computers within adjacent buildings.

LCD Liquid Crystal Display. An electro-optical device used to display digits, characters or images, commonly used in 
digital watches, calculators, and portable computers. 

LED Light-Emitting Diode. A type of diode that emits light when current passes through it.

MIME Multipurpose Internet Mail Extensions. Refers to functions used for the attachment of binary files to an e-mail 
message. MIME is the most common group of functions used to make this translation, and allows us to tack on 
graphics, sound, and executable files to our e-mail messages. 

motherboard The main printed circuit board in an electronic device, particularly a computer, which may contain sockets that 
accept additional boards (“daughter-boards”). In a personal computer, the motherboard contains the bus, the 
microprocessor, and integrated circuits used for controlling any built-in peripherals such as the keyboard, text and 
graphics display, serial ports and parallel ports, and mouse interfaces.

MPEG Moving Picture Experts Group. An ISO committee that generates standards for digital video compression and 
audio. Also the name of their algorithms. 

NEMA National Electrical Manufacturers Association. 

NetBIOS Network Basic Input/Output System. An applications programming interface (API) which activates network 
operations on IBM PC compatibles running under Microsoft's DOS. It is a set of network commands that the 
application program issues in order to transmit and receive data to another host on the network. The commands are 
interpreted by a network control program or network operating system that is NetBIOS compatible.

NetBEUI NetBIOS Extended User Interface. The network transport protocol used by all of Microsoft's network systems and 
IBM's LAN Server based systems.

NIC Network Interface Card. An adapter circuit board installed in a computer to provide a physical connection to a
network. 

ns nanosecond. 10-9 seconds (one thousand millionth part of a second)

OEM Original Equipment Manufacturer. A company which makes equipment (e.g. computers) as opposed to one 
which sells equipment made by other companies.

OS Operating System. The program that allows you to access the basic functions of your computer. It is the minimum 
software required to run a program. 
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PBX Private Branch Exchange. A telephone exchange local to a particular organization who use, rather than provide, 
telephone services. The earliest PBXs were manual (Private Manual Branch EXchange, PMBX) but are now more 
likely to be automatic (Private Automatic Branch eXchange). 

PCB Printed Circuit Board. A thin board to which electronic components are fixed by solder. Component leads and 
integrated circuit pins may pass through holes (“vias”) in the board or they may be surface mounted, in which case 
no holes are required (though they may still be used to connect different layers).

PCI Peripheral Component Interconnect. A standard for connecting peripherals to a personal computer.

PCL Printer Control Language. A Document description language used by Hewlett-Packard LaserJet printers.

PDC Primary Domain Controller. In Windows NT, this machine is the main machine that responds to security 
authentication requests, such as logging in, within its domain. The PDC may be backed by one or more backup 
domain controllers that can also handle security authentication. 

PDF Portable Document Format. The native file format for Adobe Systems’ Acrobat. PDF is the file format for 
representing documents in a manner that is independent of the original application software, hardware, and 
operating system used to create those documents.

PING Packet INternet Groper. A program used to test reachability of destinations by sending them one, or repeated, 
ICMP echo requests and waiting for replies.

PostScript A Page Description Language based on work originally done by John Gaffney at Evans and Sutherland in 1976, 
evolving through “JaM” (“John and Martin”, Martin Newell) at XEROX PARC, and finally implemented in its current 
form by John Warnock et al. after he and Chuck Geschke founded Adobe Systems, Inc. in 1982. Its primary 
application is to describe the appearance of text, graphical shapes and sampled images on printed or displayed 
pages.

PRML Partial Response Maximum Likelihood. A method for converting the weak analog signal from the head of a 
magnetic disk drive into a digital signal. PRML attempts to correctly interpret even small changes in the analog 
signal, whereas peak detection relies on fixed thresholds. Because PRML can correctly decode a weaker signal it 
allows higher density recording.

PS/2 IBM's second generation of personal computers. The PS/2 series introduced three advances over the PC series: 
3.5" 1.44 megabyte microfloppy disks, VGA and 8514 graphics display standards, and the Micro Channel bus 
architecture. The 3.5" disks and VGA can be easily installed on other PCs and will become the standard for new 
compatible computers.

RAID Redundant Array of Inexpensive Disks/Drives. A unit with several magnetic disks which protects against data 
loss in the event of the failure of any one disk.

RAM Random Access Memory. A data storage device for which the order of access to different locations does not affect 
the speed of access.

RFI Radio Frequency Interference. Electromagnetic radiation which is emitted by electrical circuits carrying rapidly 
changing signals, as a by-product of their normal operation, and which causes unwanted signals (interference or 
noise) to be induced in other circuits.

RISC Reduced Instruction Set Computer. A processor whose design is based on the rapid execution of a sequence of 
simple instructions rather than on the provision of a large variety of complex instructions.

RJ-45 A serial connector which looks very much like a standard telephone connector, except it houses eight wires instead 
of four.

ROM Read-Only Memory. A type of data storage device which is manufactured with fixed contents. In its most general 
sense, the term might be used for any storage system whose contents cannot be altered. The term is most often 
applied to semiconductor integrated circuit memories, of which there are several types, and CD-ROM. 
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RS-232 The most common asynchronous serial line standard.

SCSI Small Computer System Interface. A processor-independent standard for system-level interfacing between a 
computer and intelligent devices including hard disks, floppy disks, CD- ROM, printers, scanners, and many more.

SDLC Synchronous Data Link Control. An IBM protocol. A discipline conforming to subsets of the ADCCP of ANSI and 
the HDLC of the International Organization for Standardization. SDLC manages synchronous, code-transparent, bit-
serial communication which can be duplex or half-duplex; switched or non-switched; point-to-point, multipoint, or 
loop.

seek time The time it takes for a disk drive to move its head(s) from one track to another. The seek time depends on the power 
of the servo, the mass of the heads, the number of tracks traversed and the time taken to position the heads over 
the target track accurately enough to start data transfer. 

SFF Small Form Factor. A term used to describe computers that are housed in smaller cases than typical desktop 
computers.

SIMM Single In-line Memory Module. A small circuit board or substrate, typically about 10cm x 2cm, with RAM 
integrated circuits or die on one or both sides and a single row of pins along one long edge. Several SIMMs are 
mounted with their substrates at right-angles to the main circuit board (the motherboard). This configuration allows 
greater packing density than direct mounting of, e.g. DIL (dual in-line) RAM packages on the motherboard. In 1993 
one SIMM typically held one or four megabytes, by early 1997 one could hold 8, 16, or 32 MB.

SMTP Simple Mail Transfer Protocol. A protocol defined in STD 10, RFC 821, used to transfer electronic mail between 
computers, usually over Ethernet. It is a server to server protocol, so other protocols are used to access the 
messages.

STS Society for Thoracic Surgeons.

Subnet Mask This is a TCP/IP number used to determine which TCP/IP subnet a device belongs to. Devices in the same subnet 
can be communicated with locally without going through a router. When a TCP/IP device tries to communicate with 
another device, the bits of the TCP/IP destination address are “ANDed” with the subnet mask to determine whether 
the address is a local address (broadcastable) or must be reached through a router. 

TCP/IP Transmission Control Protocol over Internet Protocol. The de facto standard Ethernet protocols incorporated 
into 4.2BSD Unix. TCP/IP was developed for internetworking and encompasses both network layer and transport 
layer protocols.

token ring A computer local area network arbitration scheme in which conflicts in the transmission of messages are avoided by 
the granting of “tokens” which give permission to send. A station keeps the token while transmitting a message, if it 
has a message to transmit, and then passes it on to the next station.

track ball A pointing device consisting of a ball housed in a socket containing sensors to detect rotation of the ball about two 
axes - like an upside-down mouse. The user rolls the ball with his thumb or the palm of his hand to move a cursor. 
Track balls are common on modern portable computers, where there may be no desk space on which to use a 
mouse. Some clip onto the side of the keyboard and have integral buttons which have the same function as mouse 
buttons.

twisted pair A type of cable in which pairs of conductors are twisted together to randomize possible cross-talk from nearby 
wiring. Inadequate twisting is detectable using modern cable testing instruments. 

UDMA Ultra Direct Memory Access. A development of the Advanced Technology Attachment specifications which gives 
nearly twice the maximum transfer speed of the ATA-3 standard (PIO Mode 4). 

UL Underwriters Laboratories Inc. is an independent, not-for-profit product safety testing and certification 
organization.
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UNC Universal Naming Convention. The name given for the naming used when one specifies: \\the server\the 
volume\the path\then the file name of a file. 
An example of a UNC is: \\Myserver\Docdrive\Magazine\glossary.doc 

UPS Uninterruptible Power Supply. Unit which supplies ten minutes of battery backup power to the file server in the 
event of main power source failure.

USB Universal Serial Bus. A technology in the works that will replace the current way that some peripheral devices 
connect to your computer. It is much faster than serial and parallel communications. It is also much more flexible: it 
will be able to connect to possibly hundreds of devices simultaneously. 

VESA Video Electronics Standards Association. An industry standards organization created in 1989/1990 primarily 
concerned with IBM compatible personal computers. The first standard it created was the 800 x 600 pixel Super 
VGA (SVGA) display and its software interface. It also defined the VESA Local Bus (VLB). 

VGA Video Graphics Array. A display standard for IBM PCs, with 640 x 480 pixels in 16 colors and a 4:3 aspect ratio. 
There is also a text mode with 720 x 400 pixels. 
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Introduction
Changes or modification to the MUSE system server or client not expressly 
approved by GE could cause electromagnetic compatibility (EMC) issues. This 
system is designed and tested to comply with applicable regulation regarding 
EMC and needs to be installed and used according to the EMC information stated as 
follows.

CAUTION
RADIO FREQUENCY INTERFERENCE – Use of portable 
phones or other radio frequency (RF) emitting equipment near the 
system may cause unexpected or adverse operation.

Do not use RF emitting equipment near the device. 

CAUTION
EQUIPMENT INTERFERENCE – If adjacent or stacked use is 
necessary, the equipment or system should be tested to verify 
normal operation in that configuration.

The equipment or system should not be used adjacent to, or 
stacked with, other equipment.
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Guidance and manufacturer’s declaration – 
electromagnetic emissions

Emissions test Compliance Electromagnetic environment-guidance

RF emissions
EN 55022

Group 1 The MUSE server and client use RF energy for their internal 
functions. Therefore, its RF emissions are very low and are not 
likely to cause any interference in nearby electronic equipment. 

RF emissions
EN 55022

Class A
(Server)

Class A
(Client)

The MUSE server and client are suitable for use in all 
establishments other than domestic and those directly 
connected to the public low-voltage power supply network that 
supplies buildings used for domestic purposes.Harmonic Emissions

EN 61000-3-2 
Class A

Voltage fluctuations/Flicker emissions
EN 61000-3-3 

Complies
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Guidance and manufacturer’s declaration – 
electromagnetic immunity

Immunity test EN55024 test level Compliance level Electromagnetic environment-guidance

Electrostatic discharge 
(ESD)
EN 61000-4-2

± 4 kV contact
± 8 kV air

± 4 kV contact
± 8 kV air

Floors should be wood, concrete or ceramic 
tile. If floors are covered with synthetic 
material, the relative humidity should be at 
least 30%.

Electrical fast Transient/
burst
EN 61000-4-4

± 1 kV for power supply 
lines
+ 500V for input/output 
lines

± 2 kV for power supply 
lines
±1 kV for input/output 
lines

Mains power should be that of a typical 
commercial or hospital environment.

Surge
EN 61000-4-5

± 1 kV differential mode
± 2 kV common mode

± 1 kV differential mode
± 2 kV common mode

Mains power should be that of a typical 
commercial or hospital environment.

Voltage dips, short 
interruptions and voltage 
variations on power supply 
input lines
EN 61000-4-11

<5% Ut (>95% dip in Ut) 
for 0.5 cycles
40% Ut (60% dip in Ut) for 
5 cycles
70% Ut (30% dip in Ut) for 
25 cycles
<5% Ut (>95% dip in Ut) 
for 5 sec

<5% Ut (>95% dip in Ut) 
for 0.5 cycles
40% Ut (60% dip in Ut) for 
5 cycles
70% Ut (30% dip in Ut) for 
25 cycles
<5% Ut (>95% dip in Ut) 
for 5 sec

Mains power should be that of a typical 
commercial or hospital environment. If the 
user of the MUSE file server or client requires 
continued operation during power mains 
interruptions, it is recommended that the 
MUSE file server or client be powered from an 
uninterruptible power supply or a battery.

Power frequency  
(50/60 Hz) magnetic field
EN 61000-4-8

N/A N/A Power frequency magnetic fields should be at 
levels characteristics of a typical location in a 
typical commercial or hospital environment.
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Conducted RF
EN 61000-4-6

Radiated RF
EN 61000-4-3

3 Vrms
150 KHz to 80 MHz

3V/m
80 MHz to 2.5 GHz

3 Vrms

3V/m

Portable and mobile RF communications 
equipment should be used no closer to any 
part of the MAC 400, including cables, than 
the recommended separation distance 
calculated from the equation applicable to the 
frequency of the transmitter.
Recommended separation distance
d = 1.2

d = 1.2
80 MHz to 800 MHz 
d = 2.3
800 MHz to 2.5 GHz
where P is the maximum output power rating 
of the transmitter in watts (W) according to the 
transmitter manufacturer, and d is the 
recommended separation distance in meters 
(m).
Field strengths from fixed RF transmitters, as 
determined by an electromagnetic site survey, 
should be less than the compliance level in 
each frequency range. Interference may occur 
in the vicinity of equipment marked with the 
following symbol:

Note: At 80 MHz and 800 MHz, the higher frequency range applies. 

Note: These guidelines may not apply in all situations. Electromagnetic propagation is affected by reflection from structures, 
objects, and people. 

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radio, AM and 
FM radio broadcast, and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic 
environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in 
the location in which the equipment is used exceeds the applicable RF compliance level above, the equipment should be observed 
to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or 
relocating the equipment.

b Over the frequency range 150 KHz to 80 MHz, field strengths should be less than 3 V/m.

Immunity test EN55024 test level Compliance level Electromagnetic environment-guidance

P
P

P
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Recommended separation distance
The following table provides the recommended separation distances (in meters) 
between portable and mobile RF communication equipment and the MAC 400 
system. The MAC 400 system is intended for use in the electromagnetic 
environment on which radiated RF disturbances are controlled. The customer or the 
user of the MAC 400 system can help prevent electromagnetic interference by 
maintaining a minimum distance between portable and mobile RF communications 
equipment (transmitters) and the MAC 400 system as recommended below, 
according to the maximum output power of the communications equipment.

For transmitters rated at a maximum output power not listed above, the 
recommended separation distance [d] in meters (m) can be estimated using the 
equation applicable to the frequency of the transmitter, where P is the maximum 
output power rating of the transmitter in watts (w) according to the transmitter 
manufacturer.

These guidelines may not apply in all situations. Electromagnetic propagation is 
affected by absorption and reflection from structures, objects and people. 

Rated maximum 
output power of 

transmitter in watts

Separation distance in meters (m) according to frequency of transmitter

150KHz to 80MHz 
outside ISM bands

d = 1.2

150KHz to 80MHz 
outside ISM bands

d = 1.2

80MHz to 800MHz
d = 1.2

800MHz to 2.5GHz
d = 2.3

0.01 0.12 0.12 0.12 0.23

0.1 0.38 0.38 0.38 0.73

1 1.2 1.2 1.2 2.3

10 3.8 3.8 3.8 7.3

100 12 12 12 23

At 80MHz and 800MHz the separation distance of high frequency range applies. 

P P P P
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Exceptions

Component Model Type (i.e. ESD) Exception(s) EMC Environment 
Guidance

Server HP ML370G5 N/A None N/A

HP ML370G4 N/A None N/A

HP DL360G5 N/A None N/A

Client HP dc7600 N/A None N/A

HP dc7100 N/A None N/A

HP rp5700 N/A None N/A

Accessories LCD
(HP Model L1910)

N/A None N/A

UPS
120V Powerware 

PW5115 1400

___ ___ ___

UPS
230V Powerware 
PW5115 1400i

___ ___ ___
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Numerics
4 CPU Front Panel LEDs and Buttons Compaq ProLiant 

ML370 G4 2-28

A
abrasive cleaning agents 7-5
ACC (American College of Cardiology) 9-2
AIT (Advanced Intelligent Tape) 9-2
ANSI (American National Standards Institute) 9-2
API (Application Program Interface) 9-2
ASCII (American Standard Code for Information 

Interchange) 9-2
ATAPI (AT Attachment Packet Interface) 9-2
authorized service 1-8

B
BIOS (Basic Input/Output System) 9-2
BNC (Bayonet Navy Connector) 9-2

C
CDROM 7-7
chapter content 1-3
cleaning

card slot 7-6
inside 7-6
interior 7-6
visual inspection 7-5
what to use 7-5

CMOS (Complementary Metal Oxide Semiconductor) 
9-2

Compaq ProLiant ML370 G4 2-29
CPU (Central Processing Unit) 9-3
CPU Back 2-29
CPU Front 2-26, 2-27
CPU Front Panel LEDs and Buttons Compaq ProLiant 

ML370 G4 2-28

D
DICOM (Digital Imaging and Communications in 

Medicine) 9-3
DIMM (Dual In-line Memory Module) 9-3
disassembly guidelines 7-4
DLL (Dynamically Linked Library) 9-3
DMA (Direct Memory Access) 9-3
DRAM (Dynamic Random Access Memory) 9-3
DTMF (Dual Tone Multi Frequency) 9-3

E
equipment

maintenance 7-2
equipment maintenance contract 7-2
equipment symbols 1-7
ERM (Extended Runtime Modules) 2-35
ESD (Electrostatic Discharge) 9-3

F
FAT (File Allocation Table) 9-4

FRUs (field replaceable units) 8-3
FTP (File Transfer Protocol) 9-4

H
health hazards 7-2
HIS (Hospital Information System) 9-4
HL7 (Health Level 7) 9-4
how to

clean CDROM drive 7-7
clean system box 7-6
handle tape head assembly 7-5

HP ProLiant ML370 G5 2-26, 2-27

I
I/O (Input/Output) 9-4
IDE (Integrated Drive Electronics) 9-4
IEC (International Electrotechnical Commission) 9-4
IEEE (Institute of Electrical and Electronics Engineers, 

Inc.) 9-4
IIS (Internet Information Server) 9-4
immersion in water 7-5
IMS log file

ARC_#_#.LOG 4-21
BACK_?.LOG 4-21
CHKPTRS.LOG 4-21
DBANAL.LOG 4-21
IMS_?.LOG 4-21

Integrated Maintenance Suite 4-1–??
interior cleaning 7-6
IP (Internet Protocol) 9-4
IrDA (Infrared Data Association) 9-4
IRQ (Interrupt Request) 9-5
ISA (Industry Standard Architecture) 9-5
ISO (International Organization for Standardization) 9-5

K
KVM switch (Keyboard Video Mouse switch) 2-5, 9-5

L
LAN (Local Area Network) 9-5
LCD (Liquid Crystal Display) 9-5
LED (Light-Emitting Diode) 9-5

M
maintenance

contract 7-2
preventive 7-2
responsibility for 7-2
schedule 1-8

maintenance checklist
list of

maintenance checks 7-2
manual

purpose 1-3
MIME (Multipurpose Internet Mail Extensions) 9-5
mouse

cleaning 7-7
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MPEG (Moving Picture Experts Group) 9-5
MUSE dc7100 Client, Front Panel Controls and LEDs 2-

42, 2-44

N
NEMA (National Electrical Manufacturers Association) 

9-5
NetBEUI (NetBIOS Extended User Interface) 9-5
NetBIOS (Network Basic Input/Output System) 9-5
NIC (Network Interface Card) 9-5

O
OEM (Original Equipment Manufacturer) 9-5
opening file server for service 7-9
OS (Operating System) 9-5

P
patient safety

health hazards 7-2
PBX (Private Branch Exchange) 9-6
PCB (Printed Circuit Board) 9-6
PCI (Peripheral Component Interconnect) 9-6
PCL (Printer Control Language) 9-6
PDC (Primary Domain Controller) 9-6
PDF (Portable Document Format) 9-6
PDU (Power Distribution Unit) 2-35
PING (Packet INternet Groper) 9-6
POST (power-on self test) 2-20
preventive maintenance inspection report 7-2
PRML (Partial Response Maximum Likelihood) 9-6
product code 1-9

R
RAID (Redundant Array of Inexpensive Disks/Drives) 9-

6
RAM (Random Access Memory) 9-6
Rear Panel LEDs and Buttons 2-30
REPO (Remote Emergency Power Off) 2-35
required tools 7-3
RFI (Radio Frequency Interference) 9-6
RISC (Reduced Instruction Set Computer) 9-6
ROM (Read-Only Memory) 9-6

S
safety

warnings 1-7
SCSI (Small Computer System Interface) 9-7
SDLC (Synchronous Data Link Control) 9-7
service

information 1-8
requirements 1-8

SIMM (Single In-line Memory Module) 9-7
SMTP (Simple Mail Transfer Protocol) 9-7
special tools 7-3
STS (Society for Thoracic Surgeons) 9-7
supplies

needed for repair 7-3

T
TCP/IP (Transmission Control Protocol over Internet 

Protocol) 9-7
tools 7-3
troubleshooting

basic questions 6-6
operator error 6-6
visual inspection 6-6

U
UDMA (Ultra Direct Memory Access) 9-7
UL (Underwriters Laboratories Inc.) 9-7
UNC (Universal Naming Convention) 9-8
UPS (Uninterruptible Power Supply) 9-8
USB (Universal Serial Bus) 9-8

V
VESA (Video Electronics Standards Association) 9-8
VGA (Video Graphics Array) 9-8
visual inspection

cleaning 6-6
outside 7-5
troubleshooting 6-6

W
warning

equipment 1-7
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